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Presentacion

Jorge Gustavo Ocampo Ledezma?
J. Reyes Altamirano Cardenas?

Desde el surgimiento del CIESTAAM en 1990, la investigacion que se desarrolla
en este Centro ha estado caracterizada por utilizar enfoques multidisciplinarios,
trabajo de campo, contrastacion de hipotesis de forma empirica, conglomeracion
de datos actuales y la aplicacion de analisis cualitativos y cuantitativos vigentes, lo
cual ha derivado en el abordaje tedrico y metodoldgico de diferentes problemas
propios del sector agricolay rural mexicano, desde la desaparicion de los precios de
garantia, el surgimiento del PROCAMPO, la firma del Tratado de Libre Comercio,
hasta la transferencia de tecnologia, la adopcion de innovaciones y las redes de
innovacion como detonantes de la productividad agricola.

Trabajar sobre un tema de investigacion obliga a desarrollar diferentes
actividades. Por una parte requiere precisar con claridad su campo de accion,
al tiempo que se formulan las bases tedricas y conceptuales necesarias para
comprenderlo. Enseguida, es menester establecer las metodologias de analisis
en las que, con rigurosidad y resultados, se mantengan las explicaciones lo mas
completas posibles, a fin de proporcionar directrices en el acopio y manejo de la
informacion. Después se debe elaborar un plan de trabajo que permita obtener
resultados y se mantenga una continuidad fructifera que, con aportes regulares,
logren la fundamentacion cada vez mas precisa del campo de accion.

Los temas en que hemos incursionado en nuestros mas de 25 afios son los
estudios sobre ciencia, tecnologia e innovacion que abordamos desde hace mas de
una década cada vez con mayor precision, aunque con diversidad metodologica.
Diversos colectivos de nuestro Centro impulsaron trabajos al respecto, y con
resultados novedosos nos encontramos siempre con la disposicion para unificar
esfuerzos y caminar juntos. En uno de estos colectivos las formulaciones han

!Coordinador de lalinea de “Historia Agraria” del CIESTAAM.
Director del CIESTAAM.
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sido ambiciosas y referidas a los mecanismos de transferencia de tecnologia e
innovacion, en una orientacion amplia lo cual ha propiciado estar presentes tanto
en debates nacionales como internacionales.

De esta manera se han desplegado referentes empiricos sobre diversos temas,
entre ellos los sistema-producto, que analizados desde la version de la innovacion
evidencié una riqueza importante de explicar que pronto se orienté hacia el
disefo, implementacion y evaluacion de las Agencias de Gestion de la Innovacion
y de las Agencias de Desarrollo, los cuales son equipos de extensionistas que
buscan impulsar procesos de innovacion en los territorios rurales. La tendencia
se desarroll6 hacia la formulacion de metodologias de trabajo en campo que
pronto mostro la necesidad de conceptualizar y teorizar al respecto, rebasando el
estrecho marco instrumental que constantemente acecha a estas explicaciones.

Poco a poco fueron surgiendo las precisiones tedricas y las adscripciones a
diferentes escuelas de pensamiento que, pese a sus grandes aportes, mostraron
insuficiencias para nuestros propositos, y motivaron adaptaciones y busquedas
mas ambiciosas. Apareci6 asi una serie de conceptos y explicaciones que se
aproximan a las formulaciones teéricas necesarias, con las cuales perfilamos una
escuela de pensamiento, cada vez mas reconocida nacional y mundialmente. Con
todo, la necesidad de afinar metodologias e indicadores en los trabajos de campo
y en las investigaciones se mantiene. Y la bdsqueda tiene que manifestarse en
estas otras areas. Es entonces que nuevos conceptos nos refuerzan.

Es el caso del concepto redes, que si bien se desarrolla en el ambito académico
y cientifico, requiere de precisiones y elaboraciones apropiadas surgidas de
referentes empiricos que las validen para su difusion. Nuestra cercania con los
estudios sociales de la ciencia y la tecnologia, en donde destaca la presencia
estimulante de los grupos ESOCITE latinoamericanos, nos orienta a reconocer
los esfuerzos de la escuela de sociologia de la innovacion, con Bruno Latour,
Michel Callon y John Law, y la presencia mexicana de Antonio Arellano desde
la Universidad Autonoma del Estado de México, donde se propone la teoria del
actor-red, o las derivaciones latinoamericanas de la escuela de economia de la
innovacion promovida por Chistofer Freeman, Carlota Pérez y Giovanni Dosi,
entre otros, y sus ampliaciones con Gabriela Ddtrenit y un creativo equipo de la
UAM-Xochimilco, de la distincion de Rosalba Casas del Instituto de Investigaciones
Sociales de la UNAM y sus propuestas sobre redes de conocimiento, hasta arribar
a los equipos argentinos de la Universidad de Quilmes y de la Universidad de
Buenos Aires, donde desarrollan sus trabajos Pablo Kreimer y Hernan Thomas,
con un amplio espectro de participaciones, y con la fortaleza de la revista Redes.

Metodologias y herramientas para la investigacion, V 5



En esta tendencia se incorporan los esfuerzos desde el CIESTAAM de la
Universidad Autébnoma Chapingo por desarrollar sus propias aportaciones. Los
autores de este manual metodoldgico demuestran con creces la madurez que
tenemos con los estudios y trabajos. Uno de sus conceptos basicos ha sido el de
agricultor mds referido, ademas de su propia definicion de innovacién y de redes
de innovacién, asi como las aplicaciones metodoldgicas que los han llevado a
mantener relaciones académicas con los lideres mundiales en la tematica adscritos
a la Universidad de Kentucky, a la Universidad de Wageningen y con los editores
de la Revista hispana para el analisis de redes sociales de la Universidad Autébnoma
de Barcelona y de la Universidad de Sevilla.

En especifico, paralos temas de difusion de innovaciones y redes de innovacion,
entre otros, uno de los enfoques que se ha venido utilizando ampliamente y que
cada vez esta cobrando mayor relevancia a nivel nacional e internacional, es el del
Analisis de Redes Sociales (ARS por sus siglas en espafiol y SNA en inglés). En el
CIESTAAM, el enfoque del ARS se ha utilizado para explicar diferentes fenédmenos,
pero principalmente los asociados a la difusion de informacion y conocimiento
para incrementar la adopcion de innovaciones por parte de los productores
agricolas; pero también se ha utilizado para mapear los actores participantes en
una actividad agroalimentaria especifica, asi como para la seleccion de actores
que ayuden a catalizar los procesos de difusion, para disenar estrategias basadas
en red, entre otros.

Ahora, y con el objetivo de aproximarse con mayor rigor a los referentes
empiricos, han elaborado, con apoyo de herramientas y software adecuados, un
instrumental para ubicar, registrar, graficar y visualizar la informacién, donde el
requisito es manejar programas. Mas alla de tener s6lo un manual o instructivo,
este documento se amplia de manera implicita hacia destacar actores o nodos,
identificandolos en apretadas tipologias. En su caracterizacion puede parecer que
no queda precisa la distincion entre actores y nodos, pero cuando se aprecian los
graficos y las metodologias empleadas se evidencia que se refieren a lo mismo. Sin
embargo, queda aln pendiente la precision conceptual de estos términos en un
amplio conjunto de usuarios de estas metodologias, pues las redes manifiestan una
mayor complejidad, en tanto conjunto de relaciones con multiples determinaciones,
por lo que se deben generar explicaciones con mayor profundidad.

Bajo este contexto, los autores de esta obra se plantean el objetivo general de
proveer un documento que contenga los conceptos fundamentales del Analisis
de Redes Sociales, asi como proporcionar los elementos minimos a considerar al
momento de colectar datos de red, sistematizarlos y, posteriormente, analizarlos
e interpretarlos. Sin lugar a duda, creemos que lo han logrado y han sintetizado
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una serie de experiencias y desarrollos tanto conceptuales como metodologicos
plasmados en este documento; mismo que, mas que ser un manual de
procedimientos, sea un libro de apoyo y consulta para lograr “desenredar” el
complejo e interesante proceso de la aplicacion e interpretacion del ARS.

De la misma forma, como los autores lo recalcan, se tiene un interés particular
sobre el manejo de uno de los software mas populares en el ARS: UCINET. Pero
durante la lectura de este documento, los usuarios encontraran los conceptos
basicos para aplicar el ARS con el apoyo de otros software y, también, en otras
areas de investigacion.

Es asi que la importancia del documento que se presenta reviste entonces
diferentes aristas. Por una parte consolida a un equipo de trabajo dentro del
colectivo del CIESTAAM que estudia la ciencia, la tecnologia y los procesos de
innovacion. Por otra, evidencia el grado de madurez obtenido por nuestras
apreciaciones al respecto. Una mas es que atiende una necesidad surgida de
nuestras experiencias en campo y en la formacion de profesionistas, practica que
requiere materiales instrumentales que faciliten el manejo de datos y nos inscriban
en una dinamica de atender nuevas preocupaciones teoéricas y metodologicas.

Invitamos a los lectores a estudiar este texto y promover sus aplicaciones, con
lo que seguramente el proposito inicial de este esfuerzo se habra cumplido.



1. El Analisis de Redes Sociales

El Analisis de Redes Sociales (ARS, o SNA por sus siglas eninglés) es muy popular y
estasiendoampliamenteusadoendiferentesareasdeestudio.Elinterésdeentender
ciertos fendmenos con una perspectiva de red se ha extendido a todas las areas de
las ciencias sociales y esta creciendo (incluso mas rapido) en fisica, epidemiologia
y, biologia (Borgatti & Halgin, 2011b; Borgatti, Mehra, Brass, & Labianca, 2009;
Wasserman & Faust, 1994). Es asi como el ARS ha ampliado su rango de aplicacion
debido a que representa una forma de pensar sobre un sistema social, lo cual da
oportunidad de abordar estudios de este tipo desde otra perspectiva. En este
sentido, el ARS permite focalizar sobre la relaciones existentes entre diferentes
entidades que constituyen un sistema (Borgatti, Everett, & Johnson, 2013),
por ejemplo en un sistema social; estas entidades son cominmente llamadas
actores o nodos. De esta forma, con la perspectiva del ARS, un ambiente social
puede ser expresado con el uso de patrones y regularidades de relaciones
establecidas entre los actores que lo conforman; estos patrones dan formaalo que
se conocen como estructuras, mismas que derivan en indicadores estructurales
de la red social (Wasserman & Faust, 1994).

Los nodos o actores tienen caracteristicas distintivas, llamadas comdnmente
atributos, que precisamente distinguen a unos actores de otros y que pueden explicar
el comportamiento de un conjunto de actores, o de la red en su totalidad. En el
mismo sentido, si los actores poseen atributos, los vinculos que se establecen entre
ellos también los pueden tener, asi es posible distinguir entre fuerza e intensidad de
los vinculos, frecuencia de los mismos, entre otros (Granovetter, 1973). Sin duda,
uno de los elementos mas importantes de los vinculos es el tipo de relacion que estan
expresando; por ejemplo, dos actores pueden estar unidos porque son familiares
0, porque uno proporciona consejo y asesoria al otro, o porque ambos son duefios
fundadores de la misma organizacion empresarial, por mencionar algunos.

De esta forma, una red esta compuesta por un conjunto de actores o nodos que
estan unidos a través de un conjunto de enlaces que representan un tipo especifico de
relacion. Los nodos en una red pueden ser casi cualquier cosa, aunque, generalmente,
cuando se habla de redes sociales se espera implicitamente que los nodos sean
agentes activos, como son individuos o personas (Borgatti et al., 2013), por ejemplo
agricultores (Aguilar-Gallegos et al., 2016; Aguilar-Gallegos, Mufnoz-Rodriguez,
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Santoyo-Cortés, Aguilar—AviIa, & Klerkx, 2015; Mufoz Rodriguez, Renddn
Medel, Aguilar Avila, Garcia Mufiz, & Altamirano Cardenas, 2004); sin embargo,
existen redes en donde los nodos representan animales, objetos (un tractor o
una maquina), empresas, ciudades, especies vegetales, paginas de internet,
cuentas asociadas a perfiles sociales, entidades de gobierno, organizaciones no
gubernamentales (ONG), entre otros. Es asi que el ARS permite la visualizacion
y andlisis de dichos vinculos y de los actores que participan en la red (Borgatti
et al., 2009; Valente, 1996; Wasserman & Faust, 1994). Precisamente son los
vinculos establecidos los que estructuran de formas particulares a las redes,
en donde los nodos tienen diferentes posiciones dentro de estas estructuras
(Borgatti & Halgin, 2011b). Estas caracteristicas de la red, de los nodos y de
sus vinculos son el sustrato primordial para el ARS. Por tanto, los elementos
basicos de cualquier red seran los actores o nodos y los vinculos o enlaces que se
establecen entre ellos. Asi, la presencia de informacion relacional entre actores
es una caracteristica crucial y que, ademas, definen a la red (Wasserman & Faust,
1994). De forma subyacente a la informacion relacional, es importante considerar
un tercer elemento basico de la red, que es la direccionalidad del vinculo; por lo
cual, existen redes no dirigidas y dirigidas (Hanneman & Riddle, 2011). Esto a su
vez proporciona nuevos elementos, pues a través de los vinculos es que se forman
“caminos” por donde puede fluir algun tipo de recurso y a su vez, estos “caminos”
permiten conectar indirectamente partes de la red que no estan conectadas
directamente. Es asi que, recursos que parecieran socialmente distantes pueden
llegar a ser alcanzados por diversos actores (Granovetter, 1973).

Bajo este breve contexto es que laimportancia y aplicabilidad del ARS ha venido
aumentando y cada vez es mas comun observar su uso tanto como herramienta
metodologica como elemento tedrico para ayudar a explicar ciertos fenédmenos
en el que participan diversos actores. Es asi como, en la parte académica, de
investigacion y en la actividad profesional cada vez es mas comun encontrarse con
estudios (tesis, proyectos de investigacion, consultorias, entre otros) que buscan
incorporar dentro de sus procesos de colecta de informacion datos relacionales
que, posteriormente, son analizados con métodos y teorias que ofrece el ARS; el
detalle es que varios de ellos lo hacen de forma empirica y autodidacta, en algunos
casos intentando replicar analisis vistos en otras publicaciones, lo cual puede llevar a
hallazgos sumamente Utiles, pero también a errores tanto en la aplicacion como en
la interpretacion. Asi, a pesar de su popularidad y amplio uso, se han detectado en
la literatura (especificamente en el campo de la agricultura) algunos casos donde
el ARS se ha utilizado sin considerar elementos importantes que subyacen a la
informacion de red y, por tanto, se han cometido errores de analisis e interpretacion,
principalmente por el escaso fundamento en el tema mismo.

Metodologias y herramientas para la investigacion, V 5



Bajo el contexto anterior, el objetivo general de este documento es proveer los
conceptos fundamentales del ARS, asi como proporcionar los elementos clave a
considerar almomento de colectar datos de red, sistematizarlos y, posteriormente
analizarlos e interpretarlos. De la misma forma, el documento tiene la finalidad
de mostrar el uso del software mas popular para generar indicadores en el
ARS, es decir de UCINET (Borgatti, Everett, & Freeman, 2002), mismo que se
puede descargar directamente de la pagina oficial (https://sites.google.com/
site/ucinetsoftware/downloads), y ademas de dos softwares asociados a éste: i.
NetDraw (Borgatti, 2002), para visualizar redes y; ii. KeyPlayer 2 (Borgatti, 2006;
Borgatti & Dreyfus, 2005), para identificar actores clave. De esta forma, con este
documento se pretende contribuir a clarificar las bases fundamentales del calculo
de los indicadores elementales utilizados en el ARS; también se hace énfasis en la
interpretacion de éstos, a la luz de la informacion que representa la red.

Debido a que el ARS ofrece un conjunto de métodos y conceptos analiticos
que son distintos a los métodos tradicionales de analisis estadistico de datos
(Wasserman & Faust, 1994), la tarea de interpretacion puede ser compleja,
pero se ha buscado cumplirla sin necesidad de recurrir a complicadas notaciones
matematicas o de algebra de matrices; en su lugar, algunos de los indicadores se
explican a través de ejemplos sencillos y en otros con aplicaciones empiricas de facil
entendimiento. El lector mas avanzado podra recurrir a la literatura especializada
sugerida a lo largo del texto para encontrar mayores detalles tanto tedricos como
matematicos de los temas expuestos. De esta forma, los autores esperamos que
el documento pueda ser utilizado por diferentes actores con intereses variados
(por ejemplo, estudiantes, académicos, profesionales, consultores, funcionarios
publicos, entre otros), en distintas areas del conocimiento (tales como la
agricultura, ciencias sociales, informatica, desarrollo rural, entre otros), y para
analizar diferentes fendmenos (difusion de innovaciones, seleccion de actores
clave, intercambio de informaciéon y conocimiento, intervenciones basadas en
red, entre otros).

ANALISIS DE REDES SOCIALES: CONCEPTOS CLAVE Y CALCULO DE INDICADORES
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2. Colecta y generacion de datos de red

Sin lugar a dudas, el disefo correcto de la pregunta de red y los formatos a utilizar
son cuestiones criticas para el éxito de cualquier estudio que involucre datos de
red (Borgatti et al., 2013) en donde la precision de términos como “es amigo de”,
“se comunica con”, “socializa en” (entre otros), ayuda a tener mejores datos de red.
Por supuesto, la gestion, almacenamiento y el analisis de la informacion también
son importantes pues de ello depende la correcta interpretacion de la misma. En
general, en los estudios de gestion de innovacion (Aguilar-Gallegos et al., 2016,
2017,2015), que consideran el intercambio de informacién y conocimiento entre
diferentes actores, es comun que se colecten datos de red utilizando preguntas

generadoras de nombres.

2.1. Generadores de nombres

Latécnica de los “generadores de nombres” es muy utilizada en el ARS y basicamente
consiste en preguntar a cada uno de los encuestados (conocidos como, “egos”)
que indique con quién esta en contacto o con quién esta vinculado (conocidos
como “alters*”), dependiendo del tipo de relacion de interés (Marsden, 1990).
Algunos ejemplos de este tipo de preguntas generadoras de nombres (es decir,
para generar el listado de los nombres con los cuales los actores estan en contacto),
se muestra en el Cuadro 1. Uno de los elementos mas importantes a considerar es
que la pregunta esta asociada a un tipo de relacion especifico y, por lo tanto, la
red representara ese tipo de relacion y no otra mas. Por ejemplo, si se pregunta
sobre las relaciones de intercambio de informacion, entonces la red representara
el intercambio de informacion; si se pregunta sobre vinculos de cooperacion,
entonces la red sera de cooperacion entre los actores; si se pregunta sobre vinculos
de amistad, entonces la red representara vinculos de amistad de los actores; entre
otros. Adicionalmente, es posible que en el disefo del instrumento de colecta de
datos de red se incluyan mdultiples generadores de nombres, pero es importante
considerar que esto puede llevar a desgastar a los “egos” (actores encuestados)
porque la encuesta consume mas tiempo durante su aplicacion.

'En este documento se aplica el término en plural de “alter” como “alters”, el cual se utiliza en la
literatura en inglés. Sin embargo, el usuario puede encontrar en otros documentos el uso de “Alteri”,
que es un término consensuado y muy usado en la literatura en espariol. Para mayor informacion se
recomienda revisar el Glosario de términos de Analisis de Redes, de la traduccion de Wasserman y
Faust, mismo que fue revisado por Veroénica de Miguel.
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Cuadro 1. Ejemplos de preguntas generadoras de nombres

utilizadas en el ARS, aplicado a la agricultura.

Pregunta generadora de nombres

Referencia

¢Con quién habla a menudo a través de la radio mientras
esta Usted de pesca?

¢Persona, organizacion o evento de la que aprende o acude
cuando tiene problemas relacionados con la produccion de
jitomate?

¢Con quién se pone en contacto para obtener informacion
sobre el manejo y operacion de la agro-biodiversidad en su
finca de cacao?

¢Podria decir, con que otros agricultores Usted discute del
manejo y proteccion de los cultivos?

¢De quién aprende y/o a quién consulta cuando tienen un
problema en su plantacion de palma de aceite?

Construya una lista de los nombres de todas las
organizaciones con quienes Usted colabora.

Johnson (1986)

Garcia Sanchez, Aguilar Avila, y Bernal Mufioz (2011)

Isaac (2012)

Compagnone y Hellec (2014)
Aguilar-Gallegos et al. (2015)

Hermans, Sartas, van Schagen, van Asten, y Schut (2017)

Fuente: elaboracion propia.

Derivado de las preguntas realizadas durante la colecta de datos, se debe

considerar al menos lo siguiente:

 Verificar si la pregunta implica la obtencion de vinculos dirigidos.

 Clarificar si la pregunta sélo establece la existencia o no del vinculo entre
los actores o si el vinculo tiene niveles de intensidad; es decir, los vinculos

son binarios o ponderados.

 Definir si con la pregunta se establece un limite especifico de “alters” que
el “ego” puede mencionar o elegir. Algunos estudios preguntan por “los 3
mas importantes...” 0 “los 5 mas relevantes...” o “los Ultimos 3...”, etcétera.

e Explicar como se analizara la informacién obtenida.

2.2. Interpretadores de nombres

Como se ha mencionado, los datos de red se pueden colectar con uno o mas
generadores de nombres, pero siempre es importante complementar esta
informacion con datos adicionales via “interpretadores de nombres”, los cuales por
lo regular se refieren a (Marsden, 1990, 2011):

1. Datos sobre los atributos de los “egos”, como pueden ser: edad, género,
tipo de agricultor, parentesco, nivel educativo, entre otros. También se
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podria obtener informacién indirecta de los “alters” (mencionados por los
encuestados o “egos”).

2. Referencias sobre las propiedades del vinculo entre el “ego” (encuestado)
y el “alter” (mencionado por el “ego”), entre ellos: frecuencia de contacto,
intensidad de la relacion, entre otros. Como puede notarse, este tipo de
atributos estan referidos al vinculo, en lugar de al actor.

La importancia de los interpretadores de nombres radica en que después
de la colecta de datos de red y su sistematizacion, se combinan con los datos
provenientes de los generadores de nombres para medir y representar una variedad
de propiedades de la red, de los actores y de sus vinculos (Marsden, 2011).

2.3. Formato de las preguntas

Como se mostro en el Cuadro 1, existen diferentes ejemplos sobre el formato
de la pregunta generadora de datos de red. De esta forma, hay algunas ventajas
y desventajas que se recomienda tener en cuenta, pero al final la seleccion del
formato a utilizar dependera del objetivo de la investigacion, asi como del interés
particular del investigador, estudiante o profesionista.

Es importante mencionar que por lo regular se realizan preguntas abiertas
en los generadores de nombres, por lo cual el encuestado tiene la posibilidad
de mencionar a los actores que él considere mas oportunos relacionados a la
pregunta de red; en el Cuadro 2 se muestra un ejemplo. Sin embargo, el problema
principal y desventaja de estas preguntas radica en “recordar los nombres” de los
“alters”, lo cual puede llevar a olvidar nombres de actores importantes. Por otra
parte, la ventaja es que en las preguntas abiertas no se requiere conocimiento

Cuadro 2. Ejemplo de una pregunta abierta generadora de nombres.

Si usted quisiera aprender mas sobre técnicas innovadoras de produccion en su cultivo,
a quién le preguntaria o consultaria? Por favor, enliste tantos nombres como usted guste.

Fuente: elaboracion propia.
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(completo) previo de los actores que forman parte de la red, por lo que ésta se va
construyendo conforme los “egos” mencionan a los “alters”. Sin embargo, en estas
preguntas se tiene la necesidad de hacer su formulacion con la mayor precision
posible para asi evitar errores de interpretacion. Otra de las posibles desventajas
de este tipo de preguntas es que, por lo regular, deben ser administradas por
personal especializado cara a cara (conocedor de la tematica y del lugar en donde
se levantara lainformacion), por dos cuestiones: 1. La explicacion e interpretacion
correcta de la pregunta y, 2. Para apoyar al encuestado en el proceso de recordar
los nombres de los actores o para incitarlo a recordar alguno mas.

En las Figura 1y Figura 2, se ofrecen dos ejemplos de preguntas generadoras de
nombres, ambas son abiertas para que el encuestado mencione a los actores que
asocia con las preguntas mostradas (columna 1). En el primer caso (Figura 1), la
pregunta se aplico a ganaderos con cabras (Aguilar-Gallegos et al., 2017) para
identificar el flujo de informacion y conocimiento para la adopcion de practicas,
tecnologias einnovaciones en esa actividad ganadera. La pregunta va acompafada
de dosinterpretadores de nombres. Para ambas variables, se le pide al encuestador
que sélo escriba el nUmero que mejor represente el giro o actividad que tiene cada
“alter” (actor mencionado), asi como el parentesco que tiene el “ego” (ganadero
encuestado) con el “alter”, por ello se incluye al pie del formato una lista con las
posibles respuestas a obtener. Esto Ultimo facilita tanto el levantamiento de la
informacion en campo como la sistematizacion de las encuestas.

;De quién ha aprendido, se ha asesorado o ha preguntado, es decir, a quién recurre para obtener informacion y
conocimiento para implementar las practicas, tecnologias e innovaciones que realiza en su unidad de produccion
(caprina)?

Nombre del actor Giro o actividad® Parentesco®

*Sélo escriba el nimero segln corresponda: 1. Productor caprino, 2. Asesor técnico privado, 3. Extensionista de programa
de gobierno, 4. Eventos de capacitacion (institucion o personas morales), 5. Proveedores de insumos para la produccion
caprina, 6. Proveedores de pie de cria, 7. Compradores, 8. Productores agricolas en general, 9. No productores agricolas,
10. Otro (especifique)

§ Solo escriba el nimero seguin corresponda: 1. Familiar, 2. Amigo cercano, 3. Vecino, 4. Conocido, 5. Miembros del grupo
de trabajo, 6. Otro (especifique)

Fuente: Aguilar-Gallegos et al. (2017).

Figura 1. Ejemplo de una pregunta generadora de nombres aplicada a
productores caprinos, con dos atributos para los “alters” mencionados.
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En el segundo caso (Figura 2), se aplicé la pregunta mostrada a un conjunto de
extensionistas o asesores técnicos participantes en un programa gubernamental.
Basicamente se buscé identificar las fuentes de conocimiento que éstos tienen
con otros actores de un sistema de innovacion agricola. En la columna 2 se
preguntd sobre el “alter” (actor mencionado), haciendo referencia al giro o
actividad que éste desempenfia. Posteriormente, en la dltima columna (3) se pide
informacion sobre la frecuencia de contacto que se tiene con el “alter”; para ello
se utiliza una escala ordinal que va desde 1 hasta 5, donde 1 es Poco frecuentey,
5 Muy frecuente. Esta Ultima informacioén generaria un nivel de ponderacion de
la relacion. Entonces, en este caso se tuvo un atributo para el “alter” y un atributo
para la relacion.

;De quién considera Usted que ha aprendido o de quién ha obtenido informacién y conocimiento técnico para ser el
Extensionista que hoy es? Es decir, ;A quiénes considera como los actores que han sido determinantes para que Usted
sepa técnicamente lo que sabe hoy?

(1) Nombre del Actor (2) Giro o actividad (3) Frecuencia de contacto
1 2 3 4 5
1 2 3 4 5
1 2 3 4 5
1 2 3 4 5
1 2 3 4 5

1. Enelcaso del nombre del actor, intente ser lo mas especifico posible; por ejemplo, Juan Jiménez — Sanidad Vegetal.
No es recomendable sélo especificar nombre o institucion, e.g. Sanidad Vegetal o Juan.

2. Soloescriba el nimero que corresponda: 1. Productor, 2. Asesor técnico, 3. Eventos de capacitacion, 4. Proveedores
de insumos, maquinaria, y/o equipo, 5. Compradores o clientes, 6. Institucién de ensefianza-investigacion,
7. Dependencia Gubernamental, 8. Otro (especifique).

3. Lafrecuencia de contacto, evallela considerando que la variable va desde 1. Poco frecuente hasta 5. Muy frecuente.

Fuente: elaboracion propia.

Figura 2. Ejemplo de una pregunta generadora de nombres aplicada a
extensionistas, con un atributo para el “alter” y otro para el vinculo.

Cabe hacer mencion que, durante el disefio del formato de las preguntas de
red, es importante considerar la demanda cognitiva, asi como del tiempo de los
encuestados, pues se les somete a procesos de cuestionamientos que pueden ser
estresantes o de poco interés para él. Cuando se tienen preguntas de red muy
elaboradas o de muchas secciones, el encuestado puede llegar a no contestar
algunas partes o es posible que pierda el interés, contestando solamente lo
primero que le venga en mente sin necesidad de priorizar sus respuestas.
Por ejemplo, imagine un listado de nombres de una organizacion de 100
agricultores, en donde Usted quiere observar el nivel de relacionamiento entre
ellos, basicamente tendria que preguntar a cada uno de ellos por la relacién que

ANALISIS DE REDES SOCIALES: CONCEPTOS CLAVE Y CALCULO DE INDICADORES 19



guarda el encuestado ("ego") con todos los otros 99 agricultores ("alters"). A lo
anterior sume que considera colocar dos atributos por cada "alter" y un atributo
a la relacion. El tiempo que consumiria cada encuesta y la demanda de atencion
del encuestado podria llevar a obtener datos de red erréneos o con cierto nivel de
imprecision. Tal y como se ha sefalado por otros autores (Borgatti et al., 2013),
se tiene mayor probabilidad de respuesta por parte de los encuestados cuando
las preguntas estan estructuradas en formas que minimicen la irritacion, enojo,
mal entendimiento y, frustracién de los encuestados. Lo anterior, cobra mayor
relevancia cuando se tienen estudios longitudinales, en donde la participacion
mantenida y constante de los encuestados, es crucial.

2.4. Fuentes de informacion

Los puntos abordados anteriormente han estado relacionados a fuentes de
informacion primaria, en donde a la mayoria de actores que forman la red se les
hacen preguntas especificas, entre ellas generadoras de nombres einterpretadoras
de nombres. Sin embargo, existen otras fuentes de datos de red, las cuales
pueden ser secundarias; el hecho de que sean secundarias no implica que en el
disefio de la investigacion no sea necesario generar un tipo de instrumento para
la codificacion y generacion de los datos de red, lo cual, a su vez ayudaria en el
proceso de sistematizacion.

Entre las fuentes secundarias estan los datos historicos o provenientes de
registros documentales. El ejemplo clasico de este tipo de adquisicion de datos,
desde fuentes secundarias, son los extraidos por Padgett y Ansell (1993), los
cuales codificaron un conjunto de datos de red sobre nueve tipos de relacion entre
las familias élite Florentinas que sucedieron a principios del siglo 15. Otro ejemplo,
mas apegado al sector agricola, se refieren al uso de informacién documental
archivada, entre ellas propuestas de proyectos, reportes finales, minutas de varias
reuniones y, notas de periddico de varios proyectos experimentales, durante
periodo comprendido del ano 1999 hasta el 2008; con los datos recabados
y estructurados en forma de red se analizd la evolucion de redes a través del
proceso de formacion de nichos, asi como, el escalamiento de innovaciones en
sistemas de innovacion agricola (Hermans, Stuiver, Beers, & Kok, 2013; Hermans,
van Apeldoorn, Stuiver, & Kok, 2013).

Aunado a lo anterior, se tiene la creciente informacion disponible por medios
electronicos; de hecho, muchos sitios de internet contienen informacion que
facilmente se puede estructurar con formato de datos de red. El detalle con
los datos historicos y de internet es que necesitan pasar por un proceso de
depuracion y limpieza para evitar errores y aumentar la precision del analisis.
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Existen numerosos ejemplos al respecto, entre ellos, los que han analizado
colaboracion internacional entre autores de articulos cientificos a escalas
globales (Barabasi et al., 2002; Leydesdorff & Wagner, 2008); lo mismo se ha
aplicado para analizar topicos especificos, por ejemplo relacionados a temas de
extension agricola (Rodriguez, Ramirez-Gomez, Aguilar-Gallegos, & Aguilar-
Avila, 2016); incluso se ha utilizado para analizar a un Journal especializado
(Valderrama-Zurian, Gonzalez-Alcaide, Valderrama-Zurian, Aleixandre-
Benavent, & Miguel-Dasit, 2007). Otros autores, han aplicado el enfoque de
redes para estudiar el complejo entramado de relaciones en Twitter (e.g., Del-
Fresno-Garcia, 2014; Del Fresno Garcia, Daly, & Supovitz, 2015) y Facebook,
aunque en estos Ultimos dos casos todavia existen desafios de interpretacion de
los relacionamientos, debido a que las conexiones entre los actores no siempre
reflejan una situacion en un mundo off-line (Borgatti et al., 2013); por ejemplo,
el término ‘Amigo’ en Facebook no necesariamente implica que en la vida real
sean amigos, inclusive puede ser que ni se conozcan.
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3. Captura de los datos de red

Posterior al proceso de colectar datos de red, otra de las tareas complementarias
y que debe ser ejecutada con sumo cuidado y atencion, es la sistematizacion y
administracion de los datos de red; es decir, el proceso de capturar la informacién
de las encuestas levantadas en campo, la edicion de los datos y su correcta
depuracion. En general, esto se realiza para dar el correcto formateo a los datos
y asi puedan ser manejados en el software de analisis de redes (Borgatti et al.,
2013), que en nuestro caso sera UCINET (Borgatti et al., 2002).

3.1. Formato de captura de los datos de red

Conrelacion al proceso de como capturar los datos de red, esimportante remarcar
que no es recomendable efectuarlo directamente en el software para el Analisis
de Redes Sociales; por tanto, sera necesario hacer uso de otro tipo de archivos
como pueden ser: hojas de calculo, bases de datos o archivos de texto. En este
sentido, para la mayoria de los usuarios, es mas recomendable el uso de una hoja
de calculo de Microsoft Excel, pues es de uso mas amplio y, ademas, lo tienen la
mayoria de las computadoras personales.

Por otra parte, una vez capturados los datos en la hoja de calculo, sera
necesario utilizar archivos de texto, pues a través de ellos se generan archivos en
formato DL (Data Language), mismos que son leidos tanto por UCINET (Borgatti
et al.,, 2002) como por NetDraw (Borgatti, 2002). Estos archivos pueden ser
considerados como intermediarios entre las hojas de calculo de Excel y los archivos
que se manejan en los softwares mencionados.

Otra posibilidad para no manejar los archivos intermedios tipo texto, es usar
el Editor de archivos DL, disponible en UCINET (Borgatti et al., 2002), (Figura 3);
basicamente ahorra el paso de generar el archivo de texto. De esta forma, los datos
se pueden capturar y administrar en una hoja de calculo para que, posteriormente,
s6lo se copien y peguen en el Editor de archivos DL (DL Editor, en UCINET). Para
abrir el Editor DL (Figura 3), se tiene que presionar el cuarto icono de la barra
de iconos de UCINET; también se puede hacer a través de la ruta Data>Data
Editors>DL Editor. Su uso se vera con mayor detalle en las secciones 3.3.1y 3.5.
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3.2. Formato de matriz
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Es uno de los formatos iniciales y comunes de trabajo para capturar datos de red.
Basicamente es el formato mas sencillo de entender conceptualmente, pero no
es el mas adecuado cuando los datos de red son abundantes. De hecho, algunos
autores se han centrado en explicar el uso de este formato (Velazquez Alvarez &
Aguilar Gallegos, 2005). En el formato de matriz, es comun que se trabajen
conjuntos de datos de red modo-uno, en donde se tendra el mismo niimero de
filas y columnas; por tanto, los titulos de filas y columnas son los mismos; dichos
titulos corresponden a las etiquetas de los nodos que conforman la red. De tal
forma, cuando se sistematizan en una hoja de Excel, las etiquetas deben quedar
tanto en la primera fila como en la primera columna.

La Figura 4 muestra un ejemplo de datos de red formada por siete nodos y
siete vinculos dirigidos (Aguilar-Gallegos et al., 2016). Dicho ejemplo guarda
las caracteristicas mencionadas anteriormente. Es importante destacar que los
vinculos en este ejemplo sblo estan midiendo presencia/ausencia (1/0) de la
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Datos de red en matriz - Excel
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Figura 4. Ejemplo de captura de datos de red en formato de
matriz, usando una hoja de calculo de Excel.

relacion, por lo cual la matriz se llena con “1” en las celdas donde exista la relacion
entre los pares de nodos. Otra caracteristica del ejemplo es que los vinculos son
dirigidos; por tanto, la matriz es asimétrica. Esto ultimo se puede notar entre los
pares de nodos A-B, donde A refiere a B, pero B no refiere al nodo A (Figura 4).
Por supuesto, en el formato de matriz se pueden capturar tanto redes no dirigidas
como ponderadas.

Una vez capturados los datos de red en Excel, éstos facilmente se pueden
copiar y pegar en el Editor de matrices (Matrix spreadsheet editor) de UCINET
(Figura 5). En algunos casos, es importante configurar el tamafio de la matriz de
datos, esto se realiza del lado derecho de |a pantalla en las opciones de “Matrix
size”. En algunas otras ocasiones so6lo se copian y pegan los datos para que el
tamafo de la matriz se ajuste automaticamente (Figura 6). Notese como en la
Figura 4 sélo se han capturado las relaciones existentes en la red; sin embargo,
para una correcta gestion de los datos es importante rellenar las celdas vacias
con “0”, porque eso indica que no existe la relacion. Esto se puede realizar desde
Excel o en su caso en el Editor de matrices. En el Gltimo caso, se debera utilizar
el men( Transform>Fill y aparecera una ventana de configuracion (Figura 7a.);
en esta ventana sélo se debe seleccionar la opcion “Blank values” en la opcion
de “Replace” y también la opcion “Zeros” en la opcion “With” (Figura 7a), esto
indicara al programa que “remplazara las celdas en blanco con valores de 07,
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esto se aplica a toda la hoja y todas las celdas. El resultado se puede observar en
la Figura 7b, en donde todas las celdas estan llenas, ya sea con 1 o con 0. Para
guardar los datos se puede seguir una de las siguientes opciones:

Ir al menu File>Save.

Presionar la combinacion de teclas Ctrl + S.

Presionar el tercer boton de la barra de iconos del Editor de matrices, que
hace alusion a un disco de almacenamiento.

Al guardar el archivo en formato de UCINET, se crearan dos archivos, uno
con extension ##h y otro con ##d. Es importante mencionar que ambos archivos
trabajan en conjunto y, por tanto, los dos son necesarios. Si esta red que se
acaba de trabajar se abriera con NetDraw (Borgatti, 2002), se obtendria una
ilustracion muy similar a la mostrada en la Figura 8. El uso de la visualizacion de
datos de red se abordara a mas detalle en la seccion 4, por ello no se explica en

este momento.

Transform

TSl
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Figura 5. Editor de matrices de UCINET, tercer icono de la barra de iconos.
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Figura 7. Proceso de llenado de las celdas vacias con 0 desde el Editor de matrices.

El uso de matrices para realizar el proceso de captura no es recomendable
cuando el tamafio de la red es grande (podriamos decir, mayor a 30 nodos) y mas
aun cuando en la red existen muchos pares de nodos que no estan vinculados, es
decir, en una red dispersa, debido a que es dificil identificar los nodos que si estan
vinculados y so6lo en esa celda escribir el valor correspondiente. Ademas, este
procedimiento de captura de redes en matriz puede consumir mucho tiempo,
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Figura 8. Visualizacion de la red de siete nodos y siete vinculos dirigidos en NetDraw.

incluso, se puede incurrir en errores importantes. Para el analisis de redes con
gran cantidad de actores es mas recomendable el formato de lista, que se vera en
el siguiente apartado.

3.3. Formato de lista de nodos
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Cuando el nUmero de vinculos existentes en la red es pequefo, en relacion con
el nUmero de vinculos posibles, mismo que dependera del nUmero de actores en
la red, se consume mucho tiempo capturando los datos de red con el formato de
matriz (seccion 3.2). En estos casos, el formato de lista de nodos es mas sencillo
de utilizar, pues so6lo se declaran los nodos que tienen alguna relacion, lo cual
reduce significativamente el tiempo de sistematizacion.

Uno de los formatos de lista de nodos mas utilizado es el Nodelist1; es el
mas economico en uso de recursos y, por tanto, el mas sencillo de usar en la
sistematizacion de datos de red (Borgatti et al., 2013). Este formato tiene las
siguientes caracteristicas:

« Solo puede ser usado para datos binarios (1/0) que indican presencia y
ausencia de la relacion.

* No es aplicable para indicar fuerza o intensidad de los vinculos entre
actores.

e Es una lista de nodos porque basicamente la l6gica de captura es que
primero se enuncia el actor encuestado ("ego") y, posteriormente los
actores mencionados (alterl alter2 alter3 ...).
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Supongamos un ejemplo de seis nodos con once vinculos, los cuales se
capturaron en una hoja de Excel siguiendo la l6gica descrita del formato Nodelist1
(Figura 9). De esta forma, se puede observar que los nombres que aparecen
primero en cada fila son los “egos” o los que “envian” el vinculo y, posteriormente,
estan enunciados los “alters” o los que “reciben” el vinculo. Veamos el caso de
“Elizabeth” quien envia un vinculo hacia “Celia”, “Benito”, “Dante” y, “Fatima”,
esto indica que en la red se vera que existen diversos vinculos que se originan
desde “Elizabeth” y que van hacia los otros cuatro actores. Algunos de ellos seran
reciprocos, por ejemplo, “Fatima” también envia un vinculo hacia “Elizabeth”. Y asi
sucesivamente para cada caso.

c7 M Jr
A B C D E F
1 |Ego Alterl Alter2 Alter3 Alterd
2 Alberto Celia
3 Benito Alberto Elizabeth
4 Celia Alberto
5 |Elizabeth Celia Benito Dante Fatima
6 Dante Elizabeth Fatima
7 |Fatima Elizabeth

Figura 9. Ejemplo de captura de una red de seis nodos y once vinculos,
capturados en una hoja de calculo, con la l6gica Nodelist1.

Con el ejemplo anterior se destaca el hecho que, para la captura de datos de
red, es muy util generar plantillas en Excel que ayuden a identificar en qué lugar
se captura el “ego” o encuestado y, en qué casillas se escribiran los nombres de
los “alters” o de los actores con los que el “ego” dice tener algun tipo de vinculo,
dependiendo del tipo de red. Un ejemplo se muestra en la Figura 10, donde los
encabezados ayudan a guiar la captura de los datos de red, asi como el sombreado
de las columnas para evitar confusiones. Asi mismo, es Util crear claves que
identifiquen el tipo de actores, por ejemplo, E = empresa; Ere = Empresa referida,
Ext = Extensionista, entre otros; ver Aguilar-Gallegos et al. (2016) que utilizan
diferentes iniciales para clasificar a los tipos de actores participantes en la red.

Una vez que los datos se han capturado en una hoja de Excel como las anteriores,
se procede a generar el archivo de texto que pueda ser leido por UCINET y NetDraw.
Se debe aclarar que este proceso seria intermedio entre el archivo de Excel y
los archivos tradicionales que maneja UCINET. Sin embargo, el archivo de texto
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Archivo  Inicio  Insertar Disefio de pagina Férmulas Datos  Revisar  Vista

G11 - S
A B C D E F G
Folio del Actor Actor Actor Actor Actor Actor
1 |Encuestado Referidol Referido2 Referido3 Referido4 Referido5 Referido6
2 Er01 Er02 Er03
3 |Er02 Er01 Er05 Er06
4 |Er03 Er01 Er02 Er04 Er06 Er08
5 Er04 Er01 Er03
6 [Er05 Er07
7 Er06 Er01 Er02 Er04 ErQ5
g Er07 Er01
9 Er08 Er05
10 Er09 Er01 Er02 Er03 Er04 Er07 Erl0
11 |Er10 Er03

12

Figura 10. Ejemplo de plantilla disefiada en una hoja de calculo
para capturar datos de red en formato Nodelist1.

si puede ser utilizado directamente en NetDraw. Con esta aclaracion en cuenta,
en la Figura 11 se muestran los datos copiados y pegados (de la Figura 9) en un
archivo de texto, para lo cual usamos el Bloc de Notas (programa que forma parte
de cualquier computadora que trabaja en entorno Windows).

EjemnploNodelist1Texto: Bloc de notas — O X

Archivo Edicion Formato Ver Ayuda
dl n=6

format=nodelistl

labels embedded

data:

Alberto Celia

Benito Alberto Elizabeth
Celia Alberto

Elizabeth Celia Benito Dante Fatima
Dante Elizabeth Fatima
Fatima Elizabeth

Figura 11. Datos de red de la Figura 9, en un archivo de texto con
formato Nodelist1 y usando el lenguaje de datos DL.
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En los archivos de texto, para datos de red, se usa el lenguaje de datos DL
(Data Language). A continuacion, se describe como esta formado el archivo (ver
Figura 11):

i. El “dl” al principio indica que el texto que viene enseguida sera tratado
como un archivo DL.

ii. El “n=6" indica el tamafo de la red, el cual viene siendo el nimero de
actores o nodos que forman la red. Es importante destacar que el “n” no
necesariamente esta relacionado al nUmero de encuestados durante la fase
de generacion de datos de red, sino que es el total de “egos” que fueron
encuestados mas los “alters” que, aunque no hayan sido encuestados,
fueron mencionados por los primeros.

ii. Enlasiguiente fila, lainstruccion “format=nodelist1”, hace referencia a que
los datos siguen un formato de lista de nodos “nodelist1”.

iv. Lainstruccion “label embedded” indica al programa que las etiquetas
de los actores o nodos estan insertadas en los datos de red, es
decir, con esta instrucciéon no hace falta declarar primero el listado
de etiquetas de todos los nodos y, después, hacer mencion de los
vinculos entre ellos.

v. Por dltimo, la linea “data:” indica el fin de la informacion con respecto
a la organizacion de los datos de red para dar inicio precisamente a las
relaciones entre los actores de la red.

Posteriormente, el archivo de texto (ver Figura 11) simplemente se almacena
en la computadora como un archivo con extension “.txt” normal y, de esta forma,
puede ser leido por NetDraw para generar el grafico de red, que vendria siendo
similar al de la Figura 12. En su caso, el archivo puede ser leido por UCINET para
generar los archivos con los cuales trabaja dicho programa.

Es importante mencionar que con el uso de la instruccion “label embedded”, se
debe tener cuidado en incluir en el listado a los actores aislados. Es decir, en filas
nuevas se colocaran las etiquetas de los “egos” que, aunque no tengan vinculos con
otros actores, forman parte de la red. De esta forma, este tipo de actores sueltos
si se tienen en cuenta dentro de la red. Un ejemplo de esto se proporciona en la
Figura 13, donde se puede ver que los actores “Gloria”, “Homero” e, “Ignacio” no
tienen vinculos con ningln otro actor, y entonces se declaran en lineas nuevas. La
visualizacion de este ejemplo se presenta en la Figura 14, en ésta se logra observar
que dichos actores estan sueltos (no conectados a ninguin actor) y se agrupan del
lado superior izquierdo.
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Alberto

Dante

Figura 12. Red construida con el formato Nodelist1, con 6 nodos y 11 vinculos dirigidos.

| EjNodelist1NodosSueltos: Bloc de notas — O X

Archivo Edicién Formato Mer Ayuda
dl n=9

format=nodelistl

labels embedded

data:

Alberto Celia

Benito Alberto Elizabeth
Celia Alberto

Elizabeth Celia Benito Dante Fatima
Dante Elizabeth Fatima

Fatima Elizabeth

Gloria

Homero

Ignacio

Figura 13. Ejemplo de red con nodos sueltos, capturada en formato Nodelist1.

Cabe destacar en este punto que el programa es sensible al uso de mayusculas
y minusculas, asi como de caracteres especiales; por ejemplo, Leticia y leticia
son dos actores diferentes, de la misma forma, Aarén y Aaron. Aunado a esto,
el problema se acentlia cuando se tienen errores de deletreo y de ortografia,
veamos; Leticia y Letycia resultarian en dos nodos diferentes en la red, asi como
Aaron y Arén.
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Celia

[ Gloria
[ Homero

@ Ignacio
Aberto

Fatima
Elizabeth

Dante

Figura 14. Visualizacion de la red capturada en la Figura 13 en NetDraw.

En este sentido, una recomendacion muy util es capturar los datos usando
solamente dos columnas en la hoja de Excel (Figura 15a), es decir, por pares de
nodos relacionados y, una vez sistematizados, copiarlos y pegarlos en el archivo
de texto (Figura 15b). Este tipo de captura tiene la ventaja de utilizar la funcion
de autocompletar de Excel, que ayudara a evitar errores de captura y, de hecho, la
agiliza. El Unico detalle de este tipo de captura es que el “ego” se tiene que repetir

Archivo  Inicio Insertar Disefio de pégin | EjNodelist1PorPares: Bloc de notas
Archivo Edicion Formato Ver Ayuda
B15 - fi dl n=9
format=nodelistl
A B C labels embedded
1 Ego Alter data:
2 Alberto Celia Alberto Celia
3 Benito Alberto Benito Alberto
4 Benito Elizabeth Benito Elizabeth
5 Cela  Aberto Ei?iﬂb operto.
i ) izabe elia
- e Flizabeth  Senito
Elizabeth Dante
8 |Elizabeth  Dante Elizabeth Fatima
9 Elizabeth  Fatima Dante Elizabeth
10 Dante Elizabeth Dante Fatima
11 Dante Fatima Fatima Elizabeth
12 Fatima Elizabeth Gloria
13 Gloria Homero
14 Homero Ignacio
15|Ignacio | ]
a. Sistematizacion b. Archivo de texto

en Excel

Figura 15. Ejemplo de Nodelist1 sélo usando dos columnas en
su sistematizacion y creacion del archivo de texto.
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tantas veces como “alters” tenga, situacion que simplemente se soluciona copiando y
pegando la etiqueta del “ego”. En la Figura 15, por ejemplo, el nombre de “Elizabeth”
se repite cuatro veces, pues es el nUmero de “alters” que tiene dentro de la red.

Cuando se tienen pocos actores en la red o los actores estan completamente
especificados (por ejemplo, agricultores con nombre y apellido o nombres de
empresas, o nombres y apellidos de investigadores, entre otros), las etiquetas
se pueden escribir con espacios. En este sentido, vuelve a ser mas recomendable
hacer la capturasélo endos columnas para evitar errores de deletreo u ortograficos
(ver Figura 15a). Sin embargo, en el archivo de texto se deben poner las etiquetas
de los actores entre comillas para que el lenguaje de datos DL pueda leerlos de
manera correcta (Figura 16). El grafico de red resultante se puede visualizar en la
Figura 17, en donde las etiquetas de los nodos estan compuestas por dos palabras.

| EjemploNodelist1TextoEtiquetas: Bloc de notas — | X

Archivo Edicién Formato Ver Ayuda

dl n=7

format=nodelistl

labels embedded

data:

"Enrique Enriquez" "Aardn Aguilar"
"David Dallas" "Aardn Aguilar”

"Aardn Aguilar" "Berenice Barrios"
"Berenice Barrios" "Carlos Camarillo"
"Carlos Camarillo" "Felipe Fernandez"
"Felipe Fernandez" "Carlos Camarillo"
"Gustavo Gallegos" "Carlos Camarillo”

Figura 16. Ejemplo de datos de red en formato Nodelist1, usando un archivo
de texto, con etiquetas de los nodos formadas por dos palabras.

Gustavo Galegos Enrique Enriquez

Carlos Camarilo . | Aardn Aguilar

David Dallas

Felipe Fernandez

Figura 17. Grafico de red resultante de la captura de nodos cuyas
etiquetas contienen espacios, derivado de la Figura 16.
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3.3.1. El Editor DL de UCINET

Como se menciond, en UCINET existe una opcion para la creacion directa
de los archivos que contienen los datos de red en el formato que trabaja el
mismo programa; este es conocido como Editor DL (DL Editor, ver Figura 3).
Con el uso de este Editor, se logra ahorrar el proceso de crear los archivos de
textos vistos anteriormente. Esto no significa que los procedimientos explicados
no sirvan o no sean de utilidad, sino que simplemente el uso Editor DL es otra
forma de crear los archivos de red; el usuario podra elegir entre usar un método
u otro. Para abrir el Editor DL, se tiene que presionar el cuarto icono de la
barra de iconos de UCINET, pero también, se puede hacer a través de la ruta
Data>Data Editors>DL Editor.

Para ejemplificar su uso, trabajaremos con los datos capturados en el formato
Nodelist1 que se realiz6 en la Figura 9. Recordando, en esta red hay seis nodos
con once vinculos (ver Figura 12). Basados en que los datos de red ya se han
sistematizado en una hoja de calculo, y una vez abierto el Editor DL, s6lo se tienen
que copiar los datos desde la hoja de calculo y luego se deben pegar en el Editor DL.
Sin embargo, es importante mencionar que en el caso del formato Nodelist1 no se
copian los encabezados de las columnas, s6lo se copian y pegan los datos de los
relacionamientos entre los actores.

Una vez que se han copiado y pegado los datos en la ventana del Editor DL
(Figura 18) es importante considerar que se tienen que hacer algunas
configuraciones para especificar el tipo de datos que se estan trabajando y el
formato en el cual se han capturado. De esta forma se especifica lo siguiente:

i. Enlacasilla del “Data format” se debe seleccionar la opcion “Nodelist1
(ego alter1 alter2 ...)”. Como el lector podra apreciar, existen muchos
otros formatos, incluido el formato de matriz visto en la seccion
3.2. Pero debido a que los datos que estamos trabajando fueron
sistematizados en formato Nodelist1, es que se selecciona esa opcion.
Si fuera el caso que los datos de red se sistematizaran en otro formato
(por ejemplo, usando Edgelist1 que se vera en la seccion 3.4), entonces
se seleccionaria esa opcion.

ii. Las primeras casillas, que hacen referencia a los encabezados de las filas
y columnas (“Spreadsheet headers”), se deben desactivar puesto que los
datos capturados sélo tienen encabezados de columnas, pero no hacen
falta al momento de copiarlos y pegarlos. Esta opcion es importante para
cuando los datos estan en formato de matriz, porque en ese caso si hay
encabezados, mismos que hacen referencia a las etiquetas de los nodos.
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Existen otras caracteristicas configurables, algunas de ellas son
importantes. En el caso especifico de “Duplicate ties”, se recomienda
activar la primera opcién “Sum/count up”. Con esta opcion activada, si
en los datos existen vinculos duplicados, los ira sumando y entonces se
obtendrian relaciones ponderadas. De lo contrario, y si se busca que sélo
aparezcan vinculos binarios, se puede cambiar a la opcion “Ignore” que
hara que cuando un vinculo entre dos nodos esté duplicado, éste no se
tome en cuenta.

Otra casilla de interés es la relacionada a forzar la simetria de las relaciones
“Force symmetry”, para nuestro caso la casilla esta desactivada. Por
supuesto, si los datos de red capturados implican simetria, entonces esta
casilla se debe activar.

Un detalle importante cuando se capturan los datos de red en formato de lista
es que, por lo regular, éstos se ordenan automaticamente en forma alfabética;
para ello se activa la casilla “Sort alphabetically”, lo cual es importante porque
en la mayoria de los procedimientos para el calculo de indicadores, éstos se
muestran en orden alfabético seguin la etiqueta del nodo.

Al final, después de haber configurado las opciones comentadas, so6lo se
tienen que guardar los datos contenidos en el Editor DL, ya sea utilizando

0 I
Ceba A Dats format
A 53 n
. - Hodelet L (ege aiter 1 abter 2

[ gt
Fabra

Fétma e

[ Col bemcings
[ ] Ravw heacngs

Bursbeth
Elrabeth

Duplcate bes
8 S foourt up
) igrore
Cutput Optors
£ secnde mesmng 1 0
[ rerce symmetry

[ Sort sighabescaly

Edang mode Enabie [/ mouse
) Select cals # o resang
@) Edn cels Cal remcrg

Row resang

Figura 18. Ejemplo de un formato de datos de red usando Nodelist1,
con 6 nodos y 11 vinculos dirigidos, con el Editor DL de UCINET.
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el cuarto icono (que hace referencia a un disco de almacenamiento digital)
o usando la ruta File>Save UCINET dataset. Este procedimiento genera
los archivos respectivos en el formato que reconocen UCINET y NetDraw,
mismos que pueden ser usados directamente en ambos programas.

Es conveniente comentar que el uso del Editor DL no solo se restringe al
formato Nodelist1, pero se ha explicado en esta seccion puesto que es uno de
los formatos mas usados en la sistematizacion de datos de red. No obstante,
también en el Editor DL se pueden utilizar datos capturados en formato de matriz,
Nodelist2, Edgelist1, Edgelist2, Edgelist23, entre otros. Sin embargo, dependiendo
del formato que se utilice sera necesario configurar algunas de las opciones
comentadas anteriormente. El usuario encontrara muy intuitivo el uso del Editor
DL después de conocer las caracteristicas basicas de cada uno de los formatos de
captura. En este sentido, a continuacion se abordara otro formato conocido como
“lista de vinculos”.

3.4. Formato de lista de vinculos

El formato de lista de vinculos esta conformado por pares de actores relacionados,
donde precisamente cada una de las filas representa un vinculo entre los actores
dentro de la red, de ahi su nombre. Lo mas importante de este formato, y que
de hecho es lo que lo diferencia del anterior, es que sirve para declarar niveles de
intensidad de los vinculos, por lo que cada par de nodos vinculados se escribe en una
fila. Por tanto, el formato se compone por tres columnas, la primera hace referencia
al “ego”, la segunda al “alter”, y la tercera a la intensidad del vinculo.

Uno de los formatos mas Utiles para sistematizar datos de red siguiendo esta
l6gica es el Edgelist1. En la Figura 19, se muestra un ejemplo de doce nodos que
fueron capturados en un archivo de Excel para su posterior uso. En el ejemplo se
logra ver facilmente que la primera columna es la etiqueta para el “ego”, la segunda
para los “alters” y, la tercera para el nivel de intensidad del vinculo entre ellos.

Después de la captura de los datos de red, éstos se pueden copiar y pegar
en un archivo de texto para crear el archivo que sera usado para visualizar la red
y su analisis respectivo. La l6gica que se sigue es basicamente la misma que en
el formato de lista de nodos (ver seccion 3.3), sin embargo, se debe cuidar que
en la linea del formato se declare como “format=edgelist1”. En la Figura 20 se
proporciona el ejemplo del archivo de texto. En éste también se puede apreciar que
se incluyd la opcion “symmetric=yes” para especificar que los datos seran tratados
como simétricos, aunque no necesariamente se debe declarar asi en todos los
casos; esto dependera del tipo de datos de red y, por supuesto, de la pregunta
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Archivo  Inicie  Insertar Disefio de pdgina  Farmulas

c20 2 o1
A B C D

1 Ego Alter Intensidad

2 Huge Isaac 4
3 Huge Oscar 2
4 lsaac Leticia 4
5 lIsaac Rosa 1
6 Jorge Samuel 2
7 Karen Marco 5
8 Leticia Pascual 3
9 Leticia Marco 5
10 Marco Isaac 5
11 Marco Querubin 1
12 Nora Querubin 1
13 Oscar Isaac 3
14 Pascual Hugo 1
15 Querubin  Leticia 2
16 Rosa Hugo 2
17 Rosa Nora 3
18 Samuel Oscar 4
19 Samuel Leticia 1
20 ‘Samuel Nora 1

21

Figura 19. Ejemplo de una captura de datos de red en Excel con formato Edgelist1.

| tjemploEdgelist1 Texto: Bloc de notas — O >
Archive Edicién Formato Ver Ayuda
dl n=12
format=edgelistl
symmetric=yes
labels embedded
data:
Hugo Isaac 4
Hugo Oscar 2
Isaac Leticia 4
Isaac Rosa 1
Jorge Samuel 2
Karen Marco 5
Leticia Pascual 3
Leticia Marco 5
Marco Isaac 5
Marco Querubin 1
Nora Querubin 1
Oscar Isaac 3
Pascual Hugo 1
Querubin Leticia 2
Rosa Hugo 2
Rosa Nora 3
Samuel Oscar 4
Samuel Leticia 1
Samuel Nora 1

Figura 20. Disefio del archivo de texto con formato Edgelist1, del ejemplo de la Figura 19.
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generadora de nombres utilizada (ver seccion 2.1) y de la reciprocidad que se
asume en las “menciones”; por ejemplo, si “Hugo” dice estar “relacionado” con
“lsaac”, se asume entonces que “lsaac” también esta “relacionado” con “Hugo”.
Después de guardar el archivo y, posteriormente, abriéndolo en NetDraw, el
grafico de red resultante se visualizaria similar a la Figura 21. En la red se puede
apreciar como, entre mayor nivel de intensidad del vinculo entre los nodos, mayor
es el grosor de la linea que los une, y viceversa.

Figura 21. Grafico de red obtenido del ejemplo de la Figura
19, con 12 nodos con intensidad de los vinculos.

3.5. Formato Edgelist23

En el Editor DL de UCINET, como ya se apunt6 en secciones anteriores, existen
otros formatos para la introduccion de datos de red. Uno de los mas interesantes
es el formato Edgelist23, el cual es Util para introducir datos de diferentes tipos de
relaciones en un mismo archivo, lo cual permitiria, con el adecuado manejo del
software (NetDraw), visualizar distintos tipos de vinculos usando el mismo
archivo de red. Esto es relevante debido a que es comun que, cuando se generan
los datos de red, no sélo se pregunta por un tipo de relacion, sino que se pueden
hacer varias preguntas para obtener distintas relaciones.

Para ejemplificar, supongamos que se pregunta a un conjunto de diez
“w.,n

agricultores sobre a quiénes “conoce” que han adoptado la innovacion “x”, entonces
esa lista de menciones se escribe en un generador de nombres. Después, se afiade
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la pregunta, de los enlistados a quienes considera que poseen “conocimiento” de
calidad para la difusion de esa innovacion, los nombres que haya mencionado se
marcan en una casilla especial. Por Ultimo, se le vuelve a preguntar, si con alguno de
ellos ha “recurrido” para acceder a informacién y conocimiento sobre la innovacion;
los nombres que vuelva a mencionar se marcan en otra casilla especial. Esta
informacion permitiria generar tres tipos de redes que representarian tres tipos de
relaciones, pero que estan vinculadas unas con otras. Para no tener que formatear
una red por cada pregunta, se puede recurrir al formato Edgelist23. Un ejemplo
similar se puede encontrar en un estudio sobre redes de colaboracion, intercambio
de conocimiento e influencia (Hermans et al., 2017). En este estudio, primero
pidieron construir un listado de actores con los que el encuestado ha colaborado;
después preguntaron que de ese listado encerraran en un circulo a los cinco actores
que consideraban como mas importantes para el intercambio de conocimiento vy,
también, que encerraran cinco actores (de la misma lista inicial) que consideraran
como los mas influyentes; por lo cual se generaron tres tipos de redes.

Siguiendo el ejemplo planteado de los 10 agricultores, en la Figura 22, se muestra
como es que los datos son formateados. Como se puede apreciar, el formato esta
escrito considerando cada fila como una relacion entre el “ego” (columna 1) y el “alter”
(columna 2), si el “ego” tuviera mas de una relacion, se repiten tantas filas como “alters”
tenga. Posteriormente, en la columna 3, se escribe el tipo de relacion o la red a la cual
estara asociado el vinculo entre los actores. En el ejemplo, los denominamos como “1
Conoce”, “2 Conocimiento”y, “3 Recurrido”; los nimeros al inicio los incluimos para dar
un orden a las tres redes, y asi sean visualizadas en NetDraw. También es importante
mencionar que en el Editor DL se deben cuidar algunas configuraciones, entre ellas:
en la casilla de “Data format” se selecciona “Edgelist23 (node node relation [value])”,
si existen relaciones duplicadas se pide que se sumen “Duplicate ties: Sum/count
up”, para el ejemplo no se consideran las relaciones como simétricas (casilla “Force
symmetry” sin activar), entre otras mostradas en la Figura 22. Después de guardar el
archivo en formato de UCINET, y al abrirlo en NetDraw, las redes se pueden visualizar
en conjunto o por separado, lo cual dependera del objetivo de la investigacion (para
mas informacion sobre el uso de NetDraw ver seccion 4.1). En el caso del ejemplo
descrito, las tres redes se muestran por separado en la Figura 23.

Es importante destacar que con el formato Edgelist23 también se pueden
trabajar relaciones con intensidad, lo cual puede ser interesante para alguien que
quiera visualizar cambios o evolucion en los relacionamientos e intensidades entre
un conjunto de actores de una red en particular. También es importante recalcar
que el uso de este formato no esta limitado a datos de red que estén conectados o
que vayan encadenados como lo fue el ejemplo propuesto (Figura 22) o como el
realizado por otros autores (Hermans et al., 2017), es decir, que uno dependa de
otro. De hecho, los datos de red pueden representar diferentes tipos de relaciones
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Figura 22. Datos de red de 10 nodos con formato Edgelist23 en el Editor DL de UCINET,
para sistematizar tres tipos de relaciones entre los nodos de la red en un mismo archivo.
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Figura 23. Graficos de red de los datos formateados como Edgelist23,
mostrando tres tipos de relaciones en redes distintas.
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como es el del caso de las familias Florentinas (Padgett & Ansell, 1993). Para
mostrar el ejemplo, dentro de los archivos que se incluyen en UCINET (Borgatti et
al., 2002), se encuentra uno con los datos de dos diferentes vinculos sociales de
dichas familias: los vinculos de matrimonios y negocios, que se pueden visualizar
en la Figura 24. Otro caso de este tipo, se presenta en un estudio sobre una red
de embarcaciones autorizadas para la pesca (Maya Jariego, Florido del Corral,
& Saez, 2017), donde se recolectan los datos de red a través de un listado de
embarcaciones, en este listado cada uno de los encuestados marca tres tipos de
relaciones: relaciones personales, informacion ecologica y apoyo social. En este
caso, las redes no estan anidadas una dentro de otra, pero si estan relacionadas y
se levantan con el mismo instrumento de colecta de datos; de esta forma, los tres
tipos de redes se podrian sistematizar usando el formato Edgelist23.

WSROz
LAMBERTESCHT

B RIDOLA

B ACCIALIOL
ABEzl @

TORNABLONI

Figura 24. Graficos de red de dos relaciones sociales (izquierda, matrimonios; derecha,
negocios) de las familias Florentinas. Se usaron los datos de los ejemplos proveidos en UCINET.

3.6. Formato para los atributos de los actores

Una de las propiedades del Analisis de Redes Sociales (ARS), es que las redes se
pueden representar incluyendo caracteristicas de los nodos que la conforman.
Estas caracteristicas tipicamente se conocen como “atributos”, los cuales
precisamente ayudan a diferenciar alos nodos unos de otros (Borgattietal., 2013).
Los atributos, como se indicd anteriormente (ver seccién 2.2) se obtienen de los
interpretadores de nombres. Ademas, se pueden crear atributos de diferentes
tipos y pueden ser variables binarias, tales como el género (0: Hombre, 1: Mujer;
0: No adopta cierta innovacion, 1: Adopta la innovacion; 0: No recibi6 subsidio, 1:
Si recibi6 subsidio); también pueden ser variables nominales, como el municipio
en donde vive el actor; de la misma forma, se pueden incluir atributos ordinales,
por ejemplo, la superficie medida en rangos (1: Menos de tres hectareas; 2: Entre
3 y 10 hectareas; 3: Mas de 10 hectareas) y, por supuesto, también se pueden
incluir atributos cuantitativos continuos como es la edad de los actores, un indice
de adopcion de innovaciones, nimero de cabezas de ganado que posee, etcétera.
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En este ultimo caso, también existe la posibilidad de incluir como atributos
algunos indicadores derivados del ARS, tales como el grado de entrada, grado
de salida, intermediacion, entre otros (e.g. Aguilar-Gallegos et al., 2016, que
utilizan diferentes indicadores del ARS como atributos de los actores); este tema
se tratara a mas detalle en la seccion 5.

En este sentido, la forma en la cual se capturen los atributos de los actores y
después se genere un archivo que los contenga, es importante. De los formatos
hasta ahora vistos (secciones 3.2 a la 3.4), la forma mas facil de formatear los
datos de red es utilizando el formato de matriz (seccion 3.2). Sin embargo,
es importante aclarar desde aca que en este caso se generaria una matriz no
cuadrada, es decir, la matriz tendria diferente nimero de filas y columnas.

Retomando el ejemplo de la Figura 12, de una red con 6 nodos y 11 vinculos
dirigidos. En la Figura 25 se muestran cuatro atributos para los seis actores del
ejemplo mencionado (ver Figura 12). Cada uno de los atributos hace referencia
a un tipo de variable con las caracteristicas descritas en el parrafo anterior, es
decir, se incluye un atributo de cada tipo: binario, para el género; nominal, para
la localidad; ordinal, para la superficie en rangos; continua, para la edad. Como es
posible apreciar, las variables tipo binaria, nominal y ordinal deben ser codificadas;
por ejemplo, no se especifica hombre o mujer, sino que es 1: hombre, y 2: mujer.
Lo mismo para la localidad y superficie.

Archivo Inicic  Insertar Disefio de pagina  Férmulas  Datos  Revisar  Vist

E7 5 foooo29
A B C D E F
Actor Genero Localidad  Superficie Edad
1 | (Binaria)  (Nominal) (Ordinal) (Continua)
2 |Alberto 1 1 3 64
3 |Benito 1 2 1 45
4 _Celia 2 1 2 57
5 |Dante 1 2 1 29
6 Elizabeth 2 1 3 30
7 |Fatima 2 1 2 29 |
8

Figura 25. Ejemplo de cuatro atributos para seis actores, capturados en Excel.

Una vez que se tienen los atributos capturados en una hoja de Excel, éstos
son copiados y pegados en el Editor de matrices de UCINET (tercer icono de la
barra de iconos). En la Figura 26 se muestra el resultado de dicho proceso. Tal y
como se habia sefalado anteriormente, la matriz no tiene el mismo nimero de
filas y columnas, en este caso son seis filas que representan a los actores o nodos
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de la red, y son cuatro columnas que hacen referencia al nimero de atributos
que contendra el archivo. Guardando este archivo en formato de UCINET, para
posteriormente agregarlo a la visualizacion de la red (ver Figura 12), se podria
activar cualquiera de los cuatro atributos. En la Figura 27 se muestra como se
visualizaria la red con el atributo del género, donde se puede apreciar el uso de
dos colores: el azul para mujeres y, el rojo para hombres.

; ﬂ Matrix Editor = O *
File Edit Transform
4 E H <col> @ [ symmetrize as you type
' [1 |2 3 a
| | [ | ! ) Matrix size
[ Actor Genero (Binaria) Localidad (Mominal) Superfice (Ordinal) Edad (Continua) -
{1 Aberto 1 1 3 64 R
2 Benito 1 2 1 45 Cols: |4 l
3 Celia 2 1 2 57
4 Dante 1 2 1 2
5 Elizabeth 2 1 3 30
6 Fatima 2 1 2 fg___"
| T LUse row &
column 0 for
labels
‘\Sheet 1

Figura 26. Ejemplo de cuatro atributos para seis actores en el Editor de matrices de UCINET.

Dante

Figura 27. Grafico de red de seis nodos, mostrados por el atributo género.
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4. Visualizacion de redes

Una vez que se han creado los archivos respectivos de los datos de red, una de las
primeras tareas que la mayoria de las personas quiere hacer con los datos, y de
hecho, asi es recomendable proceder, es construir una representacion visual de la
red (Borgattietal., 2013). Conello se tiene el primer golpe de vista y de analisis de
la estructura de la red. Es importante destacar que este proceso es basicamente
cualitativo y el entendimiento de la red se completara hasta que se tenga el
respectivo analisis cuantitativo (que se abordara en la siguiente seccion). Este
procedimiento de analisis grafico permite realizar representaciones de sistemas
sociales en forma de red a través del uso de puntos (nodos o actores) y lineas
(vinculos o enlaces), que en conjunto representan tanto a los actores (puntos)
como las relaciones (lineas) entre ellos (Borgatti et al., 2013; Wasserman &
Faust, 1994).

Junto con el archivo de red respectivo, es Util generar otro de atributos de los
actores de la red (ver seccion 3.6); de esta forma se estara en posibilidades de
visualizar caracteristicas de los puntos (nodos), usando para ello colores, formas
y tamafos de los nodos. Lo cual, nuevamente, desde un punto de vista cualitativo,
nos permitira obtener mas informacion de la red. Es importante recordar que los
atributos de los vinculos (por ejemplo, niveles de intensidad de la relacion entre
los actores), son capturados en los archivos de la red y el formato recomendado
para ello es el de lista de vinculos (ver seccion 3.4); se debe recalcar que esta
informacion no se captura en el archivo de los atributos de los actores.

También se debe mencionar que en este apartado se describiran los
procedimientos basicos de la visualizacion de redes usando para ello el software
NetDraw (Borgatti, 2002), que se instala junto con UCINET (Borgattietal., 2002).
Sin embargo, existen otros tipos de software que podrian ser de interés, entre
ellos estan Pajek (de Nooy, Mrvar, & Batagelj, 2005), Gephi (Bastian, Heymann, &
Jacomy, 2009), NodeXL (Smithetal.,2009), entre otros (e.g., Visone y NetMiner).

Sin lugar a duda, elegir un buen disefio del grafico de red es un aspecto
importante de la visualizacioén de la misma (DeJordy, Borgatti, Roussin, & Halgin,
2007); en el mismo sentido, elegir un algoritmo correcto (o incorrecto) podria
llevar a interpretaciones mas precisas (o errdneas) sobre la visualizacion obtenida
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y, en algunos casos, a comunicar (visualmente) graficos de red interesantes
(o pobres) (Borgatti et al., 2013). El punto principal de cualquier algoritmo de
disefio del grafo de redes es que debe ubicar los nodos de la red de tal forma que
los graficos sean estéticos y facilmente interpretables (Dejordy et al., 2007). En
general, los graficos buscan cumplir con cinco principios para generar buenas
visualizaciones (Davidson & Harel, 1996):

1. Ladistribucion de los nodos. Deben quedar esparcidos uniformemente sobre
el espacio disponible, buscando que la distancia entre ellos sea similar.

2. Las fronteras del grafico. Se refiere a ocupar el espacio disponible para la red
tanto como sea posible. De esta forma, se busca que los nodos no queden
aglomerados en el centro, pero tampoco que se distribuyan en las fronteras
o limites del grafico.

3. Lalongitud del vinculo. Asi como se busca que los nodos queden distribuidos
uniformemente, también se desea que las lineas que unen a los nodos sean
de longitud aproximadamente uniforme.

4. Cruce de lineas. Aunque este criterio es dificil de conseguir, lo que se busca
es minimizar el cruce de los vinculos entre los actores, pero sin sacrificar una
visualizacion adecuada de la red.

5. Distancia entre nodo y vinculo. Si se busca que las lineas no se crucen,
entonces también es deseable mantener un margen de separacion entre los
nodos y las lineas mas cercanas.

En este sentido, es importante hacer notar que la informacion del disefio del
grafico de red representara los patrones en los cuales los nodos estan conectados
unos con otros, por lo cual cualquier arreglo de los nodos en el espacio es valido
y, por tanto, la ubicacion de los mismos correspondera a un disefio mas estético
y facil de visualizar (Borgatti et al., 2013). De hecho, cada vez que se abra o
cargue el mismo archivo de red en NetDraw se producira una nueva visualizacion
y, entonces, cada una de ellas sera igual de valida como la otra. Nuevamente,
se destaca el hecho de que su lectura o analisis sera meramente cualitativo,
hasta este nivel. Es importante remarcar que en este punto estamos haciendo
referencia a la visualizacion siguiendo algoritmos graficos, pero existen otros
basados en atributos; por ejemplo, coordenadas (ver Borgatti et al., 2013), y la
visualizacién con escalamiento multidimensional (ver Dejordy et al., 2007) que
no necesariamente cumplen con los cinco criterios mostrados. El uso de estos
ultimos disefios de visualizacion dependera del objetivo de la investigacion.
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4.1. Uso de NetDraw para la visualizacion de redes

Para visualizar un archivo de red creado, ya sea usando el formato de matriz o
lista de nodos, o lista de vinculos, en cualquiera de los casos se debera abrir el
software NetDraw (Borgatti, 2002), procedimiento que se puede realizar desde
UCINET (Borgatti et al., 2002), ya sea haciendo clic en el noveno icono, tltimo de
la barra de iconos (“Visualize network with NetDraw”) (Figura 28) o utilizando el
menU Visualize>NetDraw. Siguiendo cualquiera de los dos métodos, se abrira una
ventana como la mostrada en la Figura 29.

H UCINET & for Windows -- Version 6.617
File Data Transform Tools Network Visualize Options Help

03] m &\ D culo % 5
How ta cite LICINET:

Borgatti, 5.P., Everett, M.G. and Freeman, L.C. ZUUﬁd & for Windows: Software for Social Network Analysis.
Harvard, MA: Analytic Technologies.

& tutorial by Bob Hanneman & Mark Riddle is available here: hitp: //faculty.ucr.edu/~hanneman/nettext/.

See also this great book:
Borgatti, S.P., Everett, M.G. and Johnson, J.C. 2013, Analyzing Social Networks. Sage Publications.

This copy of UCINET is registered to Tral User
|Eutren¢ directory is C:\U sers\Norman AGA\Documents\JCINET data

Figura 28. icono para abrir NetDraw desde UCINET.
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NetOraw (<) 2002-2014 by Steve Borgats. All nights reserved. Rels  Nodes

Cite as: Helationa.
Bargatti, 5.P. 2002. Netdraw Network Visualization. Analytic Technologies: Harvard, MA
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Figura 29. Ventana principal de NetDraw.

ANALISIS DE REDES SOCIALES: CONCEPTOS CLAVE Y CALCULO DE INDICADORES




Una vez cargado NetDraw, ya es posible abrir el archivo que contiene los datos
dered. Paraello se presiona el tercer icono de la barra de iconos que hace referencia
auna “Carpeta abierta” (Open UCINET network dataset). Se recomienda usar este
icono en lugar del segundo porque éste Ultimo s6lo permite abrir archivos con
extension .##h, que como ya se menciond, es la extension manejada por UCINET.
Al presionar el icono recomendado, existen mas posibilidades para abrir diversos
tipos de archivos, entre ellos el formato de texto DL (Data Language) que se
ha venido trabajando. También se pueden utilizar los diferentes submends del
menu File, pero sin duda resulta mas sencillo utilizar los iconos disponibles. Por lo
anterior, de aqui en adelante solo se especificara el uso de los menus cuando sea
necesario, de lo contrario, s6lo se intentara hacer todo con el uso de iconos.

Una vez que se presiona el icono, se abrira una ventana similar a la de la
Figura 30, en la cual primero se debera seleccionar el archivo (Name of file to open:),
dependiendo de su ubicacion en el directorio elegido por el usuario; después, se
debe configurar el formato del archivo (File format:); en seguida, se selecciona el
tipo de datos ( Type of Data:); después, se configuraran algunas opciones (Options);
también, existe una opcion configurable para redes con vinculos ponderados ( Ties
have values...); por Gltimo, sblo se debera presionar el boton “OK”.

XN
M EEIETEIENRBRIEEIE Z [1se Pen se¥ MC|[Ego|“Node| ~Tie|| 28| 3#Km (A | 4[5 ¢ | sa|[L][-+].u[ e | Push| Pop
MetDraw (c) 2002-2014 by Steve Borgatti. Al rights reserved.
Cite as: gopen Data File = ] X
Borgatt, 5.P. 200|
Mame of file to open:
| | Ok |
File format: Type of Datac Dptions X Cancel
O Ucinet [~ #ith," #1td) (®) 1-Made Netwaork(s) Ignore reflewve ies
(O WNA [~.vna) (O Node Attibute(s) Ignore missing vales
®DL“d) Network with Attribules Ignote zeros
) Paiek Network [* net] ) 2-Mode Network

3z Ties have values .
() Payjek Partition [*.chu)

(O Pajek Vector [*.vec)
Figura 30. Ventana de NetDraw para abrir el archivo de red.

Como ejemplo, tomemos el archivo de texto creado en la Figura 11, sobre una
red de seis nodos, nueve vinculos dirigidos y con formato Nodelist1. A continuacion,
se explica la ventana de apertura de archivos en NetDraw (Figura 31):

e Enlaparte de “Name of file to open:” se especifica |la ubicacion y el nombre
del archivo que se abrira; esto se realiza usando el boton que contiene
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tres puntos (...). Al dar clic, se abre una ventana que permite visualizar
las carpetas y archivos. En este sentido, se debera seleccionar el archivo
deseado, segun la carpeta en donde esté guardado.

En la seccion de “File format:” se tienen varias posibilidades para
seleccionar, pero en nuestro caso sélo usaremos alguno de los siguientes.
El primero es el “Ucinet (*.##h, *.##d)”, este formato se seleccionara
cuando nuestros datos de red hayan sido guardados en formato de UCINET,
por ejemplo, cuando usamos el formato de matriz (ver secciéon 3.2).
El segundo es el “DL (*.dl)”, este formato se seleccionara cuando se vayan
abrir datos de red guardados en un archivo de texto con formato DL. Este
ultimo caso, precisamente, es el que seleccionamos en nuestro ejemplo
(Figura 31).

En la seccion “Type of Data:” existen cuatro opciones. La primera opcion
marcada como “1-Mode Network(s)” es la que siempre seleccionaremos
puesto que estamos hablando de redes modo-uno. La segunda
opcion (Node Attribute(s)) se utilizara cuando se carguen atributos
a la red. Las otras opciones son utilizadas para redes de atributos
(Network with Attributes) que estan en un mismo archivo, y para abrir
redes modo-dos (2-mode Network). Es por ello que en nuestro caso
se selecciona la primera opcion (Figura 31).

En la seccion “Options”, por default se encuentran activadas las tres
opciones, y es recomendable dejarlas con esa configuracion. Estas hacen
referencia a: i. Ignorar los vinculos que salen y entran del mismo nodo
(Ignore reflexive ties), es decir, no toma en cuenta los “auto-vinculos”.
Entonces esta opcion evita visualizar un vinculo del tipo Dante - Dante
0, Benito - Benito; ii. La sequnda opcion es para ignorar valores perdidos
para que no se muestren en la red (Ignore missing values), y iii. La Ultima
opcion (Ignore zeros) es para no tomar en cuenta los “0” como valores de
los vinculos entre actores. En nuestro ejemplo (Figura 31), se dejaron las
tres casillas activadas.

Por ultimo, en la seccién de “Ties have values...”, se configuran los limites
inferiores y superiores de los vinculos que se desea que se visualicen, por
lo tanto, es Util en redes con vinculos ponderados como el que se mostro
en la Figura 21. Sin embargo, se debe mencionar que esta opcion se activa
cuando se abren archivos en formato de UCINET, lamentablemente no se
activa cuando se intentan abrir en otro tipo de formatos, como lo es el DL.
Tal es el caso del ejemplo que se viene trabajando (Figura 31).

Al final, con todos los elementos configurados, sélo se presiona el boton
“OK”, y se mostrara un grafico de red como el de la Figura 32.
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Figura 31. Apertura de archivo de texto DL con formato Nodelistl con NetDraw.
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Figura 32. Grafico de red obtenido y visualizado con NetDraw.
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Con el grafico mostrado en la Figura 32 se pueden apreciar facilmente las
caracteristicas mencionadas al inicio de este apartado, y que debe cumplir un
buen grafico de red; en ocasiones no se pueden cubrir todas las caracteristicas,
pero NetDraw intentara siempre optimizar los algoritmos de visualizacion para
mostrar graficos adecuados.

Al obtener un grafico de red en NetDraw, regularmente el usuario se empieza
a cuestionar sobre otras funcionalidades proveidas por el software que pudieran
ser de utilidad. En este sentido, del lado derecho de la pantalla (ver Figura 32), se
tiene una ventana con dos pestafas, la primera hace referencia a las relaciones de la
red (pestana “Rels”), la sequnda es para trabajar con los nodos de la red (pestafna
“Nodes”). Al dar clic en cada una de ellas se puede visualizar cbmo el contenido
de cada pestafia cambia. En este momento no abundaremos en sus funciones
porque se describen en los siguientes apartados. Sin embargo, otros elementos de
gran utilidad tanto del manejo de los archivos como del grafico de red obtenido,
asi también formatos de visualizacion y hasta uso de atributos en los nodos y
en los vinculos, se pueden encontrar en la barra de iconos. Estos se describen a
continuacion de forma rapida y sencilla; el usuario podra facilmente ir asociando su
uso con lo que pasa en la red. Es asi como los iconos se pueden utilizar para:

e Los cuatro primeros iconos sirven para iniciar con una nueva ventana en
blanco (primer icono), y para abrir archivos de red (segundo y tercer
icono), asi como de atributos (cuarto icono).

e Los siguientes cuatro iconos sirven para redimensionar el tamafio del
grafico para que ocupe toda el area (quinto icono), abrir un panel de
visualizacion que permite rotar, mover y hacer zoom en el grafico (sexto
icono); los otros dos iconos sirven para acercar y alejar (zoom +y zoom -,
respectivamente) el grafico (séptimo y octavo icono).

e Los siguientes dos iconos, asi como el espacio que incluye una escala
numérica, sirven para el disefio del grafico de red. Es decir, a través de
estos dos iconos se pueden aplicar diferentes algoritmos de visualizacion
de la red. El segundo de ellos, el que esta representado por un icono
con un rayo (décimo icono), es el mas usado para visualizar redes
modo-uno. Ahora bien, el nimero que se especifica a su lado derecho
hace referencia a la distancia entre los componentes que forman la
red, mientras menor sea el nimero, menor sera la separacion entre los
componentes de una red, llegando incluso a que los componentes no
queden separados y, al contrario, los nodos queden superpuestos. Entre
mayor sea el nimero, mas distancia habra entre los componentes de la
red. Por supuesto, también esto afectara a los nodos que formen parte
de los componentes de |a red, haciéndolos mas dispersos para el primer
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caso, y mas compactos para el segundo caso. En la Figura 33 se presentan
cuatro visualizaciones de la misma red utilizando diferentes valores de la
distancia entre componentes; es facilmente observable como los nodos
estan mas dispersos y los componentes se traslapan con un valor de 1
(Figura 33a), y mientras mas se va aumentando éste valor, los nodos
se van compactando y los componentes se separan (Figura 33b-d).
El valor asignado por default es 5, esto permite obtener visualizaciones
adecuadas. Cuando el usuario no obtenga una representacion del grafico
de red adecuada, es recomendable que presione nuevamente el botén con
el rayo para cambiar la visualizacion y, si es necesario, hacerlo varias veces.
Como se menciono anteriormente, cualquiera de los graficos representara
lo mismo, aunque visualmente se perciba diferente; siempre sera (til
proveer un grafico estético y bien disefiado. También es importante
mencionar que la configuracion del valor de la distancia se puede hacer
desde el menu Layout>Graph theoretic layout, al dar clic en esa opcion
se abrira una ventana titulada como “Spring Embedding”, ahi sélo se
recomienda cambiar el valor respectivo a la casilla “Distance between
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Figura 33. Visualizaciones en NetDraw utilizando diferentes
valores de distancia entre los componentes.
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components:”. De forma practica se ha visto que los graficos obtenidos
respetan mas esa configuracion, que haciéndolo de manera directa en el
espacio que esta junto al icono con el rayo en la barra de iconos.

e Los siguientes siete iconos, desde el marcado como “se” hasta el marcado
como “~Tie”, sirven por ejemplo para borrar nodos aislados (icono 1 de los
7, Figura 34), el siguiente icono borra los nodos que solo tienen indicador
de grado =1, es decir, son los nodos que penden de la red. El icono marcado
como “MC”, sblo visualiza el componente principal de la red (Figura 35).
El icono “Ego”, abre una nueva ventana que permite configurar la
visualizacion de los “alters” de los “egos” seleccionados. Los ultimos iconos
ayudan a activar y desactivar tanto nodos como vinculos, respectivamente.
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Figura 34. Uso del icono para eliminar los nodos sueltos de una red.
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Fuente: Aguilar-Gallegos et al. (2016).

Figura 35. Uso del icono “MC” para seleccionar el componente principal de la red.
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» Los siguientes tres iconos sirven para formatear los nodos via el uso de
atributos. El primero es para asignar colores; el segundo para asignar figuras,
y el Ultimo cambia el titulo de la etiqueta del nodo dependiendo el atributo
que contenga el nodo. Este manejo de atributos se explica en la seccion 4.2.

 Los siguientes cinco iconos sirven para aumentar y reducir el tamano de
la etiqueta del nodo (iconos 1y 2 de los 5). Para aumentar y reducir el
tamano del nodo, (iconos 3y 4 de los 5). El Gltimo icono sirve para asignar
un tamafo general a todos los nodos; el tamafo por default es 8.

e Los siguientes tres iconos sirven para activar y desactivar las etiquetas
de los nodos (icono 1, Figura 36); mostrar o quitar las flechas de
los vinculos entre los actores (icono 2, Figura 37), y el Gltimo icono, para
mostrar o quitar el valor asignado al vinculo, puede ser Gtil para redes

ponderadas.
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Figura 36. Red con etiquetas y sin etiquetas en los nodos, uso del icono “Toggle labels on/off".
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Figura 37. Red con y sin flechas en los vinculos, uso del icono “Toggle arrow heads on/off".

54 Metodologias y herramientas para la investigacion, V 5



e El siguiente icono, marcado por un “punto rojo”, activa un modo de
edicion de la red, pero sélo para agregar nuevos nodos a la red, es decir,
con este boton se pueden agregar nodos que anteriormente no estaban
en la red. Estos nodos se etiquetan por un nimero consecutivo, el cual va
a depender del tamafo de la red original.

4

e Los ultimos iconos son “Push” y “Pop”. El primero, “Push”, sirve para
establecer y recordar el conjunto de nodos activos relacionados a Ia vista
actual; sin embargo, no se debe confundir o pensar que va a recordar la
visualizacion actual del grafico. Por tanto, si el usuario esta trabajando
en una red y desea visualizar unicamente el componente principal, sélo
por motivos visuales de la red, antes de hacerlo, debera oprimir el icono
“Push”, para que el programa recuerde el conjunto de nodos activos,
luego podra visualizar el componente principal, y para regresar a la vista
del conjunto de nodos original; posteriormente, con el segundo icono,
“Pop”, se reestablece dicho conjunto de nodos.

4.2. Uso de atributos de los nodos en la visualizacion de la red

Una vez que se ha obtenido el grafico de red, es muy comun que se quiera
insertar mas informacion a los nodos, para ello, como se ha mencionado, se
utilizan atributos (ver seccion 2.2 y 3.6). En NetDraw basicamente se pueden
utilizar tres caracteristicas diferentes de los nodos para insertar tal informacion.
Esto se realiza a través del uso de colores y formas, ademas de diferentes
tamanos del nodo.

Por ejemplo, en una red de intercambio de informacioén y conocimiento,
Aguilar-Gallegos et al. (2017) utilizaron tanto colores y formas para clasificar a
los actores en la red por los diferentes roles que juegan dentro de ella; en este
caso, el uso de un atributo codificado como una variable nominal resulté muy util.
Otro ejemplo del uso de variables ordinales usadas como atributos es proveido
por Hermans et al. (2017), donde mapean tres tipos de redes: de colaboracion, de
conocimiento y de influencia. Para su representacion grafica utilizan colores para
el tipo de rol de los actores y usan figuras para representar el nivel administrativo
o politico (a nivel de distrito, provincia, nacional, supranacional y no conocido) en
el cual desempena su rol dicho actor.

Por ultimo, y como ya se habia sefialado, también se pueden usar escalas
cuantitativas continuas como atributos; en este sentido, este tipo de variables
es comdn que se usen y sean representadas a través del tamafo del nodo;
por ejemplo, Aguilar-Gallegos et al. (2016) usaron un indice de adopcion de
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innovaciones (INAI) y lo insertaron en una red de intercambio de informacion y
conocimiento para la innovacion; de esta forma, a mayor tamafno del nodo, mayor
nivel de innovacion, y viceversa. Por supuesto, también se pueden insertar como
atributos, indicadores derivados del ARS; algunos autores han utilizado el grado
(medida de centralidad) como atributo (Aguilar-Gallegos et al., 2017; Spielman,
Davis, Negash, & Ayele, 2011), también se ha utilizado la radialidad y la integracion
(Aguilar-Gallegos et al., 2016), en estos casos al ser una variable cuantitativa
continua, el atributo se representa a través del tamano del nodo. Se pueden
combinar tanto colores, como figuras y tamafos de los nodos para representar
diferentes tipos de atributos de forma simultanea en un mismo grafico de red.
Sin embargo, algunos autores recomiendan, basados en su experiencia, no usar
mas de tres atributos al mismo tiempo, pues podria resultar mas distractor que
informativo (Borgatti et al., 2013).

4.2.1. Ahadir archivo de atributos a una red

A continuacion se explica como afadir atributos a una red. Para ello se utilizara
el ejemplo de seis nodos que se ha venido trabajando (con once vinculos) y que
se visualiz6 en la Figura 12. De la misma forma, se utilizara el archivo generado
en la Figura 26, que incluy6 cuatro atributos (género, localidad, superficie y
edad). Se explicara el uso de colores para el género; se utilizaran formas para
representar la superficie y; para la edad, se hara uso del tamano del nodo. Para
lograr ejemplificar cada caso, se debera primero abrir el archivo de atributos de la
red; se parte del hecho de que la red ya ha sido abierta en NetDraw y se visualiza
algo muy parecido a la Figura 12.

El procedimiento es muy similar al utilizado para abrir un archivo de red (con el
tercer icono en NetDraw) y que representa una carpeta abierta. De esta forma, para
abrir un archivo que contiene atributos de los actores que conforman la red (ver
Figura 26), se utilizara el cuarto icono, que hace referencia a una carpeta abierta,
pero con una letra A (Open UCINET attributes dataset). Al dar clic en ese icono, se
abrird una ventana muy similar a cuando se abre el archivo de la red (ver Figura 30).
Sin embargo, resalta inmediatamente que en las opciones de “Type of Data:” se
tiene seleccionada la opcion “Node attribute(s)” (Figura 38), las otras opciones
no deben de ser configuradas y solo se tiene que proceder a buscar y seleccionar
el archivo que contiene los atributos de los actores de la red; esto se realiza en la
opcion “Name of file to open:”. Después de seleccionar el archivo, se presiona el
boton “OK”, y con ello el archivo de atributos se habra cargado.
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Figura 38. Apertura del archivo de atributos en NetDraw.

Cuando el procedimiento se hace de forma correcta pareciera que nada ocurrio,
pues la pantalla sélo parpadea, sin embargo, en algunas ocasiones, aparece una
ventana indicando que los atributos se asociaron a los nodos. En cualquiera de
los casos es posible confirmar que el procedimiento se realizdé bien yendo a la
pestana “Nodes”, ubicada del lado derecho de NetDraw. Al dar clic, se mostrara
el listado de los nodos que conforman la red en orden alfabético (Figura 39a);
inmediatamente arriba del listado, existe un boton con una lista desplegable que
contiene los atributos cargados (Figura 39b), en automatico aparece “ID” pues
son las etiquetas de los nodos. Por tanto, si aparece el listado de atributos, indica
que el archivo fue cargado de forma satisfactoria.

En la lista desplegable, al seleccionar cualquiera de los atributos (en nuestro
ejemplo fueron edad, localidad, superficie y edad), la lista de nodos ahora cambia
por la lista de categorias contenidas en el atributo, por ejemplo, si selecciona
“Superficie (Ordinal)” se mostraran los nimeros 1, 2 y 3 (Figura 39c), que
precisamente hacen referencia a cada una de las localidades de los actores.
Cuando se selecciona un atributo que es una variable cuantitativa continua (e. g.,
la edad, el INAI, la centralidad de grado, etc.) las categorias son todos los valores
encontrados en la variable, por tanto, pueden ser varios (Figura 39d).
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Figura 39. Pestafia “Nodes” en NetDraw.

4.2.2. Atributos a través de colores
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Para cambiar el color de los nodos, segin un atributo deseado, y una vez que
se tiene abierta la red y cargado el archivo de atributos respectivo, se tiene que
utilizar el icono que hace referencia a una paleta de colores “Choose node colors
according to attribute values” (Figura 40) (icono nimero 18 de la barra de iconos,
enseguida del icono marcado como “~Tie”).

Metodologias y herramientas para la investigacion, V 5



Fle [dt Lsyout Anshmis Transform  Propesties Options  Help
NEEEDEIEHREREiE % loe Pen Sal MC Ego | “Hode “Tu [ BY| 78K A 4 5| 4| 5e [ L] 0]t o [Push | Pen

= iy Hade:
Choose node colors sccording to attrbute vakues =

| ibesio
— + Beritn
— & Colay

o Darte
+ Ekzabeth
e, o Fitma

\._.‘. Cshaee (L
Figura 40. icono para cambiar el color de los nodos segtn atributos.

Al presionar ese icono se abre una nueva ventana (Figura 41a), que justamente
sirve para ajustar el color del nodo segun un atributo deseado “Set symbol color
by attrib”. Al desplegar la lista de atributos se selecciona al que se desea cambiar
el color de los nodos (Figura 41a); en nuestro caso, seleccionamos “Género
(Binario)”. Cuando se selecciona el atributo, se observa como aparece un listado
con las diferentes caracteristicas codificadas, en nuestro caso se utilizd 1 =
hombre, 2 = mujer (Figura 41b). También se puede apreciar facilmente como el
programa asigna los colores de manera automatica, sin embargo, éstos se pueden
cambiar. Para ello se debe hacer doble clic sobre el color que se desea cambiar y
con ello se abrira una paleta de colores (Figura 41c), simplemente se selecciona
el nuevo color y se presiona el boton de “Aceptar”. En nuestro caso, cambiamos el
color rosa del atributo 1 = hombre a un color azul; de la misma forma, el color gris
del atributo 2 = mujer, ahora por un color rojo (Figura 41d). Al final del proceso,
so6lo se tiene que hacer clic en el botén con el simbolo v* “palomita”.

La Figura 42 muestra los cambios hechos en el grafico (ver Figura 40 antes de
la aplicacion del atributo), en donde ahora los actores que son mujeres tienen un
color rojo y los que son hombres ahora son azules. Visualmente en esta red es facil
observar quiénes son hombres y quiénes mujeres por las etiquetas de los nodos, pero
imagine una red mas grande y con una densidad de vinculos considerable, en donde
a veces hasta es Util quitar las etiquetas de los nodos para una mejor visualizacion; en
este tipo de casos, el uso de colores hace mas elocuente la lectura de la red.
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4.2.3. Atributos a través de formas

El uso de colores para destacar una caracteristica de los nodos de la red se puede
hacer mas elocuente con el uso de figuras, ya sea para afadir otro atributo a
la red o para resaltar ain mas el mismo atributo. En nuestro caso, utilizaremos
otro atributo. De esta manera, para cambiar la forma de la figura de los nodos,
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ahora se utilizara el icono que hace referencia a un conjunto de diferentes figuras
“Choose node shapes according to attribute values” (Figura 43) (icono nimero
19 de la barra de iconos, enseguida del icono utilizado para cambiar los colores
de los nodos).
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Figura 43. icono para cambiar la forma de las figuras de los nodos segun atributos.

Al presionar el icono comentado, al igual que en el procedimiento de cambio de
colores de los nodos, se abre una nueva ventana para ajustar el atributo, pero ahora
cambiando la forma de la figura de los nodos (Figura 44a) “Shapes of nodes”. Al
desplegar la lista de atributos disponibles en el archivo cargado, se selecciona uno
con el cual se desea cambiar las figuras de los nodos (Figura 44a); en nuestro caso,
seleccionamos “Superficie (Ordinal)”. Cuando se selecciona el atributo, se observa
como aparece un listado con las diferentes caracteristicas codificadas, en nuestro
ejemplo se utilizd 1: Menos de tres hectareas, 2: Entre 3 y 10 hectareas, 3: Mas
de 10 hectareas (Figura 44b). Es importante recalcar que la superficie se codifico
como una variable ordinal, y es por eso que se muestra de esa forma. En este caso
el programa también asigna figuras en automatico (1: Circulo, 2: Cuadrado, 3:
Triangulo hacia arriba), sin embargo, éstos se pueden cambiar, aunque las opciones
son mas limitadas en comparacion con los colores (ver Figura 41c). Para cambiar la
figura, en este caso se debe desplegar la lista disponible, y s6lo seleccionar la nueva
forma deseada en los casos que sea necesario (Figura 44c). En nuestro ejemplo,
cambiamos la figura del atributo 1 que corresponde a circulo, por la figura diamante
(rombo) (Figura 44d). Al finalizar los cambios (si es que son necesarios), solo se
tiene que hacer clic en el boton con el simbolo v “palomita”.
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La Figura 45 muestra los cambios hechos en el grafico (ver Figura 43 antes
de la aplicacion del atributo), para seguir con el ejemplo se conservo el color
de los nodos, pero ahora también se incluyen formas, donde los actores que se
representan por diamantes tienen menos de tres hectareas; los cuadrados tienen
entre 3 y 10 hectareas y; los triangulos hacia arriba poseen mas de 10 hectareas.
Tal y como se ha senalado, la combinacion de colores y figuras para representar
atributos de los nodos puede hacer a una red visualmente mas atractiva y ésta

puede proveer mas informacion. Sin embargo, siempre se debe tener cuidado con
la mezcla de ellos.
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Figura 44. Ajuste de las figuras de los nodos de una red segtin un atributo.
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Figura 45. Red con ajuste de figuras en los nodos, segun superficie (variable
ordinal) que cada uno posee. Diamantes: Menos de tres hectareas, Cuadrados:
Entre 3 y 10 hectareas, Triangulos hacia arriba: Mas de 10 hectareas.
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4.2.4. Atributos a través de tamano

Laaplicacion detamafosalos nodos, asociada a unatributo, vienea complementar
la asociacion de colores y figuras; esto sin duda contribuye a la interpretacion
cualitativa de la red y, por supuesto, hace mas atractiva la representacion grafica.
Para ejemplificar el uso del tamafo del nodo, utilizaremos el atributo de la edad,
en este caso es una variable cuantitativa continua, pero también se puede hacer
con otro tipo de variables, incluso con indicadores del ARS. En este caso, no existe
un icono especifico para ello y, por tanto, se utilizara la siguiente ruta en el menu:
Properties>Nodes>Symbols>Size>Attribute-based (Figura 46). Precisamente, lo
que se realizara sera cambiar las propiedades de los nodos a través del tamano de
las figuras y con base en un atributo.
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Figura 46. Ment para cambiar el tamano de los nodos segun atributos.

Al desplegar el menu indicado nuevamente se abre una ventana para
seleccionar el atributo y configurar las especificaciones del tamafio del nodo
(Figura 47a) “Set Size of Node Symbols by Attribute”. Es importante mencionar
que, a diferencia de los colores y figuras, aqui no aparece un listado de las categorias
posibles del atributo (ver Figura 41b o Figura 44b donde aparecialy2o01,2y 3,
respectivamente), en este caso se muestra un rango para la asignacion del
tamarfio de los nodos (Sizing), que va desde un tamafio minimo (Minimum size:)
a un maximo (Maximum size:). De manera automatica, el programa asigna 4 al
minimo y 24 al maximo; recordemos que el tamano normal de los nodos es 8.
Estos valores se pueden cambiar segun sea la variabilidad del atributo, aunque
también se debe considerar el tipo de variable del atributo. Por ejemplo, si se
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seleccionara el género como atributo, los nodos solo se representarian en dos
tamanos (los pequenos serian 1: hombres vy, los grandes serian 2: mujeres), lo
cual no enriqueceria la visualizacion de la red. Por lo anterior, el uso de tamanos
en los nodos es mas recomendable para atributos que sean variables cuantitativas
continuas. Al desplegar la lista de atributos, en nuestro caso, seleccionamos “Edad
(Continua)” y no cambiamos ningun tipo de configuracion extra (Figura 47b).
Para aplicar los cambios, es decir, cambiar el tamafo de los nodos, sélo se tiene
que presionar el boton “Apply” y después cerrar la ventana.

La Figura 48 muestra los cambios aplicados al grafico (ver Figura 46 antes
de la aplicacion del atributo). Para sequir con el ejemplo, se conservo el grafico
que contenia dos atributos via el uso de colores y figuras. En este sentido, ahora

Figura 47. Ajuste del tamafo de los nodos de una red segun un atributo.
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Figura 48. Red con ajuste de tamafos en los nodos, segtin la edad (variable
continua). A mayor tamafno del nodo, mayor edad del actor, y viceversa.
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es posible observar como a mayor edad del actor, mayor es el tamafio del nodo,
y viceversa. Debido a que el rango de tamafos fue de 4 a 24, y también a que
el atributo contenia varias categorias de edad, es que se visualizan diferentes
tamafos, lo cual enriquece la visualizacion de nuestro grafico de red.

Sin lugar a duda, la aplicacion de colores, figuras y tamafios enriquece la
visualizacion de graficos de red; sin embargo, es necesario recalcar que el uso
excesivo de atributos puede complicar la lectura cualitativa del grafico. Esta
situacion se puede complicar mas cuando en cada uno de los atributos existen
muchas categorias. Imagine lo dificil que podria ser leer un grafico con ocho
colores, seis formas diferentes, y con el uso de tamanos en los nodos. Por tanto, el
investigador o profesionista siempre debera decidir qué tipo de atributo aplicar y
a través de qué via (colores, formas o tamafios) quiere resaltarlo.

4.3. Filtrado de nodos con el uso de atributos

Durante una investigacion o analisis podria ser de interés observar cierto conjunto
de nodos, segun alguna caracteristica de interés. Para ello se pueden utilizar
los atributos cargados vy filtrar el o los conjuntos de nodos que cumplan con la
caracteristica deseada. Esto se puede realizar en NetDraw con el uso de la pestana
“Nodes” (ver Figura 39), pues al seleccionar el atributo de interés, se muestra el
listado de las categorias disponibles para ese atributo. De esta forma, activando
y desactivando las casillas respectivas a cada categoria, se activan (aparecen) y
desactivan (desaparecen) los nodos que tengan la caracteristica en cuestion.

Como ejemplo, tenemos una red formada por 167 actores (Figura 49a), de
los cuales 120 son agricultores (productores de hule). Los otros actores tienen
diferente rol dentro de la red (ver Aguilar-Gallegos et al., 2016 para mas detalle
sobre cada uno de ellos), en total son cuatro tipos de actores. Tomando como
base la caracteristica del tipo de actor, en la Figura 49b se representan los 120
agricultores en color negro y circulo; los otros 47 actores estan en color gris, pero
paradiferenciarentrelos tres tiposdeactores restantes se utilizaron figuras. Ahora,
supongamos que nos interesa observar solo la red formada por los agricultores,
es decir, los actores tipo 1. Para ello, utilizamos las casillas de activacion que se
encuentran en la pestafia “Nodes”, después de haber seleccionado el atributo
“Tipo”. En la Figura 49c se visualiza como al dejar s6lo activada la casilla marcada
como “1.000”, han desaparecido todos los nodos en color gris, y s6lo se observan
los nodos en color negro y en forma de circulo. Por Gltimo, presionando el icono
de redisefio del grafico marcado por un rayo (ver secciéon 4.1 y Figura 33), se
puede apreciar que el grafico toma otra visualizaciéon. Como resultado, muchos
agricultores quedan desconectados y, ademas, entre los conectados existen

ANALISIS DE REDES SOCIALES: CONCEPTOS CLAVE Y CALCULO DE INDICADORES



pocos vinculos (Figura 49d). Si fuera del interés investigar mas a fondo esta red
filtrada, NetDraw nos da la posibilidad de guardar s6lo esos datos de red. Para
ello, se utiliza el menu File>Save Data As>Ucinet>Binary Network; en este caso
se utilizé la opcion “Binary Network” porque es una red de relaciones binarias,
si la red fuera de intensidad en las relaciones, entonces se utilizaria la opcion
“Valued Network”.

Como se ha argumentado, la utilidad de utilizar atributos es mayor cuando
se tienen redes mas complejas, como es el caso de la Figura 49, pues se pueden
encontrar estructuras y composiciones de la red que de otra forma no podria ser
posible. De esta forma, aunque sigue siendo un analisis cualitativo, se tiene mas
informacion de la red.
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d. Red redibujada mostrando sélo

c. Red filtrada por el tipo de actor =1 (agricultores). los actores tipo agricultores

Figura 49. Filtrado de un conjunto de nodos con base en un atributo.

Metodologias y herramientas para la investigacion, V 5



4.4, Uso de atributos en los vinculos en la visualizacion de la red

4.4.1.

Asi como en los nodos, también en los vinculos que unen a éstos se pueden
utilizar atributos, en general, basados en niveles de intensidad que existe entre
los nodos y que forman parte de la sistematizacion de los datos de red (ver
seccion 3.4). Borgatti et al. (2013) mencionan diferentes propiedades que se
pueden editar en los vinculos, las cuales son: i. El grosor del vinculo; ii. El estilo
de la linea (s6lida, punteada, punto-linea, entre otros); iii. El color de la linea; iv.
El manejo y edicion de la punta de la flecha, sobre todo en redes dirigidas. Sin
embargo, asi como se recomendé cuidar el nimero de atributos asociados a los
nodos de una red, también se debe tener cuidado al momento de usar varios
atributos en los vinculos que lleven a una dificil interpretacion del grafico de red.
De esta forma, en esta seccion se explicara solamente la primera caracteristica
relacionada al grosor del vinculo y, de la misma forma, el filtrado de la red
derivado de la intensidad de los vinculos.

Fuerza de los vinculos

Dentro de la generacion de datos de red, es comun que se pregunte sobre
la intensidad del vinculo que el “ego” dijo tener; un ejemplo se ofreci6 en la
Figura 2, donde se preguntaba sobre la frecuencia de la relacion entre el “ego”
y sus “alters”. Esta frecuencia (o en su caso, intensidad) del vinculo se puede
representar via el grosor de la linea que une los nodos. Para ejemplificar el uso
del grosor de lineas en la red, tomemos el grafico mostrado en la Figura 21; que
s6lo como recordatorio, es una red formada por 12 nodos con 19 vinculos y fue
sistematizada via el formato Edgelist1 (ver Figura 20), en ella los vinculos estan
ponderados desde 1 hasta 5, donde 1 representa menor intensidad y 5 mayor
intensidad del vinculo.

Para aplicar el formato de grosor de linea, entonces, se usa la ruta del menu:
Properties>Lines>Size>Tie Strength (Figura 50). Lo cual indica, precisamente,
que se cambiaran las propiedades de las lineas, a través de su tamafo (grosor)
y, con base en la fuerza (intensidad, frecuencia, importancia, entre otros) de
los vinculos.

Al desplegar el menu indicado, se abrira una ventana para seleccionar el tipo
de relacion que se configurara a través del tamafio de la linea (Figura 51a) “Set
Width of Lines by Tie Strength”. Es importante mencionar que, cuando se habla
del tipo de relacion es porque en NetDraw es posible manipular y representar
diferentes tipos de vinculos (relaciones) entre los actores y, que por supuesto,
vienen de diferentes preguntas de red (ver seccion 2.1); sin embargo, en este
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Figura 50. Menu para cambiar el grosor de las lineas entre
los nodos, segun intensidad del vinculo.

ejemplo, s6lo estamos analizando un solo tipo de relacion. De esta forma, en
la opcion “Select relation:”, se selecciona la Unica posibilidad, que se refiere al
nombre del archivo de red cargado.

De la misma forma, en la ventana, se tiene que configurar el rango de grosor
de lalinea entre los nodos (Sizing), que va desde un tamafio minimo (Minimum
size:) a un maximo (Maximum size:). De manera automatica, el programa
asigna 1 al minimo y 7 al maximo (Figura 51a), en este caso el tamafo normal
de la linea es 1. Estos valores se pueden cambiar segun sea la variabilidad de la
intensidad del vinculo; es recomendable que se use el mismo rango de valores
entre la fuerza del vinculo y el tamafio del mismo, es decir, si la escala del vinculo
va de 1 a 5, entonces el tamano que vaya de 1 a 5; si la fuerza del vinculo va
de 1 a 7, entonces el tamano se puede configurar de 1 a 7, pero al final va a
depender del interés del investigador. También, es recomendable desactivar la
casilla indicada como “Change arrow head size to match”, porque cuando se
deja activada, la punta de la flecha cambia segun el grosor de la linea y es comun
que el grafico se distorsione, sobre todo cuando los tamafos de las lineas son
igual o mas grandes que 5.

Con las consideraciones hechas, la configuraciéon de nuestro ejemplo
quedaria como el mostrado en la Figura 51b. Es decir, el grosor de la linea ira
de 1 a5,y la punta de la flecha no cambiara, segun el tamafo de la linea. Para
aplicar esta configuracion, solo se tiene que presionar el boton “Apply”, y si
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la visualizacion es correcta, se procede a cerrar la ventana; de ser el caso, se
pueden volver a configurar las opciones y volver a presionar el boton “Apply”
para ver una nueva visualizacion.

La Figura 51 muestra el nuevo grafico con los cambios aplicados (ver Figura
50 antes de la aplicacion del atributo). En este sentido, ahora es posible observar
como a mayor grosor de la linea, mayor es la intensidad de la relacion entre los
actores, y viceversa. Como se puede apreciar, este tipo de atributos también
ayuda a enriquecer la visualizacion de un grafico de red. Sin embargo, un requisito
indispensable es que los datos de red estén codificados considerando niveles de
intensidad entre los vinculos, sila forma en la que se generaron los datos de red no
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Figura 51. Ajuste del tamafio de las lineas entre los nodos, segun la fuerza de los vinculos.
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Figura 52. Red con ajuste del grosor de las lineas, segun la fuerza de los vinculos. A
mayor grosor, mayor intensidad de la relacion entre los actores, y viceversa.
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Fuente: Aguilar-Gallegos et al. (2015).
Figura 53. Ejemplo de intensidad de los vinculos a través del uso de grupos de actores.

aplica para este tipo de visualizaciones, entonces no sera posible generarlas. Una
forma alternativa que podria ser utilizada para ver intensidad en los vinculos, seria
a través del analisis de la proporcion de vinculos que tienen diferentes grupos de
actores, unos con otros. Por ejemplo, Aguilar-Gallegos et al. (2015) analizaron la
proporcion de vinculos de tres grupos (Cluster 1 al 3) de productores de palma de
aceite, que tienen entre ellos y con otros tipos de actores. En su grafico, a mayor
grosor de la linea, mayor es la proporcion (del total de vinculos que tiene el grupo
de productores) que se destina a un conjunto de actores en especifico.

4.4.2. Filtrado de vinculos

Otro de los métodos Utiles para analizar visualmente la fuerza de los vinculos,
es utilizarlos como un filtro. De esta forma, se toman las conexiones entre los
nodos como criterio de filtracion y sélo se visualizan conectados aquellos nodos
que cumplan con el criterio. El criterio, precisamente, es el valor del vinculo;
por ejemplo, visualizar los vinculos que sean mayor o igual a 3. En este sentido,
continuando con el ejemplo, utilizaremos el operador “mayor o igual a (>=)",

N

aunque se pueden ocupar otros operadores como son “>”, “=", “<="y, “<”,
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En NetDraw, esto se manipula dentro de la pestafa “Rels”, del lado derecho
de la pantalla, y en el conjunto de opciones mostrado en la parte inferior (Figura
54); en automatico, la configuracion siempre sera “> 0”, que indica que se
mostraran las relaciones que sean mayor a 0, es decir, todas las de la red. Para
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Figura 54. Ventana para la filtracion de los vinculos, segun el criterio establecido.

a. Criterio de la fuerza del vinculo 1 0 mas

s e e -
F il eI 3 B mairlE BiEl 8 g1 P . B IR E¥ A

[ [

[ sl [
c. Criterio de la fuerza del vinculo 3 o mas d. Criterio de la fuerza del vinculo 4 o mas

Figura 55. Filtrado de la red, utilizando diferentes criterios de la fuerza de los vinculos.
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Figura 55 (continuacién). Filtrado de la red, utilizando
diferentes criterios de la fuerza de los vinculos.

ver los cambios, entonces primero se debera configurar como “>=1"; como
se puede apreciar en el grafico de la Figura 55a, se siguen mostrando los 19
vinculos, con el boton “+” iremos incrementando el criterio a 2, 3, 4y, 5. Los
cambios se iran reflejando de pasar de 19 vinculos, a 13 (con 2, Figura 55b),a 9
(con 3, Figura 55c¢), a 6 (con 4, Figura 55d), hasta llegar a 3 (con 5, Figura 55e).
Si se utilizara el criterio de 6 (Figura 55f), la red apareceria completamente
desconectada porque ningun vinculo cumpliria con ese criterio. De la misma
forma que se explicd anteriormente, las redes filtradas por la fuerza de los
vinculos pueden ser guardadas como archivos de datos diferentes. En cada caso,
dependera del interés del investigador o usuario.

4.5. Guardando la visualizacion de la red

Posterior al proceso de visualizacion y formateo del grafico de red, es muy comun
que el usuario quiera copiar o guardar dicha visualizacion. Como la mayoria de los
programas, en NetDraw se puede usar el portapapeles para copiar la visualizacion
y después pegarla en cualquier otro software, por ejemplo, Microsoft Word o
PowerPoint; para hacer esto, solo es necesario presionar Ctrl+C en NetDraw.
También se puede crear un archivo tipo grafico, en este sentido, es posible
guardar la visualizacion en formato jpeg (.jpg), mapa de bits (.bmp) y un meta
archivo (.emf). Esto se hace desde el menu File>Save Diagram As.

El uso de archivos jpeg es muy comin, ya que ocupa poco espacio (en
comparacion con los otros formatos) y porque la mayoria de los programas
informaticos los puede leer. Sin embargo, tiene la desventaja de la calidad de la
imagen, pues no es tan buena. En comparacion, el formato .emf guarda los datos
como si los elementos del grafico fueran vectores, lo cual hace que el archivo
sea de mejor calidad. De hecho, cada uno de los elementos se pueden editar
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posteriormente. Para comparar la calidad de los formatos, en la Figura 56 se
muestran los dos casos; como se puede ver, en la Figura 56b se movieron algunas
etiquetas de forma manual (la edicion se realizd en PowerPoint) para hacer mas
estético el grafico; en el caso del archivo en formato .jpg (Figura 56a), ningun
elemento se puede editar.

b. Archivo guardado en formato .emf.

Figura 56. Graficos de red salvados en formato .jpg y .emf.
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De forma adicional, en NetDraw se puede guardar la visualizacion en otro
formato que puede ser de interés y ayuda. Suponga que se esta trabajando en
una red, la cual ya le ha consumido tiempo de analisis y formateo visual, desde
cargar el archivo de red, insertar atributos, cambiar colores, formas y, diferentes
tamanos a los nodos, entre otros detalles. Para guardar el archivo tal y como se ha
trabajado, se utiliza el formato VNA (Visual Network Analysis), que encuentra en
el menu File>Save Data As>VNA. Este formato almacena tanto los datos de red
como el de atributos y, también, los formatos aplicados a la red. De esta forma,
guardar el archivo en este formato ayuda porque en la siguiente ocasion que se
cargue el archivo, para sequir trabajandolo, no serd necesario empezar desde
cero. El formato VNA también es Gtil y necesario para trabajar en el software
KeyPlayer 2 (Borgatti & Dreyfus, 2005), el cual sirve para la seleccion de actores
clave, de esto se hablara a mas detalle en la seccion 6.
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5. Analisis de la red: indicadores del ARS

Dentro del Analisis de Redes Sociales (ARS), se reconocen basicamente dos
tipos fundamentales de niveles de analisis: a nivel de redes completas y a nivel
de actores o nodos individuales. En ambos casos, la generacion de indicadores
representara uno u otro nivel. Sin embargo, de forma general, se debe considerar
que cuando se habla de “hacer un analisis de redes sociales”, se esta refiriendo
(implicitamente) al analisis de toda la red (Borgatti et al., 2013); esto debido
a que la red estara formada por un conjunto de nodos relacionados por un
“tipo de vinculo especifico”. Entonces, los indicadores referidos a los nodos que
componen la red (nivel individual) estaran siempre asociados a la red completa
(nivel completo) y viceversa; es decir, no podemos hablar sobre unos indicadores
(de la red completa o individuales) y tratar de explicar un tipo de relacion, y con
los otros indicadores (individuales o de la red completa) tratar de explicar otro
tipo de relacion.

Bajo este contexto, en este apartado se explicara el uso de indicadores a nivel de
la red completa y a nivel nodal. Sin embargo, es necesario hacer hincapié en que
los indicadores mostrados son sélo basicos en el ARS, por lo que existen otros mas.
Dependera del objetivo de la investigacion o motivo de uso, la eleccion de uno u
otro. Se podria decir, que en el ARS no existe un indicador ideal; en su caso, se debe
tener en cuenta el objetivo de lo que se desea explicar con el indicador y, con base
en ello, utilizar el que mas convenga. De forma complementaria, si se busca tener
mas informacion y conocimiento sobre los indicadores es recomendable consultar
las fuentes originales, mismas que se iran mencionando en cada apartado. Ademas,
existen otros articulos (Aguilar-Gallegos et al., 2016, 2017; Monge, Hartwich,
& Halgin, 2008; Monge Pérez & Hartwich, 2008; Spielman et al., 2011; Valente,
Palinkas, Czaja, Chu, & Brown, 2015) que han descrito, tanto de forma detallada
como resumida, algunos indicadores del ARS que han utilizado, mismos que pueden
ser de interés del lector que requiera profundizar.

En este apartado se ilustraran los indicadores explicados con la ayuda de un
ejemplo de red pequefa. Los datos se obtuvieron de una red mas grande (ver
Aguilar-Gallegos et al., 2017 para mas detalle), aplicada a productores caprinos
en un momento inicial (antes de una intervenciéon basada en asistencia técnica
y capacitacién en innovaciones clave, llamada linea base). A cada uno de los
caprinocultores se les preguntd “;De quién ha aprendido, se ha asesorado o ha
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preguntado, es decir, a quién recurre para obtener informacién y conocimiento
para implementar las prdcticas, tecnologias e innovaciones que realiza en su unidad
de produccién?”. Los datos recabados, por tanto, refieren a vinculos binarios y
dirigidos. De esta forma, los resultados obtenidos para los indicadores del ARS, se
mostraran como salidas originales del software UCINET (Borgatti et al., 2013).
La red pequefa que se aisl6 consta de 11 nodos con 16 vinculos, los actores que
los conforman son so6lo productores caprinos, para evitar confusiones con otro
tipo de actores, como es el caso de la red mas grande. El extracto de los datos,
siguiendo lal6gica explicada, de la captura en formato Nodelist 1 (ver seccion 3.3),
se presenta en la Figura 57; con estos datos, el usuario podra generar el archivo de
red y con ello tendra la oportunidad de seguir los ejemplos que se desarrollaran
en las siguientes secciones. De la misma manera, una visualizacion general de la
red pequefa se puede apreciar en la Figura 58, todos los nodos estan etiquetados
como ER porque hacen referencia a “Empresas rurales”, el nGmero que le sigue es
para efectos de identificacion.

| RedCaprinosM11_Modelist1: Bloc de notas — O X

Archive Edicidn Formato Ver Ayuda
dl n=11

format=nodelistl

labels embedded

data:

ERG82

ERBB3 ERBB2

ERG&S ER©18

ERB18

ERB12 ERBB2 ERB13

ER@13 ER@B2 ER@12
ER@14 ERe1R ER@25
ERB17 ERBB2 ERG8s5 ERB18 ER@18 ER®24
ERGL18 ERB85 ER@12
ER@24 ER@18

ERB25

Figura 57. Datos de la red extraida de Aguilar-Gallegos et al. (2017),
siguiendo el formato Nodelist1 y en archivo de texto.
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Figura 58. Extracto de la red de informacion y conocimiento para la innovacion
entre productores caprinos, extraido de Aguilar-Gallegos et al. (2017).

Por ultimo, es conveniente mencionar que para que UCINET pueda analizar
los archivos en todos los procedimientos que se explicaran, éstos deben estar en
formato de UCINET, es decir, deben tener extension .##h. Silos archivos estan en
formato de texto DL (Data Language), éstos deberan ser primero transformados
al formato adecuado, ya sea usando NetDraw (File>Save Data As>Ucinet>Binary
Network) o el mismo UCINET (Data>Import text file>DL).

5.1. Indicadores a nivel de redes completas

Debido a que una red social esta definida por los vinculos que forman los actores
que la componen, es que se considera importante iniciar describiendo toda la
red en su conjunto. Para ello se explicaran dos de los indicadores mas comunes
en el ARS que ayudan a caracterizar a toda la red; estos son la densidad y la
centralizacion. Por supuesto, existen otros indicadores a nivel de red pero
algunos de ellos son la base de otros; por ejemplo, el tamano de la red, asi como
el nimero de vinculos existentes podrian ser indicadores de la red completa (ver
Aguilar-Gallegos et al., 2017 sobre una aplicaciéon empirica de los indicadores)
pero éstos se utilizan para el calculo de la densidad. Otros indicadores generales
podrian ser el nimero de componentes o el tamafio del componente mas
grande, pero estos a su vez podrian ser considerados como elementos basicos
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para la descripcion de una red. Es por lo que s6lo nos enfocaremos en los dos
indicadores mencionados.

5.1.1. Densidad

La densidad es considerada como una medida de cohesion entre los actores de la
red (Borgatti et al., 2013). La densidad, basicamente, es una medida del nimero
de vinculos existentes en la red, presentados como una proporcion del nimero de
vinculos posibles. En este sentido, el nimero de vinculos posibles dependera del tipo
de red, diferenciando entre redes no dirigidas y dirigidas. Para redes no dirigidas,
el nimero de vinculos posibles se obtiene a través de n (n — 1) / 2, donde n es el
numero de nodos que forman la red. Mientas que, para redes dirigidas, el nimero de
vinculos posibles se obtiene usando n (n — 1); en ninguno de los dos casos se toman
en cuenta las auto-nominaciones.

Si la densidad significa cohesién en una red, entonces a mayor densidad,
mayor sera la cohesion y, por tanto, mayor nimero de vinculos entre los actores
que forman la red (de Nooy et al., 2005). De la misma forma, la densidad nos
puede proporcionar cierto nivel de conocimiento de la forma en la que se podria
comportaralgiinfenémeno (Hanneman & Riddle, 2011), por ejemplo, la velocidad
de difusion de informacion entre los nodos se dara con mayor rapidez en redes
densas; o también, considere el hecho del grado de acceso a capital social que
tiene un actor en redes poco densas, que podria significar una limitante de la
estructura social, entre otros.

Por otra parte, el valor de densidad alcanza un maximo en redes donde todos
los nodos estan conectados unos con otros. Sin embargo, en redes grandes la
densidad tiene valores cominmente bajos, debido a que la cantidad de vinculos
posibles es proporcional al tamafio de la red; es decir, a mayor tamafo de la red
(mayor nimero de nodos), mayor nimero de vinculos posibles. Por ejemplo,
suponga tres redes dirigidas con diferentes tamafos, n, = 10, n,= 50y, n, = 100,
en cada una de ellas el nimero de vinculos posibles, respectivamente, sera de:
90, 2,450y, 9,900; mientras el numero de vinculos posibles es proporcional al
tamano de la red, la probabilidad que tiene un individuo de formar vinculos con
otros no lo es; ademas, se debe recordar que la capacidad que tiene un individuo
de mantener y formar nuevos vinculos es limitada. Es decir, el tamafo de la red
es critico para la estructura de relaciones sociales, debido a que los recursos y
capacidades que tiene cada actor para formar y mantener vinculos es limitada
(Hanneman & Riddle, 2011). Por ello, es recomendable manejar este indicador
con cuidado y sin llegar a conclusiones generalistas.
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Siguiendo con el ejemplo de las tres redes antes apuntadas, suponga que en
cada caso existe una densidad de 10%. En general, no se podria decir si la densidad
es baja o alta, pero quizas si lo vemos en el contexto de que en la red 1 hay 10
nodos, entonces puede ser extremadamente pequefa, mas aun si los 10 nodos
forman parte de un equipo de trabajo, y porque existe una mayor probabilidad de
que entre ellos se conozcan; mientras que en la red 3 de 100 nodos, puede ser que
la densidad de 10% sea buena o alta, sobre todo porque existe menor probabilidad
de que entre todos se conozcan; ademas, imagine que los 100 nodos forman
parte de diferentes departamentos en una misma empresa (o de distintos municipios
en un territorio), lo cual indicaria que hay cierto nivel de comunicacion entre ellos.
Por tanto, la densidad debe ser interpretada a la luz de diferentes condiciones y
caracteristicas de la red y, por supuesto, de los datos que esta red representa.

Considerando lo anterior, es importante mencionar que en algunas ocasiones
se prefiere usar como indicador global de la red al grado (seccion 5.2.1)
promedio de cada actor, en lugar de la densidad; el grado promedio es mas facil
de interpretar puesto que es la media aritmética de los grados individuales de
cada actor que forma la red (Borgatti et al., 2013). Este detalle de eleccion,
sin embargo, dependera del objetivo del analisis y de la utilidad que uno u otro
indicador represente para el investigador.

Para el calculo de la densidad en UCINET se utiliza la ruta: Network>Cohesion
>Density>Density Overall (Figura 59). Posteriormente se abrira una ventana en
la cual s6lo se tiene que seleccionar el archivo a analizar en la opcion “Network

T8l UCINET 6 for Windows - Version 6617 - X
File Dats Tronsform Tooks | Network | Visualize Options Help

1] xlm E|\|D Cohesion » Multiple cohesion measures

How to cits UCINET Regions > Density > Density Overall

Bogati. S P., Everett. M.G. and Fit Subgroups E-lIndex Density by Groups
Harvard, MA” Anshtx: Techrobogie: Transitivity

£go Networks > Old Density procedure

_ _Transitivity (old)
See skso this real book: s e | Chusteriog Coecient

Group Centralit >
Borgati, § P, Eversit MG. and Jo E B Reciprocity
>

Core/Periphery R
This copy of UCINET irreguteed . oles & Positions 3 Krackhardt GTD

Cunert drectory is C:\U sers\Narman Triad Census Simmelian / Embedded ties
& Geodesic Distances

Balance counter Geodesic Distance (old)

e . Alters in Commen
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2-Mode networks > No. of Geodesics
Trajectories Geodesic Cube
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Multiple Measures. > Line Connectivity/Maximum Flow ..

Point Connectivity

Figura 59. Menu para el calculo de la densidad en UCINET.
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Dataset:”; éste debera estar en formato de UCINET, tal y como se mencion6 al
inicio de este apartado. Al seleccionar el archivo de la red ejemplo (tamafio 11 con
16 vinculos dirigidos), presentada en la Figura 58, y presionar el boton “OK”, se
obtiene una salida como la mostrada en la Figura 60. Los resultados muestran que
la densidad de la red es 0.1455, que expresada en porcentaje seria 14.55%; es decir,
los 16 vinculos observados, representan 14.55% de los vinculos posibles de toda la
red (tamafio n=11). Si se realiza el calculo manualmente, seria 16 / (11*(11-1)) =
16 /110 = 0.1455. En esa misma salida, también se puede apreciar el indicador del
grado promedio de la red, cuya importancia se ha comentado anteriormente, para
este caso fue de 1.4545; es decir, cada uno de los 11 actores que componen la red
tienen 1.5 vinculos en promedio.

DENSITY / AVERAGE MATRIX VALUE

1 2 3 4 5
Density No. of Std Dev Avg Deg Alpha
Ties ree
1 RedCaprinosNil ©.1455 16 ©.3526 1.4545 ©9.6519

1 rows, 5 columns, 1 levels.

Figura 60. Resultado de la densidad de la red de 11 nodos y 16 vinculos.

5.1.2. Centralizacion

Para el estudio de redes completas dentro del ARS, un indicador que mide la
diferencia entre los niveles de centralidad de los actores y que nos proporciona
una idea de que existen nodos dominantes, es el nivel de centralizacion de la red
(Freeman, 1979). Siendo que la centralizaciéon mide el grado en el cual un actor
es dominante en la red, se pueden obtener diferentes medidas de centralizacion
basadas en los tres indicadores de centralidad de los nodos (Freeman, 1979); sin
embargo, para efectos del presente documento se hara énfasis solamente sobre
la centralizacion de la red basada en la centralidad de grado. De esta forma, la
centralizacion de una red puede ser entendida como el grado en el cual una red
esta dominada por un solo nodo (Borgatti et al., 2013). Para saber en qué grado
una red esta centralizada, se compara la red observada con una red que tenga
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la maxima centralizacion posible; en este sentido, y desde la perspectiva de la
centralidad de grado, una red estrella es la representacion grafica del indice de
centralizacion maximo (100%, Figura 61a), pues todos los vinculos se centran
en un solo nodo y no existen vinculos entre los demas actores (Borgatti et al.,
2013; Freeman, 1979). Por supuesto, una red en donde todos los actores estan
vinculados entre si, es decir, una red con densidad de 100% tendra un indice de
centralizacion de cero (Figura 61b), pues ningun actor es dominante.

a. Red estrella, Centralizacion 100%. b. Red densidad 100%, Centralizacion 0%.

Figura 61. indice de centralizacion de la red.

Es importante enfatizar que los ejemplos de la figura anterior estan basados en
vinculos no dirigidos; sin embargo, es posible obtener indices de centralizacion
relacionados con la centralidad tanto de grado de entrada como de grado de salida.
En este sentido, se obtendran indices de centralizacion de entrada y de salida,
respectivamente. Esto es importante, porque imagine una red de informacion,
donde un nodo con alto grado de entrada signifique que es una fuente importante
de informacion; por otra parte, un nodo con alto grado de salida signifique que es
un actor que consigue informacién con diferentes actores. Entonces, un alto indice
de centralizacion de la red basada en grados de entrada indicaria que hay uno o
varios nodos que son importantes como fuente de informacion; sila centralizacion
es baja, entonces quiere decir que no hay actores importantes que cumplan este
rol. Por su parte, un alto indice de centralizacion de la red basada en grados de
salida indicaria que hay uno o varios nodos que estan buscando y consiguiendo
informacion de varias fuentes; por el contrario, si el indice de centralizacion
es bajo, indicaria que los actores de la red tienen pocos actores como fuente
de informacion. Esto por supuesto, se puede trasladar a otros contextos. Por
ultimo, y considerando la explicacion dada, estos indicadores de centralizacion de
entrada y salida pueden verse como una medida de la desigualdad y varianza que
tienen los actores en la red (Hanneman & Riddle, 2011), pues si la red observada
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tiene varios componentes en forma de estrella (de entrada o salida), el indice de
centralizacion entonces se incrementara y, por tanto, la varianza de la centralidad
de grado también lo hara.

Para el calculo de la centralizacion de la red en UCINET, se utiliza la ruta:
Network>Centrality and Power>Degree (Figura 62), ndtese que se ocupa la primera
opcidn “Degree”, no la sequnda marcada como “_Degree (old)”. Posteriormente, se
abrira una ventana en la cual sélo se tiene que seleccionar el archivo a analizar en la
opcion “Input Network:”. Existen otras opciones configurables, como son: si la red
es dirigida, no dirigida, o que se autodetecte; también, las salidas de los indicadores, si
se toman en cuenta las automenciones, entre otras. En este punto, se sugiere dejar
la configuracion automatica. Después de seleccionar el archivo de nuestro ejemplo
y al presionar el botdn “OK”, se obtiene una salida de resultados sobre el grado de
salida y entrada de nuestra red, en este momento no nos detendremos a ver estos
resultados porque se explican mas adelante (seccion 5.2.1), casi al final de la ventana
aparecen los indicadores buscados, similares a los de la Figura 63.

Losindicadores obtenidos muestran que lared de nuestro ejemplo (ver Figura 58),
estd mas centralizada en grados de salida (0.39 = 39.0%), que de entrada
(0.28 = 28.0%). Es decir, en la red existe uno o mas nodos que son dominantes en
el establecimiento de vinculos de salida, el cual es el ERO17. De la misma forma,
se podria decir que existen cierto nivel de centralizacion de entrada, es decir, hay
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Figura 62. Menl para el calculo de la centralizacion de la red en UCINET.
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Figura 63. Resultado del indice de centralizacion (de salida y
entrada) de la red de 11 nodos y 16 vinculos.

nodos importantes por su grado de entrada, en la red estos se pueden visualizar
como ER002, ER018 y ER010. Por ultimo, como se ha observado, el indicador de
centralizacion se muestra como una proporcion y no como porcentaje (marcado en
la salida de resultados, Figura 63), entonces el usuario debera tener cuidado para
multiplicarlo por 100, y asi representarlo en porcentaje. La forma de presentar los
resultados es la principal diferencia entre la opcion “Degree”y “_Degree (old)”; si se
escoge la segunda opcion, los indicadores se muestran en porcentaje.

En UCINET se puede utilizar otro ment para la obtencion de los tres indicadores
vistos (densidad, grado promedio y centralizacion); de hecho, se obtendrian
juntos en el mismo procedimiento. Adicionalmente, se obtienen otros indicadores,
varios de éstos son considerados indicadores de cohesion de la red. Sin embargo,
algunos no se abordaron a detalle y otros no se mencionaron, debido a que los
indicadores explicados son basicos, y parte del objetivo del documento es ése
precisamente. De esta forma, es posible que algunos usuarios se vean interesados
en los otros indicadores; por lo tanto, la ruta que se utiliza para el analisis es:
Network>Cohesion>Multiple cohesion measures. Para una comprension de algunos
de los indicadores obtenidos por este Gltimo procedimiento se recomienda
profundizar en literatura clasica del ARS (Hanneman & Riddle, 2011; Wasserman
& Faust, 1994).

5.2. Indicadores a nivel nodal

Asi como se describio el apartado anterior, ahora en éste se hace referencia a
algunos de los indicadores tradicionalmente utilizados en el ARS, que son los
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mas comunes y que, de acuerdo a algunos autores (Aguilar-Gallegos et al.,
2016), se podrian considerar de primer orden (centralidad de grado, cercania
e intermediacion). Después se explican los indicadores que toman en cuenta
los vinculos indirectos (eigenvector, centralidad Beta de Bonacich, integracion
y radialidad), por lo que son considerados de segundo orden. En este contexto,
un indicador de primer orden es aquél que vincula directamente a dos nodos vy,
por tanto, lo hace a través de un solo paso; por su parte, un indicador de segundo
orden es aquél que logra vincular a dos nodos a través de dos o mas pasos. Para
ejemplificar el tipo de indicadores, se usara la red mostrada en la Figura 58; sin
embargo, sélo en los casos de la centralidad de cercania y del eigenvector, se usara
un ejemplo diferente sobre una red hipotética simétrica, mostrado en la Figura
21; no obstante, los datos se tuvieron que dicotomizar (1 para cualquier valor en
el vinculo, 0 cuando no existe vinculo), pues la red mostraba datos ponderados.
Esto se realizd en UCINET, siguiendo la ruta: Transform>Dichotomize.

Centralidad de Grado

Esta eslamedida mas simple del ARS, cominmente llamada “grado”. La centralidad
de grado de un actor es el nUmero de otros actores a los cuales éste esta
conectado; es decir, es adyacente. Se dice que dos nodos son adyacentes cuando
estan directamente conectados por un vinculo (Freeman, 1979), es por ello que
se considera un indicador de primer orden. En redes no dirigidas, los actores de
la red difieren sélo por el nimero de vinculos que tiene; sin embargo, en redes
dirigidas es importante distinguir entre la centralidad del grado de entrada y del
grado de salida (Hanneman & Riddle, 2011). En este sentido, el grado de entrada
se refiere al nimero de vinculos que recibe un actor provenientes de otros actores.
Por su parte, el grado de salida es el nUmero de vinculos que manda o envia un
actor hacia otros actores (de Nooy et al., 2005; Jackson, 2008). De alguna forma,
la centralidad de grado puede ser vista como un indice de la exposicion que tiene
un nodo dentro de la red (Borgatti et al., 2013), es decir, un actor con un grado
alto puede tener mayor probabilidad de ser alcanzado en la red.

Parael calculo dela centralidad de grado de cada uno de los nodos que componen
la red, en UCINET, se utiliza la ruta: Network>Centrality and Power>_Degree (old)
(Figura 64), notese que ahora estamos ocupando la segunda opcion “_Degree
(old)”, no la primera marcada como “Degree”. Esto se debe a que la segunda opcion
incluye un cuadro de estadisticos descriptivos de los indicadores obtenidos. Otra
diferencia es que la segunda opcién ordena los nodos por su importancia segun
el grado de salida, de mayor a menor. La opcion “Degree”, ordena los resultados
alfabéticamente y, por su parte, la opcion “_Degree (old)” muestra los indicadores
normalizados en escala de 0 a 1, mientras que la segunda opcion los presenta en
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porcentaje (de 0 a 100). Posteriormente, se abrira una ventana en la cual sélo se
tiene que seleccionar el archivo a analizar en la opcion “Input dataset:”. La opcion
de tratar los datos como simétricos (pues se trata de una red dirigida) e incluir
la diagonal en el analisis (por lo regular no se incluyen autonominaciones en las
redes), se dejan configuradas en “No”. Después de seleccionar el archivo de nuestro
ejemplo y al presionar el boton “OK”, se obtiene una salida de resultados con los

indicadores deseados, similares a los de la Figura 65.
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Como se puede apreciar (Figura 65), el primer conjunto de resultados esta
basado en cuatro columnas, en el siguiente orden: grado de salida (Out Degree),
grado de entrada (In Degree), grado de salida normalizado (Nrm Out Degree)
y, grado de entrada normalizado (Nrm Out Degree). Como se menciond, el orden
de los nodos esta hecho considerando el grado de salida, de mayor a menor. En
este sentido, el nodo ER017 es el de mayor grado de salida (refiri6 a otros cinco
actores como sus fuentes de informacion), existen tres nodos que no tienen grado
de salida. Por su parte, el actor mas referido por los otros actores y que, por tanto,
es importante para la red es el ERO02 con 4 grados de entrada. Las siguientes dos
columnas, que son los indicadores normalizados, son basicamente densidades
individuales, es decir, es la proporcion (expresada en porcentaje) de vinculos que
cada actor tiene con respecto a las posibles. En este sentido, sila red es de 11 nodos,
entonces cada uno de los actores podria vincularse a cada uno de los otros 10.
Entonces, si los grados de salida de ER017 son 5 de 10 posibles, por lo tanto, su
grado de salida normalizado es de 50%, y asi para todos los actores, y lo mismo que
para el grado de entrada.

Junto con los resultados anteriores, también se obtiene un conjunto de
estadisticos descriptivos sobre los indicadores que pueden ser de utilidad para la
interpretacion de los resultados. En la Figura 66 se muestran dichos datos. Notese
coémo el estadistico promedio tanto del grado de entrada como de salida es igual

DESCRIPTIVE STATISTICS

1 2 3 4

OutDegree InDegree NrmQutDeg NrmInDeg

1 Mean 1.4545 1.4545 14.5455 14,5455
2 Std Dev 1.3727 1.3848 13.727@ 13.8479
3 sSum 16.06000 16.00800 1668.00800 160.0800
4 Variance 1.8843 1.7825 188.4297 170.2479
5 SSQ 44 . 0000 42 .0000 4400 .0000 4200 .0000
6 MCSSQ 20.7273 18.7273 2072.7273 1872.7273
7 Euc Norm 6.6332 6.4887 66.3325 64.8074
g Minimum 2.0000 2.e000 2.e000 0.0000
9 Maximum 5.e6ee 4.0000 Se.oeee 40.0000
18 N of Obs 11.000e 11.0000 11.0000 11.00060

Network Centralization (Outdegree) = 39.000%
Network Centralization (Indegree) = 28.800%

Actor-by-centrality matrix saved as dataset RedCaprinosNll-deg

Figura 66. Estadisticos descriptivos de los resultados de la
centralidad de grado (de salida y entrada).
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al obtenido durante el calcul6 de la densidad (ver seccion 5.1.1, Figura 60). Junto
con ello se puede ver el tamafo de la red (linea “N of obs”), el nUmero de vinculos
existentes (linea “Sum”), entre otros estadisticos como es el valor minimo,
maximo, promedio, y desviacion estandar. Al final, también se proporciona la
centralizacion de la red; como nuestro ejemplo es de una red dirigida, entonces
se muestra la centralizacion de salida y la de entrada, que coincide con los valores
mostrados anteriormente (ver seccion 5.1.2, Figura 63).

Centralidad de Cercania

La cercania puede ser vista como la independencia que tiene un nodo con
respecto a todos los demas nodos en la red (Freeman, 1979). Es decir, si un “nodo
A” necesita de varios nodos para alcanzar a otros mas, entonces es distante; en
comparacion, si un “nodo B” esta en contacto con otros y necesita de pocos
nodos para alcanzar a otros mas, entonces es cercano. En este ejemplo, el “nodo
B” es mas independiente que el “nodo A”, pues este Ultimo depende de otros;
entonces, el “nodo B” tiene una mayor centralidad de cercania. En este sentido,
la forma de calcular la cercania es a través de la suma de las distancias geodésicas
de un nodo hacia todos los otros (Freeman, 1979). Sin embargo, mientras mas
grande sea la suma obtenida de las distancias de un nodo, mas lejano estara éste
de los demas nodos, y viceversa; por tanto, la centralidad de cercania se obtiene
mediante el inverso de la suma calculada. La version normalizada de la cercania
se obtiene primero dividiendo la suma de las distancias geodésicas, entre n — 1,
el cual es el valor minimo posible de lejania de un actor a todos los demas y, de
hecho, este valor se puede alcanzar cuando el actor esta conectado a todos los
demas actores (n — 1). Una vez obtenida la division, se obtiene el inverso y asi, la
cercania de un actor alcanza un maximo de 100 cuando esta conectado a todos
los demas actores.

En un contexto de interpretar una red conectada y lo que fluye dentro de
ella, cominmente la centralidad de cercania se interpreta en términos del tiempo
minimo que tomaria a un nodo alcanzar el recurso que esta fluyendo en la red.
Entonces, un nodo con valor de cercania alto, tardaria menos tiempo porque esta
mas cercano a la red y; al contrario, para un nodo que depende de otros nodos
y, que por tanto, esta lejano del recurso, tomara mas tiempo para alcanzarlo
(Borgatti et al., 2013). Mientras mas cercano esté un nodo a la red, mas facil éste
puede alcanzar informacion u otro recurso y, ademas, su centralidad es mayor (de
Nooy et al., 2005).

Uno de los detalles mas problematicos de la cercania es que, a pesar de ser
atil y facil de interpretar en redes conectadas, no lo es para redes no conectadas.
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Fundamentalmente, porque no se puede calcular una distancia geodésica entre
nodos no conectados, lo cual podria tender al infinito (Freeman, 1979). Existen
varias formas de tratar esta situacion, por ejemplo, asignando un valor de distancia
maximo, tomar una distancia reciproca o asignando el valor de cero, pero no es facil
de justificar la eleccion de uno u otro; por esta razon, a veces no es un indicador muy
usado como medida de centralidad (Borgatti et al., 2013). Aunado a lo anterior,
es que esta situacion se acentla en redes dirigidas, puesto que se deberia calcular
una cercania de entrada y de salida; entonces, para que el indicador se obtenga de
forma “adecuada”, todos los nodos deberian tener al menos un grado de entrada y
uno de salida para que las distancias geodésicas entre todos los nodos puedan ser
obtenidas, situacion que en la realidad no es comun.

Como se indicod anteriormente, para ejemplificar el calculo de la centralidad
de cercania se utilizara una red hipotética (ver Figura 21) con datos no dirigidos
y dicotomizada. De esta forma, para obtener el indicador por cada uno de los
nodos que componen la red, en UCINET, se utiliza la ruta: Network>Centrality
and Power>Closeness (old) (Figura 67). De la misma forma que en el indicador
de Grado, ndtese que existen dos opciones “Closeness measures” y “Closeness
(old)”; sin embargo, se recomienda la segunda debido a que ésta incluye en los
resultados la suma de los caminos geodésicos de cada uno de los nodos a todos
los demas de la red. Posteriormente, se abrira una ventana en la cual sélo se tiene
que seleccionar el archivo a analizar en la opcidén “Input dataset:”. La siguiente
opcion marcada como “Type:”, por default tiene seleccionada “Sum of geodesic
distances (Freeman)” y asi se debe dejar, es decir, no es necesario cambiar nada.
Por Gltimo, existen tres opciones para los valores de distancias que no pueden ser
calculadas “Value to assign undefined distances:”, precisamente porque no existe
ningln camino que una a los pares de nodos; en esta opcion, lo recomendable es
seleccionar la opcion “N (number of nodes)”. Después de estos procedimientos y
al presionar el boton “OK”, se obtiene una salida de resultados con los indicadores
de lejania y cercania normalizada, similares a los de la Figura 68.

Los resultados obtenidos (Figura 68) muestran primero una columna con
el indicador de lejania (Farness), que es la suma de los caminos geodésicos que
cada uno de los nodos tiene hacia los demas. En seguida se muestra la columna
de la centralidad de cercania normalizada (nCloseness). El mismo archivo de
resultados, incluye un conjunto de datos con estadisticos descriptivos, muy
similar al mostrado en la centralidad de grado. Como se explico, este indicador
de centralidad es inverso, es decir, a menor lejania, mayor sera la cercania del
actor dentro de la red y, viceversa. En el ejemplo de la Figura 68, el actor mas
cercano es “Leticia (64.71)” pues tiene el indicador mas bajo de lejania (17);
por el contrario, el menos cercano es “Jorge (37.93)”, mismo que tiene la lejania
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I UCINET 6 for Windows - Version 6617
File Data Transform Tools Metwork Visualize Options Help

1 @ m B\ C Cohesion » -
Regions »
Beegstt, 5P, Everett, MG, and Fiu Lmnnd,:.s
Harvard, MA: Analytic Technologe: Subgroups »
Multiple Measures Ctrl+M
Ego Networks ¥
A butorial by Bob Hanneman & Mark F Centrality and Power e Degree
See also this preat book Growp Centrality > _Degree (old)
Borgatt, 5 P Everett MG andJo  Core/Periphery » Inverse-weighted degree
ETT—————— T Eigenvector centrality
Roles & Postions ¥
Thiz copy of UCINET is regetesed to L ¢ (old)
Triad Census

Bl

Balance counter

Compare densities

Compare sggregate proximity mattices

Figura 67. Menu para el calculo de la centralidad de cercania en UCINET.

Method:
Closeness Centrality Measures

CLOSENESS CENTRALITY

Bonacich Power (Beta centrality)
PN Centrality

Political Independence Index (PIl}
Hubbell/Katz Influence

Hubs & Authorities

?\,l.,ﬂd?;ﬁ,ﬁ 2-Mede networks » e
Trajectories cl (oldl)
st ’ Beta Reach Centrality
Tester Reach centrality
Multiple Measures » Infermation Centrality

Info centrality (obsolete)
Freeman Betweenness
Distance-Weighted Betweenness
Attribute-Weighted Betweenness
Proximial Betweenness

Flow Betweenness ...

Fragmentation

Geodesic paths only (Freeman Closeness)

1 2

Farness nCloseness

5 Leticia 17 .0000 64.7059
2 Isaac 18.0000 61.1111
B Marco 19.8808 §7.8947
12 Samuel 19.0000 57.8947
1 Hugo 21.0000 52.3810
7 Nora 21.6808 52.3818
8 Oscar 21.8808 52.381e
11 Rosa 21.0000 52.3810
10 Querubén 22 .8088 58.8088
9 Pascual 23.00808 47.8261
4 Karen 29.0000 37.9310
3 Jorge 29.0000 37.931e

Figura 68. Resultado de la centralidad de cercania por cada nodo.
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mas alta (29). Esto se puede visualizar facilmente en la Figura 69, en donde se
muestra la misma red, pero considerando a los dos nodos focales mencionados.
En la primera parte (Figura 69a) se observa como “Leticia” (nodo en color rojo),
esta conectado a cinco actores a una distancia de uno (nodos en color verde), y
con otros cinco actores lo esta a una distancia de dos (nodos en color azul), es
por lo que su lejania tiene el valor mas bajo. Por su parte, Jorge (Figura 69b), sblo
esta conectado a un actor con distancia uno (nodo en color verde), después a

Hugo

a. Caminos geodésicos de Leticia.

Hugo

b. Caminos geodésicos de Jorge.

Figura 69. Caminos geodésicos de dos actores focales dentro de la red.
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tres actores con distancia dos (nodos en color verde), seguido de seis actores a
distancia de tres (nodos en color rosa) e incluso, esta conectado a un actor con
distancia de cuatro (nodo en color naranja), por lo que su valor de lejania es el
mas alto (junto con el de Karen).

Centralidad de Intermediacion

La intermediacion es una medida basada en la frecuencia con la cual un nodo esta
ubicado entre los caminos geodésicos (caminos mas cortos) que conectan a pares
de otros nodos en la red (Freeman, 1979). La intermediacion de un actor es cero
cuando no esta o no forma parte del camino mas corto entre cualquier otro par
de nodos en la red. Esto puede ocurrir, por supuesto, cuando un nodo esta aislado
(centralidad de grado cero) o cuando todos los actores con los que esta conectado
el actor focal (al que se le esta calculando el indicador) estan conectados unos
con otros (Borgatti et al., 2013). En este sentido, la intermediacion de un actor
depende del grado en el cual éste es necesario como un enlace o eslabén para
conectar a otros nodos y con ello facilitar la propagacion de informacion dentro de
la red (de Nooy et al., 2005; Jackson, 2008). De la misma forma, la intermediacion
es comunmente interpretada como una medida del potencial de control que
tiene un actor sobre “lo que fluye” a través de la red; en este sentido, los actores
con alto nivel de intermediacién estan en una posicién ventajosa pues pueden
retener, interrumpir o distorsionar la operacion de la misma (Borgatti et al., 2013;
Freeman, 1979), pero también pueden acelerar la difusion de informacion o de
otro “recurso” de interés para los actores de la red.

Un detalle a considerar en la intermediacion, es que las estructuras de la red
derivadas de las conexiones de los nodos van a influir en el nivel de intermediacion
de los actores, por ejemplo, en una red estrella, el nodo central intermedia todas
las conexiones entre los demas actores; pero imagine ahora un "clique" (subred
formada por tres o mas nodos en donde todos los actores estan conectados
con todos, es decir, son adyacentes entre ellos) donde no hay un nodo central
y, por tanto, ninguno de ellos es necesario para intermediar la conexion de los
otros (Hanneman & Riddle, 2011; Wasserman & Faust, 1994). Otro detalle a
tener en cuenta es que la intermediacion toma en cuenta los caminos geodésicos
entre los nodos, sin embargo, existen actores que intermedian a dos actores y
que no necesariamente estan intermediando los caminos mas cortos, en este
sentido, Freeman, Borgatti, y White (1991) desarrollaron el indicador llamado
Flow betweenness, al considerar todos los caminos posibles entre los actores. Sin
embargo, para efectos de la explicacion, sélo nos referiremos al enfoque basico de
la intermediacion (Freeman, 1979).
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Para el calculo de la centralidad de intermediacién de cada uno de los nodos
que componen la red, en UCINET se utiliza la ruta: Network>Centrality and
Power>Freeman Betweenness>Node Betweenness (Figura 70). Para este caso
se esta usando nuevamente el ejemplo de la red mostrada en la Figura 58, que
es una red dirigida. Posteriormente, se abrird una ventana en la cual s6lo se
tiene que seleccionar el archivo a utilizar en la opcion “Input dataset:”. En este
caso, no se tiene que configurar otro tipo de opciones, simplemente se tiene
que presionar el boton “OK”. Al hacerlo, se obtiene una salida de resultados
similar a la Figura 71.

Los resultados obtenidos (Figura 71) muestran primero dos leyendas a
considerar en el calculo de este indicador. La primera es que la centralidad de
intermediacion no puede ser calculada para redes con vinculos ponderados, pues el
procedimiento dicotomizaria las relaciones si fuera el caso; de cualquier forma, los
datos de red del ejemplo no estan ponderados. La segunda leyenda por considerar
es que el calculo de la intermediacion se hizo asumiendo que los vinculos son
dirigidos, por lo que los caminos geodésicos tomaran en cuenta esta caracteristica
para poder ser determinados por el programa. Posteriormente, se muestran dos
columnas, la primera es el nUmero de caminos geodésicos que intermedia cada nodo
(Betweenness), es decir, es el nimero de veces que el actor (nodo j) esta dentro del
camino geodésico de un par de nodos i, k. La segunda, es el mismo indicador, pero
normalizado (nBetweenness). Este indicador también se expresa como porcentaje
de la intermediacion que tiene el nodo j, con respecto a la intermediacion de todos
los pares de nodos en la red, por supuesto excluyendo el nodo j.
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Figura 70. Menu para el calculo de la centralidad de intermediacion en UCINET.
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FREEMAN BETWEENNESS CENTRALITY

Important note: This routine cannot handle valued data, so it binarizes your data automatically.
It DOES handle directed (non-symmetric) data, so it does NOT symmetrize.

Un-normalized centralization: 3@.008

1 2

Betweenness nBetweenness

9 ERe18 3.0000 3.3333

1 ERee2 ©.0000 0.0000

3 ERees 9.0000 0.e000

2 ERee3 9.0000 9.80008

5 ERel2 9.eeee 9.e0ee

6 ERe13 e.eeee 9.eeee

7 ERel4 e.ecee 9.e0e0e

8 ERe1l7 9.ecee @.e000

4 ERele 0.eeee ©.8000

1@ ERe24 8.6000 @.6000
11 ERe25 0.0000 0.0000

Figura 71. Resultado de la centralidad de intermediacion por cada nodo.

Como se puede observar, el Unico nodo que tiene cierto nivel de intermediacion
es el actor ER0O18 (Figura 71), ningun otro actor esta intermediando a otros
pares de nodos. Esto es interesante por dos cuestiones: primero, debemos
recordar que la red es dirigida, entonces para que un nodo j esté intermediando
las conexiones entre otros nodos (i, k), al menos el nodo j debe tener un grado
de entrada y uno de salida, situacién que no sucede en muchos casos en nuestra
red ejemplo. Segundo, aunque suceda lo anterior, es necesario que los nodos i,
k que esta intermediando el nodo j, no estén conectados. Por ejemplo, el nodo
ERO12 cumple con tener un grado de entrada y uno de salida, pero no cumple
con el segundo punto, puesto que los nodos que intermedia (ER013 y ER002),
estan conectados directamente, por ello su nivel de intermediacion es 0. Otro
ejemplo ilustrativo es el del nodo ERO17, el cual fue muy prominente en sus
grados de salida (ver Figura 65); sin embargo, como no tiene ninglin grado de
entrada entonces no intermedia el flujo de las conexiones.

Volviendo con el nodo ER018, los tres caminos geodésicos que intermedia
representan el 3.33% de los caminos geodésicos totales entre pares de nodos
en la red. Para saber cuantos pares de nodos existen en una red, sin considerar
el nodo focal (nodo j), se aplica la formula (n — 1) (n — 2) para redes dirigidas;
para redes no dirigidas, el producto anterior se divide entre 2. En nuestro caso,
son 11 nodos, por tanto (11 — 1) (11 — 2) = (10) (9) = 90 pares posibles.
Dividiendo (3 / 90) y luego multiplicado por 100 para obtenerlo en porcentaje,
obtendriamos 3.33. De la misma forma que en los indicadores anteriores, en las
salidas del programa también se incluye un conjunto de estadisticos descriptivos.
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Es importante comentar que, en ocasiones, aunque no se observa en el ejemplo,
se pueden tener valores decimales en la columna de intermediacion (Betweenness),
esto se debe principalmente a que el nodo j no es el Unico nodo que intermedia el
camino geodésico entre los nodos i, k. Por ejemplo, en la Figura 72, los nodos B, C
y D, intermedian a los nodos A-E con la misma longitud de pasos, es decir, en cada
caso el camino geodésico es 2. Entonces, el valor de intermediacion seria 1 / 3 =
0.3333 y normalizado de 2.7778; para mas detalles ver Velazquez Alvarez y Aguilar
Gallegos (2005) que presentan varios ejemplos.

D

Figura 72. Ejemplo de tres nodos (B, C y D) intermediando a un par de
nodos (A-E) con la misma longitud de camino geodésico.

5.2.4. Eigenvector

94

De una forma basica, el eigenvector deriva del razonamiento de que una medida
simple de la popularidad de una persona es el numero de vinculos que esa persona
tiene, pero entonces puede ser deseable y posible, crear un indice de popularidad
de segundo orden al considerar y ponderar los vinculos de las personas a las que
el nodo original esta conectado y, asi sucesivamente (Bonacich, 1972). De esta
forma, el eigenvector se puede interpretar como una medida de la popularidad de
un actor en el sentido de que un nodo con alto valor del indicador esta conectado
anodos que a su vez estan bien conectados (Borgatti et al., 2013). Este indicador,
al tomar en cuenta las relaciones indirectas, también ofrece mas informacion con
respecto a los vinculos de los nodos, porque puede ser que existan nodos con
centralidad de grado bajas, pero que estén conectados a nodos con grados altos
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y, por tanto, su eigenvector sera alto; al contrario, puede ser que haya actores
altamente conectados (grados elevados) pero que éstos no estan conectados a
nadie, por tanto, su eigenvector sera bajo.

Uno de los detalles importantes a considerar en el uso del eigenvector, es que
so6lo trabaja con estructuras sociales (datos de red) simétricas (Bonacich, 1972).
En redes dirigidas, el indicador no puede ser computado porque basicamente
existen nodos que aunque tengan grados de entrada o salida, los actores a los que
estan conectados es posible que no tengan ninguno de los dos indicadores; por
lo cual, el valor obtenido por el calculo del eigenvalue (constante necesaria para
el calculo del eigenvector) sera cero (Borgatti et al., 2013). En este sentido, es
importante considerar que simetrizar la red simplemente para lograr obtener el
indicador podria ser completamente incorrecto, sobre todo porque si el vinculo
dirigido representa “algo”, esa informacion se pierde y, por supuesto, porque se
podrian llegar a interpretaciones erréneas. Por tanto, el indicador recomendado
para redes dirigidas seria la Centralidad Beta de Bonacich (Bonacich, 1987), que
se explica a continuacion.

Como se menciond, el eigenvector es un indicador no recomendado para redes
dirigidas, por lo tanto y para ejemplificar el calculo de este indicador se utilizara
nuevamente la red hipotética con datos no dirigidos y dicotomizada (ver Figura 21),
lamisma que se analizd parala centralidad de cercania. De esta forma, para obtener
el eigenvector de cada uno de los nodos que componen la red, en UCINET, se
utiliza la ruta: Network>Centrality and Power>Eigenvector centrality (Figura 73).
En este caso también existe una version “old” del indicador “Eigenvector (old)”,
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Figura 73. Mend para el calculo de la centralidad de cercania en UCINET.
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sin embargo, en esta ocasion es mas recomendable usar la primera opcion debido
a que ésta tiene algunas variantes que pueden ser de interés. Aunque la version
“old” también proporciona el indicador de forma normalizada, entonces sera
decision del usuario cual de las dos utilizara; en este caso usaremos la ya indicada.
Posteriormente, se abrira una ventana en la cual sélo se tiene que seleccionar
el archivo a analizar en la opcion “Input Network:”. En las opciones marcadas
como “Normalization”, de manera automatica esta seleccionada la opcion “Euc.
Norm=1", en este sentido se recomienda dejar asi, junto con las otras opciones,
entonces no seria necesario cambiar nada. De manera breve, el hecho de dejar la
configuracion “Euc. Norm=1", hace que el procedimiento normalice el indicador
entre uno, por lo cual la salida mostrara el valor original del eigenvector.

Si se quisiera obtener un indicador normalizado, acorde a los valores originales
(de hecho, obtenida por la via de la version “old”), entonces se deberia seleccionar
la opcion “Div by max possible”. También se podria obtener el indicador
normalizado, dividiendo los valores originales entre el maximo observado.
Aunque una vez mas, todas estas elecciones las hace el usuario. Después de la
configuracion de las opciones se debe presionar el boton “OK”, de esta forma se
obtiene una salida de resultados con el indicador de eigenvector, similares a los
de la Figura 74.

EIGENVECTOR CENTRALITY
Important note: This routine automatically symmetrizes by maximum.
1
Eigenv
ector
1 Hugo ©.331@
2 Isaac ©.4479
3 Jorge 8.8745
4 Karen ©.@9@9
5 Leticia ©.4158
6 Marco ©.3330
7 Nora ©.2214
8 Oscar ©.2872
9 Pascual ©.2839
10 Querubin @.2649
11 Rosa ©.2732
12 Samuel @.2728
12 rows, 1 columns, 1 levels.

Figura 74. Resultado del eigenvector por cada nodo.
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Los resultados obtenidos (Figura 74) muestran una columna con un Gnico
indicador, el eigenvector por cada actor. Como se explico, este indicador toma
en cuenta los vinculos indirectos; es asi como, se puede observar que “Isaac
(0.4479)" tiene el eigenvector mas grande, seguido de “Leticia (0.4158)", esta
comparacion es interesante porque ambos tienen cinco vinculos (Figura 75),
pero si se comparan los vinculos que tienen los actores a los cuales cada uno
(Isaac y Leticia) esta conectado, se puede contabilizar que la principal diferencia
esta en que “Isaac” esta vinculado a dos actores que a su vez estan conectados
a cuatro actores mas, mientras “Leticia” s6lo esta conectado a un actor con esas
caracteristicas, ademas “Leticia” es adyacente a un actor que tiene vinculos con
otros dos actores, en tanto que “Isaac” no esta conectado a un actor asi. Por
supuesto, la lectura de los otros actores y de los otros vinculos indirectos se va
realizando con la misma logica. De esta forma es que un actor con un valor de
eigenvector alto indicara y se podra interpretar como que ese nodo esta bien
conectado con nodos que a su vez también estan bien conectados. Es por esta
situacion que “Jorge” y “Karen”, a pesar de tener un solo vinculo directo, tienen
valores de eigenvector diferentes. En este sentido, “Karen” estad conectada a
actores mejor conectados en comparacion con “Jorge”. Esta descripcion breve se
puede visualizar facilmente en la Figura 75 donde se asigno6 a los actores el valor
del eigenvector como atributo, y después es representado usando el tamafo del
nodo (ver seccion 4.2.4); por ello, el mayor tamafo del nodo es porque el valor
del eigenvector es mas alto, y viceversa.

Karen

Figura 75. Grafico de red con atributo eigenvector por cada nodo, a
mayor tamafo mayor valor del eigenvector, y viceversa.
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5.2.5. Centralidad Beta de Bonacich

Un indicador en el ARS que de manera muy interesante une el enfoque de la
centralidad de grado y los vinculos indirectos (que serian aquellos que tienen
los actores a los cuales un actor esta conectado, es decir, el eigenvector), es la
Centralidad Beta de Bonacich (Bonacich, 1987). Bonacich propuso un indicador
basado en la idea de que el estatus de un actor dentro de una red es una funciéon
del estatus de aquellos con los que uno esta conectado, para lo cual utiliza un
parametro beta (3, cuya magnitud afecta el grado en el cual los vinculos distantes
son tomados en cuenta. El parametro beta, que es elegido por el usuario, sirve
como un ponderador basado en la longitud de los vinculos indirectos (Borgatti et
al., 2013); es decir, el valor de beta es un factor que captura la forma en que el estar
conectado a otros nodos decae con la distancia (Jackson, 2008), por supuesto,
considerando un nodo focal. Entonces, cuando beta incrementa su magnitud,
la centralidad de los actores a los cuales un actor esta conectado toman mas
relevancia y, por tanto, incrementan el valor del indicador, y viceversa. Por tanto,
cuando beta tiende a cero, la medida es basicamente equivalente a la centralidad
de grado, es decir, s6lo toma en cuenta a los nodos conectados directamente. De
esta forma, la Centralidad Beta puede ser vista como una medida de influencia
potencial que un actor puede tener sobre otros actores via directa o indirecta,
lo cual va a depender del valor beta, para saber qué tanto las distancias mas
largas entre pares de nodos son consideradas o no. Por Ultimo, el parametro beta
puede tomar valores tanto positivos como negativos; en el primer caso, la medida
resultante hace referencia a la centralidad o influencia de un actor; en el sequndo,
el indicador representa una medida de poder (Bonacich, 1987).

Para ejemplificar la explicacion anterior, imagine una red dirigida como la de
la Figura 76, en la cual existen tres niveles. En el primero, sélo esta el nodo A, en
el segundo hay tres nodos B (B1-B3) y, en el tercer nivel, cada uno de los nodos B
tiene cinco nodos C (C1-C15). Si se calculara la Centralidad Beta (con base en el
grado de salida) con un parametro beta de 0.8, es decir, que se tienen en cuenta
distancias mas largas, entonces la centralidad del nodo A seria de 3.7749 y de los
nodos B, de 1.2583, a pesar de que los nodos B tienen mas vinculos directos que
A (Cuadro 3). Por el contrario, si se usara un parametro beta de 0.1, entonces se
tendrian en cuenta los vinculos mas locales y cercanos, por lo cual la centralidad
de los nodos B (2.2331) seria mas alta que la del nodo A (2.0098), pues este
ultimo solo tiene tres vinculos directos, en comparacion a los cinco que tienen los
nodos B; por supuesto, en ambos casos, la centralidad de los nodos C resultaria
de cero.
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Figura 76. Ejemplo de una red jerarquica en tres niveles.

Cuadro 3. Centralidad Beta de Bonacich (con base en grados de salida) para varios valores de beta.

Beta Nodo A Nodos B Nodos C
0.8 3.7749 1.2583 0.0000
0.5 3.3627 1.6013 0.0000
0.1 2.0098 2.2331 0.0000

Ahora bien, para el calculo de la Centralidad Beta de Bonacich de cada uno de
los nodos que componen la red, en UCINET se utiliza la ruta: Network>Centrality
and Power>Bonacich Power (Beta Centrality) (Figura 77). Es importante mencionar
que, para ilustrar este indicador, se esta usando nuevamente el ejemplo de la red
mostrada en la Figura 58, que es una red dirigida. Posteriormente, se abrira una
ventana en la cual sélo se tiene que seleccionar el archivo a analizar eligiendo
“Input Network Dataset:”. Existen otras opciones que deben ser configuradas,
pero basicamente las escogidas por default se deben conservar, sobre todo en las
opciones de “Parameters and Method:” o “Normalization method”. Sélo en el caso
de la seccion “Beta coefficient”, existe un espacio titulado como “Beta coefficient”
en donde se debe escribir el parametro beta que se busca analizar; para nuestro
ejemplo lo haremos con un valor beta de 0.6. Otra opcion importante a considerar es
la de “Direction”, ya que como se menciond, este indicador puede ser obtenido para
redes dirigidas. Siguiendo con nuestro ejemplo, se utilizara la opcion “In-centrality”.
Es conveniente considerar en esta Ultima opcion, que la seleccion de uno u otro (Ino
Out) dependera del tipo de red y de la informacion que representa; en nuestro caso,
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Figura 77. Menu para el calculo de la Centralidad Beta de Bonacich en UCINET.
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por ser una red de informacion y conocimiento, es que se seleccion6 la opcion “In-
centrality” puesto que esto nos ayudara a saber cuales son los nodos masimportantes
para el acceso a informacion y conocimiento. Posterior a la configuracion de las
opciones simplemente se tiene que presionar el boton “OK”; al hacerlo, se obtiene
una salida de resultados similar a la Figura 78.

Antes de continuar, es importante considerar que la eleccion del valor de beta
dependera de los fundamentos tedricos y empiricos subyacentes a la red y de lo
que represente ésta; por ejemplo, Aguilar-Gallegos et al. (2016) usaron un valor de
beta de 0.4 y la direccién “In-centrality” porque argumentan que utilizar un valor
mas alto implicaria suponer que la informacion vertida en un actor se difundiria a
distancias mas largas; por tanto, con el valor de 0.4 se asume (con bases tedricas y
empiricas) que los vinculos locales y cercanos toman mayor relevancia pero, ademas
ellos indican que los vinculos indirectos toman relevancia para alcanzar a actores
distantes. Quizas en redes de difusion de virus informaticos, un valor de 0.2 o0 0.4
no represente bien la red, en su lugar, valores altos de 0.8, 1.0, 10 o mas, sean mas
recomendables. Es el mismo caso para redes jerarquicas; por ejemplo, en empresas
o en arreglos institucionales por niveles. En estos casos, la informacion, érdenes o
procedimientos, deben tener un nivel de penetracion alto en toda la red, es decir, en
estos casos se deberian manejar valores de beta altos.
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BETA CENTRALITY / BONACICH POWER

Beta value 8.6
Beta parameter: 8.6
Computational method: Exact (slow for large networks)

Beta value is 8.6

Bonacich Power

1 ER@GZ 7.@e@e 1.5715
2 EREE3 ©0.000e 2.8000
3 ERGES 6.5000 1.4593
4 ERele 7.-e8e 1.683B
5 ERR1Z 2.5688@ B.5813
6 ERR1l3 2.568@ 8.5613
7 ERRl4 @.B2ge ©.8e20
8 ERR1Y P.228e 0.8eae
9 ERR1lE 7.5088@ 1.683B
1@ ER@24 1.8088 8.2245
11 ERE2S 1.e080 B.2245

Figura 78. Resultado de la Centralidad Beta de Bonacich,
usando un parametro beta de 0.6, por cada nodo.

Regresando al ejemplo, los resultados obtenidos (Figura 78) muestran dos
columnas, la primera es la Centralidad Beta sin normalizar (Beta Ce), es decir,
es el calculo de los vinculos directos e indirectos considerando el parametro o
factor de atenuacion beta. La segunda, es el mismo indicador, pero normalizado
(Normali). Este indicador es el que cominmente se incluye en los informes o
cuadros de resultados (ver Bonacich, 1987). En el caso del autor referido y del
ejemplo expuesto, la normalizacién se obtiene de tal forma que la suma de los
cuadrados de todos los valores sume el nimero total de nodos en la red, es
decir, el tamafio de la misma; otros procedimientos de normalizacion podrian ser
utilizados, por ejemplo, que la suma de los cuadrados de los valores sea igual a 1,
e.g. Borgatti et al. (2013).

De esta forma, se puede apreciar que los actores con el mayor indicador son
los ER010 y ER018 (1.6838), seguidos por el ER0O02 con 1.5715 (Figura 78).
Este caso es interesante de analizar porque este Ultimo actor tiene 4 grados de
entrada, mientras que los primeros dos actores so6lo tienen 3 (Figura 79); sin
embargo, es aqui en donde se aprecia el efecto que tienen los vinculos indirectos,
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ER025

Figura 79. Grafico de red con atributo Centralidad Beta de Bonacich por cada
nodo, a mayor tamafo mayor valor de Centralidad Beta, y viceversa.

es decir, toman relevancia los vinculos que tienen los otros nodos a los cuales
se esta vinculado directamente, es por ello que el valor del ER0O02 es inferior
al de los primeros dos, pues a los que ER002 esta vinculado no tienen a su vez
buenos vinculos. En el extremo se tienen los actores ER003, ER014 y ERO17 cuyo
indicador es de 0.0000 y, es obvio, pues no tienen grado de entrada (Figura 79).
Por tanto, a mayor valor de la centralidad beta mayor sera la relevancia del actor
dentro de la red, y viceversa. La visualizacion del indicador en la red, usandolo
como atributo, y siendo representado por el tamano del nodo se aprecia en la
Figura 79.

Por Gltimo, en este caso, solo utilizamos la Centralidad Beta de Bonacich
tomando como base los grados de entrada, pero también podria ser interesante
para el usuario obtener el mismo indicador, pero ahora con los grados de salida el
procedimiento seria el mismo sélo que se debera marcar la casilla indicada como
“Out-centrality” en las opciones de “Direction”.

5.2.6. Integracion y Radialidad

La integracion (Valente & Foreman, 1998) se refiere al grado en el cual un actor
esta conectado a muchos y diversos actores en una red. Este indicador no sélo
toma en cuenta los vinculos directos, sino también los indirectos, y esta basado
en las distancias geodésicas invertidas (no reciprocas). De esta forma, un actor
integrado puede ser alcanzado facil y rapidamente por otros actores, por lo cual
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este indicador puede ser tomado como una medida de cercania, pero también
de conectividad. El calculo de la integracion se basa en los grados de entrada;
por tanto, la integracion es una medida del grado en el que las nominaciones de
entrada de un actor lo integran a la red. De esta manera, la integracion mide qué
tan bien esta conectado un actor a la red.

La integracion, al ser una medida de cercania, se puede confundir con la
centralidad de cercania de un actor; basicamente, la diferencia radica en que uno
toma las distancias invertidas y el otro las distancias reciprocas. Sin embargo, la
integracion tiene la ventaja, asi como la radialidad, de ser calculada para nodos
aislados o poco conectados, lo cual no es posible para la centralidad de cercania,
y se tendrian que hacer algunos ajustes de célculo para obtenerla (ver seccion
5.2.2).

Por su parte, la radialidad (Valente & Foreman, 1998) es una medida
complementaria a la integracion. Este indicador hace referencia al grado en el cual
las relaciones de un actor, enviadas por él hacia la red, proveen acceso a varios
y diversos actores, permitiéndole alcanzar a otros actores e insertarse en la red
por diferentes vias. Este indicador también puede ser tomado como de cercania,
aunque también de alcance o accesibilidad. La radialidad, por tanto, esta basada
en los grados de salida y, al igual que la integracion, va mas alla de los vinculos
directos de los actores a los cuales esta conectado. De esta forma, un actor con un
nivel alto de radialidad es capaz de alcanzar a muchos masactores en lared a través
de pocos pasos, debido a los vinculos indirectos de otros nodos (Costenbader &
Valente, 2003). Es decir, la radialidad mide qué tan bien los vinculos de un actor
alcanzan a los actores de la red.

Losindicadores de integraciony radialidad, al ser considerados como una medida
de cercania, se obtienen siguiendo el mismo menu utilizado en la Centralidad de
Cercania (ver seccion 5.2.2). De esta forma, para calcular la integracion y radialidad
por cada uno de los nodos que componen la red, en UCINET se utiliza nuevamente
la ruta: Network>Centrality and Power>Closeness (old) (ver Figura 67). Sélo se
debe recordar que se utiliza la opcién “Closeness (old)” y no la que esta marcada
como “Closeness measures". También se debe recordar que para ejemplificar estos
dos indicadores utilizaremos la red de 11 nodos con vinculos dirigidos (ver Figura
58). Posteriormente, en la ventana que se abre (Figura 80), se debera seleccionar
el archivo a analizar en la opcion “Input dataset:”. El siguiente apartado es crucial
para la obtencion del indicador, en la casilla desplegable de la opcion “Type:”, en
automatico aparece “Sum of geodesic distances (Freeman)”, pero en este caso se
debera seleccionar “Avg of reversed distances (Valente-Foreman)” (Figura 80). En
la siguiente opcion de “Gradient”, no es necesario cambiar la configuracion. Por
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{ I8l Closeness Centrality — O X

Parameters

Input Dataset: |FiedCaprinosN11

[l lvg of reversed distances [Valente-Foreman [v X Cancel

Sum of geodesic distances (Freeman)
Sum of reciprocal distances ? Help

Gradient:

A
Output Dataset: Sum of lengths of all paths
Sum of lengths of all trails

VYalue to assign undefined distances:

N [number of nodes)
Max observed distance plus 1

Zero [within components only)

Figura 80. Configuracion para el calculo de la integracion y radialidad en UCINET.

ultimo, como se mencion6 anteriormente, la integracion y radialidad no tienen
ningun problema de calculo para redes fragmentadas y nodos no conectados, como
lo tiene la Centralidad de Cercania (ver seccion 5.2.2), por lo que las tres opciones en
la seccion “Value to assign undefined distances:” se desactivan automaticamente.
Después de esta configuracion, solo se debe presionar el boton “OK”. De esta forma,
se obtiene una salida de resultados con los indicadores integracion y radialidad,
similares a los de la Figura 81.

CLOSENESS CENTRALITY

Note: Data not symmetric, therefore separate in-closeness & out-closeness computed.
Closeness Centrality Measures

1 2 3 4
Integration Radiality nIntegration nRadiality

1 ERee2 0.g8e8e 8.2208 48,0080 2.2208
4 ER®le 0.8e8e a8.0ee 40 . 0008 2.0ee
9 ER@18 B.6088 8.4868 38.00880 208.0000
3 ERees B.5880 9.3200 25,0080 15.0200
6 ERe13 e.2080 8.4e200 19.ee080 28.0000
1@ ERe24 8.2608 6.4000 10.0800 20.0009
5 ERe12 0.20080 a.4e00 18.e080 28.0800
11 ER@25 B.2088 8.0e68 18.e8880 8.0e68
2 ERee3 9.008080 9.2000 9.00800 19.0000
8 ERe17 0.e828 1.0e68 0.e828 58.0000
7 ERel4 ©.oe8e 8.4800 ©.oe8e 28.0800

Figura 81. Resultado de la integracion y radialidad por cada nodo.

104 Metodologias y herramientas para la investigacion, V 5



Los resultados obtenidos del procedimiento efectuado (Figura 81) muestran
cuatro columnas; las dos primeras son para los indicadores sin normalizar
(Integration, Radiality). En seguida, la tercera y cuarta columna son los mismos
indicadores, pero normalizados (nintegration, nRadiality). En ocasiones, los
indicadores normalizados son los que se recomienda reportar para poder hacer
comparaciones con otras redes, incluso si son de tamafos diferentes (Valente
& Foreman, 1998). En este caso, la normalizacion se obtiene dividiendo el valor
original entre el maximo valor de la distancia inversa de la matriz de distancias
geodésicas, es decir, el diametro de la red (Valente & Foreman, 1998). En nuestro
ejemplo, se puede notar que al dividir cada valor original de la integracion y
radialidad entre dos, y después multiplicarlo por 100, se obtiene el valor de los
indicadores normalizados; se divide entre dos, porque es el diametro de la red (ver
Figura 58). En este mismo caso de los indicadores normalizados, Aguilar-Gallegos
et al. (2016) explican que en una red tipo estrella, con 5 nodos y con vinculos
dirigidos hacia adentro (donde el diametro de la red es 1), el nodo central (con 4
grados de entrada) tiene una integracion del 100%, es decir, este nodo integra a
la totalidad de los nodos en la red. Por otra parte, cada uno de los otros 4 nodos
(con un grado de salida), tiene una radialidad normalizada de 25%; lo cual indica
que cada uno de ellos solo alcanzaria a un cuarto de los nodos involucrados en la
red, que precisamente seria el nodo central.

Con estas aclaraciones en mente, se puede observar en la Figura 82 que los
actores con el mayor nivel de integracion son ER002 y ER010 (valor normalizado de
40%). Lo cual se podria interpretar como que estos nodos pueden ser alcanzados

ER0O25

Figura 82. Grafico de red con atributo integracion por cada nodo, a
mayor tamafio mayor valor de integracion, y viceversa.
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por el 40% de la red. Se debe recordar que la integracion esta basada en los grados
de entrada y por eso coincide con que estos dos nodos son los que tienen grados de
entrada mas altos, de 4 para ER003 y de 3 para ER010; de hecho estos indicadores
estan muy correlacionados (Aguilar-Gallegos et al., 2016). En este sentido, es muy
interesante observar que, aunque los dos actores difieren en el grado de entrada,
tienen la misma integracion. Esto se debe a que, como se menciond, la integracion
y la radialidad toman en cuenta los vinculos indirectos y no solo los directos. Es
asi como se puede observar en la Figura 82 que ER003 no tiene ningln vinculo de
entrada indirecto, s6lo directos; mientras que, ERO10 tiene dos vinculos de entrada
indirectos de dos pasos, a través de ERO18 y que serian ERO05 y ER024; por lo que
su indicador de integracion es el mismo. Por su parte, los nodos que no poseen
ningun grado de entrada tienen un nivel de integracion de 0.000.

Complementaria a la integracion, esta la radialidad, basada en los grados de
salida. Por tanto, el actor mas radial en la red es el ER017 (50%, Figura 83), que
se interpreta como la capacidad de alcanzar al 50% de los nodos que componen
la red. Este valor de la radialidad del actor se debe a sus 5 grados de salida; sin
embargo, se puede verificar que no posee ningun vinculo indirecto, debido a que
con los actores que esta conectado, a través de sus grados de salida, no tienen a
su vez grados de salida a otros actores. Como puede ser el caso del ER024 que a
través del ERO18 y sus grados de salida, puede alcanzar a ER010 (Figura 83). De
esta forma, nodos sin grados de salida tendran una radialidad de cero, como lo son
ER002, ERO10y, ER025 (Figura 81).

ERO13

ERO12 \
-HH‘“H-..

EROO3

ERO05

Figura 83. Grafico de red con atributo radialidad por cada nodo, a
mayor tamafio mayor valor de radialidad, y viceversa.
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5.3. Interpretacion de los indicadores del ARS

Por lo general, durante el proceso de colecta de informacion de redes y, por
ende, durante el analisis de dicha informacion, la red que se genera esta asociada
y se refiere a un tipo especifico de vinculo (Marsden, 2005). Por lo tanto, la
especificacion del tipo de red que se analiza y de la informacion que representa
es siempre un aspecto importante que se debe tener en cuenta para la correcta
interpretacion de los indicadores, mas aiin cuando la red esta formada por vinculos
dirigidos (Aguilar-Gallegos et al., 2016).

De esta forma, no es lo mismo visualizar un vinculo A->B que provenga de una
pregunta tipo “;Con quién habla a menudo a través de la radio mientras estd Usted de
pesca?” (Johnson, 1986) a otra pregunta del tipo “;Persona, organizacién o evento
de la que aprende o acude cuando tiene problemas relacionados con la produccion en
su invernadero?” (Garcia Sanchez et al., 2011), y lo mismo para esta pregunta A
quién recurre para obtener informacion y conocimiento para implementar las prdcticas,
tecnologias e innovaciones que realiza en su unidad de produccién (caprina)?” (Aguilar-
Gallegos et al., 2017). En los tres casos existe una direccionalidad de la respuesta,
pero no se puede llegar a la misma interpretacion de los indicadores. Por ejemplo,
imagine que se pregunta “;Con quién comercializa su produccion y en qué volumen
o0 porcentaje?”, esta Ultima pregunta también tiene direccion e incluso los vinculos
podrian tener peso, y la interpretacion de los indicadores seria diferente a los casos
anteriores. Incluso, como ha sido sefialado por otros autores (Aguilar-Gallegos et
al., 2016), un vinculo A>B en donde se pregunté sobre fuentes de informacion y
conocimiento, quiere decir que B es la fuente de informacion de Ay, no que A le
esta compartiendo informacion y conocimiento a B. En este sentido, se recalca la
importancia de siempre hacer la interpretacion de los indicadores del ARS a la luz de
la informacion que representa la red, y de la pregunta de la cual se deriva el vinculo.

De acuerdo con lo senalado, se presentan las siguientes recomendaciones
para la interpretacion de los indicadores:

1. Siempre hacer mencién de la pregunta o informacion que dio origen a
la red. Omitir esto llevara sélo a una visualizacion de “lo que sea” que
represente la red, sin posibilidad de precisar qué esta siendo representado
con los graficos de redes.

2. Explicarsilainformacion colectadallevaala obtencion de vinculos dirigidos
o no dirigidos. En ambos casos, se recomienda explicar si los vinculos (por
la informacion que representa) tienen niveles o intensidades; si es el caso,
proporcionar mas informacion sobre qué representa cada nivel. Ademas, la
escala o variacién de los mismos; por ejemplo, representan proporciones,
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cantidades, distancias, escalas ordinales o nominales, escalas tipo Likert,
entre otros.

3. Con base en lo anterior, la direccionalidad y la intensidad de los vinculos,
es necesario considerar el uso y posibilidad de interpretacion de los
indicadores. Recordando (ver seccion 5.2), algunos de éstos no pueden
ser utilizados en redes dirigidas; otros no son posibles de obtener en redes
fragmentadas, y otros son necesarios en forma dicotomica. Entonces, una
explicacion de los indicadores a emplear es necesaria y recomendable.

4. Unavez que se realiza el calculo de los indicadores del ARS, es conveniente
que se haga su interpretacion uno a uno, por las implicaciones que tienen.
Por ejemplo, sison indicadores directos o indirectos (e.g., Aguilar-Gallegos
et al., 2016); o si se trata de indicadores de enlace o de puenteo (e.g.,
Bourne, Gassner, Makui, Muller, & Muriuki, 2017), entre otros.

5. En especial, para vinculos dirigidos, no obviar u olvidar la direccion del flujo.
Tal y como se ha indicado, un vinculo A= B no significa lo mismo a la luz de
una pregunta que de otra. Por ejemplo, en una red estrella “hacia adentro”
donde el nodo “A” recibe todos los vinculos de entrada, y se preguntd
nuevamente sobre fuentes de informacioén y conocimiento a los actores
involucrados, el nodo “A” sera un actor clave por ser un nodo fuente de
otros. En comparacion, si con la misma pregunta obtenemos una red estrella
“hacia afuera”, donde el nodo “A” envia todos los vinculos a los otros nodos
(el nodo “A” tiene alto grado de salida), la interpretacion sera diferente,
en este Ultimo caso puede ser posible que el nodo “A” sea un “buscador o
recolector” de informacion, en lugar de “una fuente de informacion” como
en el primer caso. Siguiendo el mismo ejemplo de las dos redes estrella
mencionadas, imagine que se pregunto “;A quién le ha comentado sobre lo
aprendido y visto durante el proceso de capacitacion y giras tecnologicas a
las que asistio?”; si en este sentido se obtiene la red estrella hacia afuera,
la interpretacion sera que el nodo “A” es un actor que comparte su
conocimiento; pero si fuera una red estrella hacia adentro, implicaria que
el nodo “A” es un actor que esta recibiendo informacion por diferentes
vertientes, pero en ninguno de los casos, se podra interpretar que el nodo
“A” es importante (ejemplificando en extremo) porque les vende insumos
a muchos agricultores, ya que simplemente los vinculos existentes en la red
no representan eso. La “direccionalidad” que se deriva de la pregunta es
entonces crucial para interpretar los indicadores de redes.

6. Enespecial, parael casodelaintermediacion, no se debe olvidar que el flujo
que esta intermediando el nodo focal es resultado de la direccionalidad; por
ejemplo, si se tiene el vinculo A>B->C derivado de una pregunta asociada
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a fuentes de informaciéon (como la tercera de los ejemplos ofrecidos al
inicio de esta seccion); entonces, B esta intermediando la informacion que
recibe de C y que, por tanto, A recibe de B. Estaria mal interpretar que B
intermedia la informacion de A hacia C. La misma consideracion se debe
tener paraindicadores como la Centralidad Beta de Bonacich, laintegracion
y la radialidad donde, por sus caracteristicas de indicadores indirectos, la
direccionalidad de los vinculos tiene implicaciones importantes.

7. Algunos indicadores del ARS son mas elocuentes en su forma normalizada
que “cruda” o no normalizada. Por tanto, es recomendable que en esos
casos se haga uso de las versiones normalizadas, en éstas su interpretacion
puede ser mas sencilla.

8. Aunque parezca obvio, se debe sefalar que hasta cierto punto es
incorrecto “sumar relacionamientos” derivados de distintas preguntas
generadoras de datos de red. Esta es una practica que se ha detectado en
alguna literatura, en donde proceden a sumar relacionamientos de “acceso
al conocimiento”, de “compra de insumos”, de “venta de cosechas”, y
hasta de “la red de amigos”, para generar una “red conjunta”. Derivado
de la explicacion que se ha dado hasta este momento, el lector facilmente
puede inferir que esa “red conjunta” no logra representar algo congruente.
Sin embargo, es necesario apuntar que existen redes multi-nivel y multi-
actor en donde se analizan diferentes tipos de vinculos, pero cuyos analisis
también son especializados.

9. Por ltimo, la interpretacion de los indicadores, por separado, puede verse
enriquecida si cada indicador generado es utilizado como atributo de los
nodos al momento de elaborar graficos. En algunos casos esto es aln mas
elocuente cuando se usa el tamafo del nodo (ver seccién 4.2.4) para
representar el indicador.

Esta seccion es importante que se tenga en cuenta porque existen algunos
casos en la literatura en donde la interpretacion de los indicadores se ha hecho
a la inversa (no tuvieron cuidado de la direccion del vinculo); otros en donde la
explicacion metodoldgica de los indicadores, asi como su calculo, es erroneo (por
tanto, la interpretacion de los resultados carece de fundamento), y otros mas
donde se llega a conclusiones con base en informacién que no esta representada
en los vinculos que forman la red (es decir, no tuvieron consideracion de
la informacion que subyace y da forma a la red). Por tanto, en la medida en que la
interpretacion de los indicadores del ARS se haga con apego a la informacion que
una red representa, mas sencillo sera ver la utilidad de los mismos. En su caso, tratar
de interpretar algo que no se logra visualizar en la red o que no tiene respaldo en la
informacion colectada, llevara a conclusiones erréneas y fuera de lugar.

ANALISIS DE REDES SOCIALES: CONCEPTOS CLAVE Y CALCULO DE INDICADORES

109






6. Seleccion de actores clave

En el ARS existe un conjunto de teorias y herramientas metodoldgicas que permite
localizar individuos que son mas centrales en su entorno social, y entonces es
muy posible que sean influyentes dentro de sus redes (Valente & Davis, 1999);
estos actores clave pueden funcionar para dinamizar, acelerar y difundir mas
rapidamente buenas practicas, tecnologias e innovaciones (Aguilar-Gallegos
et al., 2017; Valente & Davis, 1999). Otro punto importante de estos actores
clave es que, desde un punto de vista de la articulacion de la red, son estratégicos
pues sin ellos la red se fragmentaria, no habria cohesion y, por tanto, algunos
actores no podrian “alcanzarse” unos con otros. En este sentido, el propésito de
la identificacion y seleccion de actores clave dentro de una red se basa en que,
dentro de un contexto social, siempre existen algunos actores mas referidos por
sus pares, por tener caracteristicas sobresalientes en comparacion de los demas
(Aguilar-Avila, Santoyo-Cortés, Mufioz-Rodriguez, Aguilar-Gallegos, & Martinez-
Gonzalez, 2015; Aguilar Avila, Rendén Medel, Mufioz Rodriguez, Altamirano
Cardenas, & Santoyo Cortés, 2011). Entre estas caracteristicas, en el sector
agricola, estan: mayor tamano del rebano o superficie agricola, mejor calidad
genética, mayor antigiiedad en la actividad, mejor prestigio social, pero sobre
todo mayor cimulo de conocimientos, entre otros. Con seguridad el lector podra
enlistar los rubros destacados de los actores que conforman la red que pretende
analizar, segun el contexto de la actividad de éstos y de su interés particular.

Aunado a lo anterior, los actores clave por lo regular son considerados como
aquellos que tienen las posiciones mas centrales dentro de la red (Valente, 2012);
estos actores por tanto pueden ejercer una influencia sobre los demas actores a
los cuales estan conectados (Valente et al., 2015; Valente & Pumpuang, 2007),
directa o indirectamente. Es asi, una vez mas, que el ARS es una herramienta muy
poderosa para encontrar a los actores mas centrales, derivado de las menciones
de los otros actores (Aguilar-Gallegos et al., 2017).

No obstante, existen diversas formas de obtener indicadores que den cuenta
de laimportancia de los actores dentro de la red. En la seccidn 5.2 se han explicado
algunos de estos indicadores, los cuales van desde encontrar a los mas centrales
por tener mayor numero de nominaciones o por nominar a un mayor nimero de
actores, es decir, por su grado de entrada y/o salida (Freeman, 1979); los que
estan mas cercanos a otros actores y por tanto pueden tener acceso a recursos
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mas rapidamente (Freeman, 1979); los que estan intermediando el flujo de
informacion (Freeman, 1979; Freeman et al., 1991); los que ejercen cierto nivel
de poder y son mas centrales por las conexiones que poseen los actores a los que
estan directamente conectados (Bonacich, 1987); los que estan mas integrados
en lared o son mas radiales en ella y, por tanto, pueden ser facilmente alcanzados
por otros actores o saben como insertarse y moverse entre el entramado de
relaciones (Valente & Foreman, 1998), entre otros.

En este punto es donde se destaca el uso de software especializado para
encontrar a los actores clave, en este caso se hara referencia al uso del software
KeyPlayer 2 (Borgatti, 2006; Borgatti & Dreyfus, 2005). El problema basico
que busca solucionar este procedimiento es encontrar un conjunto de nodos,
llamados conjunto-kp (kp por Key Player), de tamafo k, con dos posibilidades
(Borgatti, 2006):

i. Primero, si se remueve el conjunto-kp, resultaria en una red con la menor
cohesion posible, esto es, la red se fragmenta. Este conjunto de nodos es
definido como KPP-Neg (“Key Player Problem/Negative”).

ii. Segundo, un conjunto-kp tal que esté conectado al maximo niimero de
otros nodos, es decir, que a través de sus vinculos se alcance la mayor
cobertura posible de la red. Este conjunto de nodos es definido como KPP-
Pos (“Key Player Problem/Positive”).

Debido a que la seleccion de actores clave, usando el enfoque de seleccion
de un conjunto-kp, tiene dos vertientes: el KPP negativo y positivo (Borgatti,
2006), se considera importante explicar su calculo, a través del uso del software
KeyPlayer 2, por separado. De esta forma, primero se mostrara el KPP-Neg y
posteriormente, el KPP-Pos.

Sin embargo, antes de continuar, es importante mencionar que para poder
trabajar con el software KeyPlayer 2, el archivo de red que se vaya a analizar
debe estar guardado en formato VNA (ver secci6on 4.5). Como se mencion6
en la seccion referida, este archivo se genera desde NetDraw (Borgatti, 2002)
y para ello se utiliza la ruta del menu File>Save Data As>VNA. Al dar clic en la
ruta anterior, aparecera una ventana como se aprecia en la Figura 84. En esta
ventana lo que se tiene que configurar es s6lo el nombre del archivo y la ubicacion
del mismo, esto se hace en la opcion “Name of VNA file to create:”, usando el
boton marcado con tres puntos suspensivos. Las demas opciones deben quedar
como se muestra en la Figura 84; es decir, en las opciones de “What to save:”
se selecciona “Current relation, only active ties and nodes”, y en las opciones
de “Delimiter” se selecciona “Spaces”. Por lo regular estas opciones estan
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seleccionadas de manera automatica. Después, sélo se debe dar clic en el botén
“OK”. Es recomendable guardar el archivo en una carpeta conocida y de facil
ubicacion en el disco duro, pues puede llegar a suceder que el nuevo archivo
creado no se encuentre con facilidad. De esta forma, se esta en posibilidades
de trabajar en el software KeyPlayer 2. En nuestro caso y para ejemplificar su
uso, se seguira empleando la red ejemplo de la Figura 58, que representa un
extracto de once nodos de una red con vinculos dirigidos de caprinocultores
que intercambian informacién y conocimiento para la innovacion, ver Aguilar-
Gallegos et al. (2017) para mayor detalle.

X | Save complete VNA file == O X
Filenarme:
MName of WA file to create: v OK
A" vna' extension will be added automatically. x Cancel
What to save: Delimniter
() &l nodes and ties (but marking inactive ones as inactive] for all relations @® Spaces
() All ties for all relations but only for currently active nodes i
() All relations, only ties of given tie strength, only active nodes [NOT YET IMPLEMENTED]
() Commas

(®) Curent relation, only active ties and nodes

‘When there is just one relation in memory, you narmally want to save just the ties that are
currently visible. But when there are several relations, you probably want to save ALL ties.

Either way, only nodes currently active will be saved.

Figura 84. Creacion del archivo VNA desde NetDraw.

6.1. El conjunto-kp negativo: Fragmentacion

Como se menciond, el concepto fundamental para encontrar el conjunto-kp
negativo (KPP-Neg) es la fragmentacion de la red. Basicamente y de forma muy
resumida, esto podria resolverse desde diferentes vertientes, la mas basica seria a
través del indicador de centralidad de intermediacion, pero no es adecuada; otra
podria ser a través de la obtencion del maximo nimero de componentes en la red,
no obstante, tiene el inconveniente del tamano de los componentes, entre otras
formas, ver Borgatti (2006) para mas detalle de cada caso. Después de diversos
argumentos, el autor (Borgatti, 2006) llega a definir una alternativa muy practica,
basando la medida de fragmentacion en la suma de la distancias reciprocas, de tal
forma que los nodos que tuvieran una distancia infinita (porque no se pueden
alcanzar por ninguna via), tuvieran una medida reciproca de cero. De esta forma,
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el indicador de fragmentacién basado en maximizar las distancias reciprocas
adquiere valores de 0 a 1. Por supuesto, el maximo valor de fragmentacion se
obtiene en redes formadas por nodos aislados.

Con base en lo anterior, el procedimiento entonces sera el de encontrar el
conjunto-kp que haga que se generen las maximas distancias reciprocas entre los
nodos que forman la red. Este procedimiento, por tanto, implica que se tendra
una condicion inicial de fragmentacion de la red; es decir, con base en un estado
inicial, es posible calcular las distancias reciprocas de los nodos de la red y calcular
una fragmentacion inicial, lo cual también podria ser un indicador global de la
red (ver seccion 5.1). Posteriormente, el procedimiento lo que hace es buscar
aquellos nodos, que después de ser removidos, tuvieran un efecto maximo en el
cambio de la fragmentacion, por lo cual se genera una condicion final. El cambio
entre la condicion final e inicial sera el que sufra la red al seleccionar el conjunto-
kp tal que incremente la fragmentacion en su maximo nivel.

Para la obtencion del conjunto-kp negativo, usando KeyPlayer 2, antes que nada,
se deberd abrir el archivo en formato VNA. Para ello se puede utilizar el primer icono
tradicional de apertura de archivos “Open network file:”, también se puede usar la
ruta “File>Open” o, usar la combinacion de teclas Ctrl + O. Siguiendo con el ejemplo
de la red mostrado en la Figura 58, se visualizaria una red muy similar a la Figura 85.
Como se puede apreciar, es comun que la red se muestre sin el uso de las flechas que
explican la direccion del vinculo, de ser el caso (como el que se ejemplifica) que la red
sea dirigida, estos elementos se pueden activar usando la ruta “Graphics>Arrows”.
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Figura 85. Red desplegada usando el software KeyPlayer 2.
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Una vez que se tiene abierto el archivo, se utilizara el menu
“Analyze>Identify>Disrupt” (Figura 86), la opcion “Disrupt” hace alusion a la
desorganizacién o fragmentacion de la red. Al seleccionar esa opcion, se abrira una
ventana de configuracion (Figura 87a), en ella existen algunas consideraciones a
tomar, entre ellas: i. En las opciones “Disruption Criteria:” se selecciona la que
hace referencia a maximizar las distancias reciprocas (“Maximize reciprocal
distance”), existen otras dos opciones que maximizan la fragmentacién por
componentes y otra por el tamafio de los componentes; sin embargo, es mas
recomendable la opcion seleccionada; ii. Para seleccionar el tamafo del conjunto-
kp negativo, se utiliza la opcion “Selected Group Size:” en nuestro ejemplo,
iniciaremos seleccionando 1; por supuesto, el tamafio del grupo dependera del
tamano de la red, pero siempre se tendra que hacer un proceso iterativo y, por
tanto, repetirlo tantas veces como sea necesario, y iii. Las otras opciones se dejan
configuradas como se muestra en la Figura 87a; de manera general, éstas no
se cambian debido a que el procedimiento trabaja de manera adecuada con el
algoritmo seleccionado de forma automatica, y las opciones de nodos requeridos
y no requeridos se explicaran mas adelante.
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Figura 86. Menu para la obtencion del conjunto-kp negativo
que fragmentan la red, en KeyPlayer 2.

Al presionar el botdn “OK” aparecera una ventana con el conjunto-kp propuesto
(Figura87b),esdecir,unalistade nodos que tendrian el mayor nivel de fragmentacion
de la red. Es comUn que se muestre mas de una lista de nodos, de ser el caso, sera
decision del investigador seleccionar la que mejor explique el comportamiento de
la red. Al seleccionar el conjunto-kp deseado, ahora aparecera una nueva ventana
(Figura 87c), en ella se muestran los resultados precisamente de la seleccion del
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conjunto-kp. En nuestro caso, se puede observar que la fragmentacion inicial de la
red es de 0.841, y al seleccionar el nodo ER018, la fragmentacion llegaria a 0.900;
es decir, el cambio en la fragmentacion es de 0.059. Al presionar el primer boton
indicado como “Go” hara que en la red se destaque el conjunto-kp negativo en otro
color y con otra forma, en nuestro caso seria un color lima y en forma de cuadrado
(Figura 88), mismos que se pueden cambiar.

Disruption n Results Sets
‘Weights and Measures B8 Femove 1 nodes, Maximize reciprocal di (31/07/2017 01:1%:13 p. m.)
Edge weights [TRE RG] o - Weighted fragmentation delta is 0.05% “ERD18
Data type Adjacent v
Disnuption Critena:
Maximze component count
(®) Maximize reciprocal distance |
() Mavimize fragmentation
Group Parameters: b. Resultado(s): Conjunto-kp negativo.
Selected Group Size:
- 2 Key Player Highlight — O 5
M . Greedy Algorithm 7 HecotdKPmdes[kp-set |
r [] Delete KP Nodes
Nurber of Iterations: 10 ‘
Save to nodelist ~ GO
Parameters Set color |. Lina v|
Set shape Square v

Dptirnize with areedy

Notsee [0 ]2

Mode zets
: Results  l\weighted fragmentation delta is 0.053; “ER018"
[] Use untouchable nodes kst _
Edge value: RedCaprinosN11: type: Adjacency
. - Initial fitness: 0.841
(] Use required nodes ls Final fitness: 0.900.
Change in fitness: 0.059.
Key Players:
[+1 Show Results Set Window ERGH
O Cancel
a. Configuracion del procedimiento. c. Informe del procedimiento.

Figura 87. Configuracion del procedimiento para obtener el KPP-Neg, en KeyPlayer 2.
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Figura 88. Conjunto-kp seleccionado en el procedimiento KPP-Neg en KeyPlayer 2.

En la practica, la seleccion del conjunto-kp es un proceso iterativo en donde el
usuario puedeirincrementando el tamafio de dicho conjunto. Recordando siempre
que, a mayor tamano mayor sera la fragmentacion de la red. En nuestro ejemplo,
la red se fragmentaria completamente al seleccionar cinco nodos (Cuadro 4),
con ellos el indicador alcanza su valor maximo (fragmentaciéon = 1), es decir,
todos los demas nodos quedarian aislados (desconectados). Sin embargo,
es necesario volver a considerar implicaciones como: ;qué tan factible es
intervenir en esos cinco nodos? ademas de las necesidades en el uso de recursos
economicos (y de otro tipo) que llevaria ese proceso. Es importante notar que,
aunque al incrementar el tamafo del conjunto-kp se incrementa el cambio en
la fragmentacion de la red, también se recomienda tener en cuenta el cambio
marginal en cada paso porque ese puede ser un indicador de qué tanto conviene
(o no conviene) incrementar el tamafio del conjunto-kp. Por ejemplo, pasar de
uno a dos nodos significa un cambio porcentual de 4.0% en la fragmentacion de
la red; pero pasar de cuatro a cinco nodos sélo es de 1.8%. Entonces en ocasiones
no es tan conveniente incrementar el tamafo del conjunto-kp si los cambios
marginales en la fragmentacion son pequefios.

Sin duda, la definicion del tamanfo del conjunto-kp dependera de los objetivos
que tenga el investigador y, también, hasta cierto punto, de las condiciones
iniciales de la red, porque si la red esta de por si fragmentada al inicio, con la
seleccionde pocosactores se fragmentaria mas, y viceversa; porque en una red mas
cohesionada, se deberan seleccionar mas actores para lograr su fragmentacion.
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Aunado a lo anterior, se tiene el tamafio de la red; en redes pequefas el conjunto-
kp necesario sera menor, y viceversa, por lo que, en nuestro ejemplo, de 11 nodos,
con sélo cinco de ellos se logra fragmentar la red completamente.

Cuadro 4. Cambio en la fragmentacion en la red al cambiar el tamafo del conjunto-kp.

Cambioenla

Tamario del conjunto-kp Fragmentacion final £ . Conjunto de nodos KP
ragmentacion
1 0.900 0.059 ERO18
2 0.936 0.095 ERO18; ER002
3 0.964 0.123 ERO18; ERO02; ERO17
ERO18; ERO02;
4 0.982 0.141 ERO17: ERO12
5 1.000 0.159 ERO18; ERO02; ERO17;

ERO12; ERO14

6.2. El conjunto-kp positivo: Cobertura o alcance de la red

De forma complementaria a la vision propuesta por Borgatti (2006), de la
seleccion de actores clave con dos tipos de objetivos, se tiene el conjunto-kp
positivo (KPP-Pos). En este caso, el concepto fundamental esta basado en la
conexion o cohesion que los actores del conjunto-kp tienen con los demas actores
restantes de la red (Borgatti, 2006); es decir, es una medida del grado en el cual
un grupo de actores esta conectado al resto de la red. Por tanto, se puede hablar
de una medida de cobertura o alcance de la red, en porcentaje, que se tiene al
seleccionar un conjunto-kp.

Al igual que con el KPP-Neg, pueden existir varios enfoques o formas de
tratar el problema de la seleccion del conjunto-kp, dos son los mas convenientes.
El primero es a través de maximizar el alcance de los nodos restantes, donde se
debe considerar y configurar una distancia maxima que cada nodo del conjunto-
kp puede usar para alcanzar a los otros nodos, en este caso la medida va de 0 a
100, expresada en porcentaje de nodos alcanzables por el conjunto-kp positivo.

El segundo enfoque es a través del uso de una medida de alcance de distancia
ponderada entre los nodos (Borgatti, 2006), es decir, este enfoque vuelve a
basar su calculo en las distancias entre los nodos, en este caso no es necesaria
la definicion de la distancia por obvias razones. De esta forma, el procedimiento
busca que las distancias del conjunto-kp a todos los demas nodos sea minima.
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Derivado del procedimiento, la medida de alcance del conjunto-kp positivo va de
0 a 1. El valor maximo de 1 se obtiene cuando cada uno de los nodos restantes de
la red es adyacente al menos a uno de los miembros que forman el conjunto-kp.
Al contrario, el valor minimo de O se obtiene cuando ninguno de los miembros del
conjunto-kp pertenece al mismo componente de cualquier otro nodo que forme
la red, es decir, el conjunto-kp esta completamente aislado de los demas y, por
tanto, no hay vinculos directos o indirectos que permitan alcanzar a los otros
nodos de la red.

Es importante considerar que, aunque ambos enfoques (el de maximizar el
alcance de los nodos y el de maximizar las distancias reciprocas) tienen ligeras
diferencias, ambos llegan a |a seleccion de un conjunto-kp positivo tal que ayude
a maximizar la conectividad de dicho conjunto con el resto de la red. Sin embargo,
en esta ocasion sélo nos basaremos en el procedimiento de obtencion del
primero pues de alguna forma es mas intuitivo de explicar y, al estar expresado
en porcentaje, también es mas facil de interpretar. No obstante, el lector podria
estar interesado tanto en probar la utilidad como en analizar las diferencias entre
los métodos, para ello es aconsejable revisar la fuente original de la propuesta de
estos indicadores en Borgatti (2006).

Con respecto al calculo y determinacion del conjunto-kp que ayudaria a tener
una mayor cobertura de la red (via la maximizacién del alcance de los nodos
restantes, no asi el de las distancias ponderadas), es importante profundizar en
algunos aspectos que se consideran durante el procedimiento de calculo de los
actores clave, con el uso del KeyPlayer 2. En este sentido, Aguilar-Gallegos et al.
(2017) explican que una caracteristica que se debe tomar en cuenta es la distancia
maxima (m) en la cual un nodo i puede alcanzar a otro nodo j; entonces cuando
la distancia es m=1, el procedimiento toma en cuenta los nodos adyacentes al
nodo iy, por tanto, seleccionara a los actores con mayor grado; pero cuando la
distanciaesiguala 2 (m=2), se tienen en cuentalos vinculos indirectos del nodo i.
Por supuesto una m=2 también incluye a los nodos que estén a una distancia
m=1. De esta forma, uno de los puntos clave en el procedimiento de calculo del
conjunto-kp positivo es la seleccion del valor de m. Debido a que, a mayor valor,
entonces mayor sera la distancia por considerar entre los nodos y, por tanto, la
cobertura del conjunto-kp sera mayor, y viceversa.

Sin embargo, es muy conveniente hacer hincapié en que la seleccion del valor
de m esta relacionada con el tipo de informacion representada en la red, es decir,
debe existir una base tedrica o empirica de seleccion. En términos sencillos, el
procedimiento no es sélo asignar un valor por asignarlo, o bien asignar un valor
alto simplemente para encontrar mayor cobertura en la red, aunque la teoria (o
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la evidencia empirica) subyacente de la informacién que representa la red no
sostenga una seleccion de m grande. Por ejemplo, en un estudio de seleccion de
actores clave para la difusién de innovaciones a través de una intervencion en red
(Aguilar-Gallegos et al., 2017), la distancia seleccionada fue de m=1. Los autores
argumentan que la seleccion de ese valor se debe a que empiricamente se buscaba
que los actores seleccionados, al menos lograran influir en la decision de adopcion
de los actores adyacentes. En este sentido, utilizar una m=2 o mayor, implicaria
que, si un nodo A influye en un nodo B, entonces B influiria a su vez en un nodo C
(considerando que A no tiene “conexion directa” con C), y asi sucesivamente, lo
que en teoria y en la practica es complicado de comprobar y, también, podria ser
dificil de lograr en un horizonte de tiempo corto.

Para ejemplificar un poco mas la importancia de la seleccion de m, en el marco
del KPP-Pos, imagine la red de la Figura 89; una red de cinco nodos con cinco
vinculos dirigidos. Suponga que quiere seleccionar al mejor actor para alcanzar la
mayor cobertura posible, la pregunta complementaria es ;a qué distancia puede
llegar ese actor? Esto es importante, porque si definiéramos una distancia maxima
de 1 (m=1), entonces el mejor actor es A porque llegaria a B y C; estos dos Ultimos
no lo serian porque sélo llegan a un actor D y E, respectivamente. AUn mejor seria
si se definiera a m=2, entonces A ahora podria alcanzara D y E, ademas de By C,
entonces con A se tendria una cobertura del 100% de la red. Ahora suponga que no
so6lo se puede seleccionar un actor sino dos y con una m=1, entonces seria lo mismo
seleccionar Ay Bo, Ay Co, By C, porque entre ellos se llegaria al 66.7% restante de
la red, es decir, en el primer caso se llegariaa Cy D, en el sequndo casoa By E y, por
ultimo, se llegaria a D y E. Es obvio pensar que no tendria mucho caso seleccionar
dos actores con una m=2, porque basicamente con A se cubre a todos los otros
actores, entonces seria lo mismo seleccionar a B o C. Pero se debe recordar que, en
cualquiera de los casos, la definicién de m debe estar sustentada ya sea tedrica o
empiricamente. Por supuesto, como se ha visto, a mayor m mayor es la cobertura de
los actores de la red, pero eso no implica que arbitrariamente se seleccione ese valor.
En este sentido, conviene sefalar que si, por ejemplo, los vinculos hacen alusion a
un mensaje que se comunica en la red, probablemente ese mensaje se podria
distorsionar o reinterpretar a medida que llega a actores mas “alejados” del (o los)
actor inicial que “disemina” ese mensaje; por lo que, valores altos de m podrian ser
errbneos para calcular el alcance del mensaje a través de la red.

D B A C E
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Figura 89. Ejemplo de una red con cinco nodos y cinco vinculos dirigidos hacia afuera.
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Es importante explicar que la seleccion del conjunto-kp puede ser obtenido
para redes dirigidas y no dirigidas; de hecho, la explicacion de la Figura 89 se ha
hecho con vinculos dirigidos. Pero ahora imagine que los vinculos no van del centro
hacia afuera; sino al contrario, de afuera hacia adentro, como en la Figura 91. En
este sentido, existen dos formas de resolver el KPP-Pos en el software KeyPlayer
2, con base en los grados de entrada (en el software KeyPlayer 2 indicado como
“Harvest”) y, por supuesto, con base en los grados de salida (en el software
KeyPlayer 2 indicado como “Diffuse”). Sin embargo, en este punto hay un detalle
muy relevante que siempre debera considerarse, el cual esta relacionado al tipo de
informacion que representa o subyace en la red. Es decir, imagine que la red de la
Figura 89 representa personas que difunden informacion y conocimiento, entonces
puede ser de mayor interés buscar el KPP-Pos basado en grados de salida porque se
buscaria a los actores con mayor propension a compartir.

Ahora imagine que la red de la Figura 90 representa personas a quienes se
recurre para obtener asesoria o soporte técnico para la produccion agricola (o
cualquier otra actividad empresarial), entonces, el analisis seria mas interesante
basarlo en los grados de entrada, pues se buscarian a los actores con el mayor nivel
de recurrencia por parte de otros actores. Sin embargo, si solo se seleccionara un
actor, es facil observar que en ambas redes el actor mas importante es el nodo A.
La diferencia sustancial radica en la informacion que representa la red. Por tanto,
esta es una caracteristica a la que se le debe dar la debida importancia durante la
seleccion del conjunto-kp positivo, y en general durante el analisis de toda la red.
Esto nos remite nuevamente a entender a cabalidad tanto la pregunta generadora
de datos de redes como la forma en la cual se ha colectado la informacion.

D B A C E
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Figura 90. Ejemplo de una red con cinco nodos y cinco vinculos dirigidos hacia adentro.

En resumen, si el analisis de la seleccion del conjunto-kp esta basado en
grados de entrada por la informacion que subyace en la red, entonces se utilizara
el procedimiento indicado como “Harvest” en el software KeyPlayer 2; pero si
el analisis esta basado en grados de salida porque la red esta representando
ese tipo de informacion, entonces se debera utilizar el procedimiento indicado
como “Diffuse”.

Por ejemplo, imagine una red en donde los vinculos dirigidos se originan de la
pregunta “;A quiénes le informa sobre los avances en los proyectos que usted estd
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Figura 91. Menu para la obtencion del conjunto-kp positivo,
procedimiento “Harvest”, en KeyPlayer 2.

ejecutando actualmente?” y suponga que queremos encontrar aquellos actores
que poseen informacién acerca de varios de los proyectos (obviamente, se
refiere a los actores que el entrevistado a sefalado como “los informados” sobre
los avances en los proyectos), entonces, el analisis estaria basado en los grados
de entrada, y se utilizaria el procedimiento “Harvest”. En el mismo sentido,
imagine una comunidad donde se implementaron proyectos productivos piloto
asociados al aprovechamiento sustentable de recursos naturales y se pregunta
a los responsables de estos proyectos piloto ;A quiénes les ha explicado Usted el
funcionamiento y los alcances del proyecto implementado?, entonces el analisis
para encontrar a los actores que mas han compartido informaciéon con otros
estaria basado en los grados de salida, y se utilizaria el procedimiento “Diffuse”.

En los casos anteriormente ejemplificados, confundir y realizar un
procedimiento por otro, llevaria a seleccionar un conjunto-kp con diferentes
caracteristicas; por ejemplo, imagine que en el primer caso se utiliza el
procedimiento “Diffuse”, entonces se estarian seleccionando a los actores que
tienen mayor participacion en varios proyectos, lo cual no era el objetivo inicial.
Ahora, imagine que en el segundo ejemplo se utiliza el procedimiento “Harvest”,
entonces se estarian seleccionando a los actores a quienes varias personas les han
explicado como funcionan los proyectos piloto; en ambos casos el conjunto-kp
estaria representando otro tipo de situacion diferente a la planteada inicialmente.
Noseestaindicando que noseaposible realizarlo, sino que esimportante considerar
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el tipo de informacion representada en la red y el objetivo de la seleccion de actores
clave; con ello se puede efectuar una correcta interpretacion. De esta forma, se
hace énfasis en tener en consideracion la informacion que representa la red (cuyo
origen es la pregunta generadora de los datos de red) porque derivado de ello se
escogera el procedimiento correcto. Por supuesto, en redes no dirigidas se puede
utilizar cualquiera de los dos procedimientos pues se obtiene el mismo resultado al
momento de hacer el analisis basado en los grados de entrada o de salida, es decir,
utilizando el procedimiento “Harvest” o “Diffuse”, respectivamente. Conviene
apuntar que cuando una red “dirigida” se convierte arbitrariamente en una “red
no dirigida” conlleva a una serie de errores encadenados al momento de analizar
e interpretar la informacion resultante de los procedimientos anteriores.

Con las consideraciones anteriores en mente, es posible proceder a la obtencion
del conjunto-kp positivo, usando KeyPlayer 2. Para lo cual volveremos a usar el
archivo VNA creado (ver seccién 4.5y Figura 84) y abierto en el software (ver Figura
85). Antes de continuar, es importante recordar la pregunta que se realizd para
obtener los datos de red; de esta forma se aclara que a cada uno de los productores
caprinos se les pregunt6 “;De quién ha aprendido, se ha asesorado o ha preguntado,
es decir, a quién recurre para obtener informacién y conocimiento para implementar
las prdcticas, tecnologias e innovaciones que realiza en su unidad de produccion?”.
Por tanto, las relaciones entre los actores de la red refieren a vinculos binarios y
dirigidos. Ademas, se entiende que los grados de salida hacen alusién a los vinculos
que establecen los caprinocultores para acceder a informacioén y conocimiento;
mientras que los grados de entrada son las menciones que recibieron los actores
por ser fuentes de informacion y conocimiento.

Considerando esta aclaracion sobre la pregunta y su interpretacion, es
entendible que el procedimiento “Harvest” podria ser utilizado para encontrar
a aquellos actores mas referidos por los caprinocultores y que son fuentes
de informacion, puesto que su calculo esta basado en los grados de entrada;
mientras que el procedimiento “Diffuse” podria ser utilizado para encontrar a
aquellos actores que establecen varias conexiones para la busqueda y acceso a
informacion y conocimiento, debido a que el calculo toma en cuenta los grados
de salida. Nuevamente es importante tener en cuenta que esta interpretacion
y aplicacion de los procedimientos se hace a la luz de la pregunta que se realizd
para obtener los datos de red; por tanto, el uso de ambos procedimientos podria
ser diferente si se utilizara otro tipo de pregunta(s), situacion que se ha venido
ejemplificado a lo largo de esta seccion.

De esta forma, para iniciar con el procedimiento “Harvest” se utilizara el
menl “Analyze>ldentify>Harvest” (Figura 91). Aunque la palabra hace alusion a
la “recoleccion” o “cosecha” dentro de la red, se debe recordar que es asi porque
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esta basado en los grados de entrada, aunque no necesariamente significa que los
nodos estan cosechando “algo”. Al seleccionar esa opcion, se abrira una ventana de
configuracion (Figura 92a), en esta ventana existen algunas consideraciones que se
deben cuidar, entre ellas: i. En las opciones “Harvest criteria” se selecciona la primera
opcion, es decir, la que hace referencia a maximizar el alcance de nodos (“Maximize
nodes”), la segunda opcion (para los usuarios con interés en probarla) es la que se
toma en cuenta la maximizacion de las distancias reciprocas, recordando que ambos
métodos de calculo se explicaron anteriormente; ii. Para seleccionar el tamafo del
conjunto-kp positivo, se utiliza la opcion “Selected Group Size:” en nuestro ejemplo

Harvest n Results Sets
Weights and M
: S . n"“‘“""*, = Harvest 1 nodes. Masimize nodes. (01/08/2017 12:51:48 p. m.)
dge weights | RedCaprinos11 v Pescentage of nodes harvested 40.000%: "ER002"
Data type Adjacent v
Harvest criteria
(®) Maximize nodes
() Maximize reciprocal distance
Growp Parameters:
o 1 |
Selected Group Size: L b. Resultado(s): Conjunto-kp positivo.
Maximum distance l1—] .
Algorithen: | = Key Player Highlight - | >
Method: Greedy Algonthm w Record KP nodes| kp-set Go
Number of Iterations: 10 | [ Delete KP Nodes
Parameters Save to nodelist s 60
. Set color |. Lime -
Optirmize with greedy
Set shape Square v
N acts Node size :
|:| Usze untouchable nodes list Resuls  [Percentage of nodes harvested 40.000%: “EF
D Use required nodes list Edge value: RedCaprinosN11: type: Adjacenc

Initial fitness: 0.000.
Final fitness: 0.400.
Change in fitness: 0,400,

A Show Results Set Window Key Players:
EROO2
oK Cancel
< >
a. Configuracion del procedimiento. c. Informe del procedimiento.

Figura 92. Configuracion del procedimiento “Harvest” para obtener el KPP-Pos, en KeyPlayer 2.
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iniciaremos seleccionando 1; por supuesto, de la misma forma que en el procedimiento
anterior (KPP-Neg), el tamafio del grupo dependera del tamano de lared, teniendo en
mente que los procesos se tendran que hacer varias veces, es decir, es algo iterativo;
iii. En este caso, existe una opcién muy importante a configurar y es la de “Maximum
distance”, que recordando se refiere a la distancia maxima a considerar del conjunto-
kp a cualquiera de los otros nodos que conforman la red, continuando con el ejemplo,
iniciaremos configurando la distancia como m=1. Las otras opciones se recomienda
que se dejen configuradas como se muestra en la Figura 92a.

Después de la configuracion anterior, solo se debe presionar el botén “OK”.
Con esto, aparecera una ventana con el conjunto-kp positivo propuesto por el
software (Figura 92b), es decir, una lista de nodos que tendrian el mayor nivel
de cobertura (expresado en porcentaje) en la red, si se observa la ventana el
software incluye la leyenda “Percentage of nodes harvested 40.000%: “ER002"".
En algunas ocasiones se mostrara mas de una lista de nodos, de ser el caso, sera
decision del investigador seleccionar la que mejor convenga (lo cual dependera
del contexto en el cual se desempefan los actores). Al seleccionar el conjunto-
kp deseado, ahora aparecera una nueva ventana (Figura 92c¢) que muestra los
resultados de la seleccion del conjunto-kp positivo. En nuestro caso, se puede
observar nuevamente que la cobertura alcanzada por el nodo ER002 es de 40%
del restante de los nodos que conforman la red. Al presionar el primer boton
indicado como “Go”, hara que en la red se destaque el conjunto-kp positivo en
otro color y con otra forma, en nuestro caso seria un color lima y en forma de
cuadrado (Figura 93), formatos que pueden ser configurables en la ventana
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Figura 93. Conjunto-kp positivo seleccionado (un nodo),
procedimiento “Harvest”, en KeyPlayer 2.

ANALISIS DE REDES SOCIALES: CONCEPTOS CLAVE Y CALCULO DE INDICADORES 125



anterior (Figura 92c). Si se observa detenidamente la Figura 93, se podra ver
que el nodo ER002 es el actor con el maximo nimero de grados de entrada y, por
tanto, fue seleccionado como actor clave; considerando a su vez, que la distancia
maxima configurada fue m=1, entonces basicamente la cobertura alcanzada es
sobre los nodos adyacentes, los cuales son: ERO03, ER012, ER013 y, ERO17; que
son cuatro nodos de los diez restantes de la red, recordar que el conjunto-kp no
se considera en el calculo de la cobertura; este dato se obtiene sobre el restante
de los nodos después del conjunto-kp.

Durante la seleccion del conjunto-kp es muy comun que el proceso se tenga
que estar repitiendo, y se configuran tanto el tamano del conjunto-kp como la
distancia maxima m. Teniendo en mente siempre dos cosas: i. A mayor tamano
del conjunto-kp, mayor sera la cobertura que se alcanzara en la red y, ii. A mayor
distancia m que puede recorrer el conjunto-kp, también sera mayor la cobertura
a alcanzar. Por ejemplo, ahora consideremos que se sigue seleccionando un solo
nodo, pero con una distancia m=2, los resultados ahora indican que el nodo clave
es el ERO10 porque, aunque solo tiene tres grados de entrada directos (ER004,
ERO17 y ER018), tiene otros dos indirectos que son ERO05 y ER024, que a través
de ERO18 llegan a ERO10, recordando nuevamente que estamos basando el
analisis en grados de entrada.

Siguiendo con el ejemplo e incrementando el tamafo y la distancia, entonces
la red se alcanzaria completamente al seleccionar tres nodos y una distancia
m=2 (Cuadro 5). Con esos tres nodos (ER002, ER010 y, ER025) el indicador
alcanza su valor maximo (cobertura = 100%), es decir, todos los demas nodos
restantes (8 de 11, sin considerar al conjunto-kp seleccionado) serian alcanzados
por los actores clave (Figura 94). Sin embargo, es necesario volver a recalcar la
importancia e implicaciones de seleccionar tanto un tamafo mas grande como
una distancia mayor, porque considere ;qué tan factible es que los nodos elegidos
puedan hacer fluir dentro de la red “algun recurso, informaciéon o mensaje” a
través de dos o mas pasos? ;Tedrica o empiricamente es posible?, etcétera.
Entonces, nuevamente se hace hincapié en laimportancia de basar la seleccion en
cuestiones tedricas o empiricas y no sélo configurar ambos valores para alcanzar
coberturas espectaculares que no sean posibles en la practica.

Por otra parte, es importante hacer mencion que, aunque al incrementar el
tamano del conjunto-kp se incrementa la cobertura de los nodos restantes de la
red, también se recomienda tener en cuenta el cambio marginal de esa cobertura,
asociado nuevamente al uso y necesidad de recursos (econdémicos, de tiempo,
humanos, entre otros). De esta forma, en ocasiones no es tan conveniente
incrementar el tamano del conjunto-kp positivo, si los cambios marginales en la
cobertura son pequefos.
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Figura 94. Conjunto-kp positivo seleccionado (tres nodos),
procedimiento “Harvest”, en KeyPlayer 2.

Cuadro 5. Cambio en la cobertura (%) alcanzada por el conjunto-kp positivo,
al cambiar el tamano del conjunto-kp y la distancia que alcanzan.

Tamafio del conjunto-kp Distancia de 1 Distancia de 2 Distancia de 3
1 40.0% 50.0% 50.0%
(ER002) (ER010) (ERO10)
2 66.7% 88.9% 88.9%
(ER0O02; ERO10) (ER002; ERO10) (ER002; ERO10)
3 87.5% 100.0% 100.0%
(ER002; ERO10; ER018) (ER002; ERO10; ER025) (ER002; ERO10; ER025)

Sin duda, la definicion del tamafo del conjunto-kp positivo y de la distancia m,
dependera nuevamente de los objetivos que tenga el usuario o el investigador y, hasta
cierto punto, de la estructura de la red. Lo anterior es importante porque si la red tiene
cierto nivel de fragmentacion, por ejemplo, existen muchos componentes en la red o
el nivel de vinculos entre los actores es bajo, la seleccion del conjunto-kp positivo sera
dificil. Esto es porque basicamente para el software sera lo mismo seleccionar un actor
con un grado de entrada que esté ubicado en un componente, que elegir a otro nodo
también con un grado de entrada que forme parte de otro componente. Es decir, el
software ofreceria como resultados muchas combinaciones de nodos con las mismas
caracteristicas. Aunado a lo anterior, se tiene el tamano de la red, en redes pequenas
(como la de nuestro ejemplo) el conjunto-kp a seleccionar no debera ser grande, pero
en redes grandes si sera necesario probar el proceso con tamafos mas grandes; de
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hecho, es por esta caracteristica que, en nuestro ejemplo, de sélo 11 nodos, con tres
de ellos se logra el 100% de cobertura.

Como se indico en esta seccion, el conjunto-kp positivo se puede calcular
con base en los grados de entrada y, por tanto, también con los grados de
salida. Hasta ahora se ha explicado el procedimiento basado en los grados
de entrada a través del uso de la opcion “Harvest”. En este sentido, la opcion
complementaria es “Diffuse”, la cual esta basada en los grados de salida. El
procedimiento metodoldgico es similar al que se ha explicado, simplemente la
diferencia es que se trabaja con el menu “Analyze>Identify>Diffuse”. En esta
opcion también se tendra que seleccionar el tipo de criterio de difusion, es decir,
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Figura 95. Configuracion del procedimiento “Diffuse” para calcular
el KPP-Pos y resultados obtenidos, en KeyPlayer 2.
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si es para maximizar los nodos a alcanzar o si es a través de la maximizacion de
las distancias reciprocas. También se debe configurar el tamafio del conjunto-kp
positivo a seleccionar y, para el primer criterio de difusion, la distancia maxima
desde los nodos del conjunto-kp hacia los nodos restantes de |a red. Por supuesto,
también se incluyen las opciones de nodos requeridos y no deseados. La salida
de resultados, después de la configuracion sera la misma y nos proporcionara el
porcentaje de nodos restantes que se alcanzan con los nodos seleccionados, pero
siempre recordando que se esta trabajando con la opcion “Diffuse” y, por tanto,
el calculo estara basado en los grados de salida. Por Ultimo, también se genera el
grafico de red resaltando los nodos que forman el conjunto-kp positivo.

Para ejemplificar, supongamos que se desean seleccionar tres nodos clave, con
base en sus grados de salida y con una distancia m=1. Entonces se selecciona la
opcion “Diffuse”y se configura el procedimiento como se muestra enla Figura 95a.
Los resultados obtenidos indican que el mejor conjunto-kp positivo, con base
en grados de salida, es el formado por los nodos ER012, ER014 y, ER017, cuya
cobertura seria de 87.5% de la red restante (Figura 95b). En la Figura 96 se puede
observar que el nodo ER017 es el que tiene el maximo nimero de grados de salida
y que, a una distancia de 1, alcanza a otros cinco nodos. Ademas, los nodos ER012
y ER014, alcanzan a otros nodos que no son tocados por el ERO17. Entre los
tres nodos alcanzan a siete de los ocho nodos restantes, por lo que la cobertura
resultante es 87.5%. Por supuesto, en este caso también se puede incrementar el
valor del tamafio del conjunto-kp y de la distancia maxima, pero ambos valores
tienen implicaciones similares a considerar como se explic anteriormente.
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Figura 96. Conjunto-kp positivo seleccionado (tres nodos),
procedimiento “Diffuse”, en KeyPlayer 2.
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6.3. Los nodos requeridos e intocables

Durante la seleccién de actores clave, y aln mas para disefar intervenciones
basadas en red (ver Aguilar-Gallegos et al., 2017, quienes explican el disefio de una
estrategia de este tipo; también Maya Jariego, 2016 describe siete usos especificos
de las redes en el disefio, implementacion y evaluacién de programas asociados a
la salud; por supuesto también es muy recomendable consultar a Valente, 2012),
puede suceder que existan actores que sean necesarios incluir, ya sea porque han
sido seleccionados a priori, porque tienen caracteristicas destacables (e.g., en
agricultura estos actores pueden poseer niveles de adopcion de innovaciones altos,
superficies agricolas grandes, productividad destacada, alta tecnologia productiva,
entre otras) o, incluso, se deben incluir porque es estratégicamente bueno (e.g.,
en algunas comunidades rurales, los parrocos o lideres politicos tienen poder de
convocatoria o de veto). De manera opuesta y complementaria, es posible que
existan actores que no es deseable que sean seleccionados dentro de los actores
clave, por diversas razones. En este sentido, el software KeyPlayer 2 tiene la opcion
para configurar en el proceso de calculo a actores deseados (requeridos en el
conjunto-kp) y no deseados (intocables por el procedimiento).

Primero se ejemplifica el proceso para actores deseados, para ello se utiliza el
menu “Data>Required Nodes...”, al abrir esa opcion aparecera una ventana similar
a la Figura 97a. En ella se mostrara una lista con las etiquetas de los nodos que
conforman la red, dicha lista se puede incluso filtrar por atributos de los actores
(por ejemplo, los que tengan mayor nivel de adopcion de innovaciones, mayor
superficie cultivada, entre otros); en nuestro ejemplo, simplemente se muestran
por la etiqueta, supongamos que el nodo ER005 queremos que sea seleccionado
dentro del conjunto-kp, entonces activamos la casilla correspondiente, tal y como
se muestra en la Figura 97a. Una vez seleccionados los nodos requeridos, se vuelve
a realizar el procedimiento, ya sea para determinar el conjunto-kp negativo (ver
seccion 6.1) o positivo (ver seccion 6.2). Siguiendo con el ejemplo, supongamos
que volveremos a seleccionar un conjunto-kp positivo de tamafio 2 y con una
m=1 y basado en los grados de entrada. De esta forma, utilizaremos la opcion
“Harvest” (ver Figura 91). Al seleccionar dicha opcion, se deberan configurar
nuevamente las opciones respectivas del tamano del conjunto-kp y de la distancia
maxima, siguiendo el ejemplo mencionado la configuracion deberia quedar como
en la Figura 97b Ademas, existe un paso indispensable que se debe configurar y es
la activacion de la casilla marcada como “Use required nodes list” (Figura 97b) que
precisamente le indica al programa que calcule el conjunto-kp usando la lista de los
nodos requeridos, mismos que fueron seleccionados anteriormente (Figura 97a).
Al presionar el boton “OK” aparecera la ventana de resultados y después la del
informe del conjunto-kp seleccionado (ver secuencia en la Figura 92).
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Figura 97. Configuracion de nodos deseados o requeridos en KeyPlayer 2.

Los resultados obtenidos (Figura 98) muestran que el conjunto-kp de tamafio
2 deberia estar formado por los nodos ER002 y ER0O5. El primero es seleccionado
por el programa debido a las caracteristicas propias de ese nodo, es decir, tiene el
mas alto valor en grados de entrada. El seqgundo nodo, el EROO5, es precisamente
el que le solicitamos al programa que incluya. Recordando, si no se activara la
casilla de usar los nodos requeridos (Figura 97b), el programa determinaria
que los mejores nodos fueran el ER002 y ER0010, con los cuales se tendria una
cobertura de 66.7% de la red restante (ver Cuadro 5); sin embargo, al determinar
que el nodo EROO5 deberia quedar seleccionado dentro del conjunto-kp, sélo se
alcanza una cobertura de 55.6% de la red restante, la cobertura disminuye pues
este nodo solo incorpora un nodo (el ERO18) a la cobertura, que no habia sido
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Figura 98. Resultado del procedimiento KPP-Pos, opcion “Harvest”, con dos
nodos y una distancia de 1; el nodo ER005 se configuré como requerido.

considerado por el ERO02. En comparacion, el ERO10 incorporaba dos nodos mas
(ERO18 y ER014).

Siguiendo con el ejemplo anterior, ahora suponga que vuelve a configurar la
lista de nodos requeridos y se incluye también el nodo ER014, ademas del EROO5.
Si se realiza nuevamente el calculo del conjunto-kp, pero ahora de tamano 3,
se obtendria como resultado que el conjunto-kp estaria formado por los nodos
ER002, EROOS y ER014, y estos tres tendrian una cobertura de 62.5%, es decir,
mayor a sélo los dos nodos seleccionados anteriormente, que fue de 55.6%
(Figura 99). La duda es ;por qué aumenta la cobertura si el nodo ER014 no tiene
ningun grado de entrada (Figura 100)? Esto se debe a que la cobertura se calcula
con base en la red restante después de la seleccion del conjunto-kp; entonces con
tres actores seleccionados, la red restante es de 8 nodos, y el alcance que tienen
los dos nodos que si poseen grados de entrada son 5, entonces (5 / 8) * 100 =
62.5%, que es el resultado obtenido. Es por lo que, aunque se configuren nodos
requeridos que no posean grados de entrada, la cobertura siempre aumentara
(Figura 99).

La configuracion de los nodos intocables (no deseados o no requeridos) sigue
un procedimiento similar; en este caso se utiliza el menu “Data>Untouchable
Nodes...”. Asi como se configuraron los nodos requeridos, en este caso también
aparecera una ventana con la lista de nodos que el calculo del conjunto-kp no debe
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Figura 99. Comparacion de resultados entre configurar el conjunto-kp
de tamafo 2 y 3, con 1y 2 nodos requeridos, respectivamente.
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Figura 100. Conjunto-kp positivo de tres nodos (los nodos ER005 y ER014 fueron
configurados como requeridos), procedimiento “Harvest”, en KeyPlayer 2.

considerar (Figura 101a). Siguiendo con el ejemplo que se ha venido explicando,
supongamos que no deseamos que el procedimiento seleccione ni el nodo ER010
ni el ERO18, por tanto, es necesario activar las casillas de esos nodos (Figura 101a).

Posteriormente, se tiene que volver a realizar el procedimiento de seleccion
del conjunto-kp, ya sea negativo (fragmentacion) o positivo (cobertura); en
nuestro caso debemos recordar que estamos siguiendo el ejemplo con la opcién
“Harvest”. En este punto, es importante que al momento de configurar la
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Figura 101. Configuracion de nodos intocables, no deseados, o no requeridos en KeyPlayer 2.

ventana del procedimiento (Figura 101b) se active la casilla “Use untouchable
nodes list”, lo que le indicara al programa que durante el calculo del conjunto-
kp use Ia lista de los nodos intocables, es decir que, aunque sean buenos nodos,
no se seleccionen. En nuestro ejemplo, supongamos que vamos a seleccionar
tres nodos a una distancia maxima de 1, los resultados anteriores (ver Cuadro 5)
mostraban que los mejores tres nodos eran ER002, ER010 y, ER018, ademas que
con ellos se alcanzaba una cobertura de 87.5% de la red restante. Sin embargo,
ahora se le ha pedido al programa que no considere la inclusion de los nodos
ER010 y ERO18, por lo tanto, el procedimiento ofrecera una lista nueva. En este
caso, se obtuvo que el conjunto-kp estaria formado por ER002, EROO5 y, ER025
alcanzando una cobertura de 75% (Figura 102). Por su puesto, la cobertura es
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menor pues precisamente los nodos de la lista de no deseados son el sequndo y
tercero mas importante en la red (por sus grados de entrada). En la Figura 103
se puede apreciar como el conjunto-kp positivo seleccionado esta distribuido en
la red; obsérvese como los nodos ERO10 y ER018 que estan al centro de la red no
fueron seleccionados, aunque son buenos nodos.
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Figura 102. Resultado del procedimiento KPP-Pos, opcion “Harvest”, con tres nodos y una
distancia de 1, dos nodos (ER010 y ER018) se configuraron como intocables o no requeridos.
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Figura 103. Conjunto-kp positivo de tres nodos (los nodos ER010 y ER018 fueron configurados
como no requeridos, por ello no fueron seleccionados), procedimiento “Harvest”, en KeyPlayer 2.
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Para finalizar este apartado, es importante comentar que durante la
configuracion de la lista de nodos no deseados se pueden seleccionar mas nodos
de los que se buscara que formen el conjunto-kp, es decir, es posible seleccionar
cinco nodos no deseados y solo estar buscando tres actores clave. O en una red
mas grande, digamos 200 nodos, es posible que sean 25 los nodos no deseados
y el tamano del conjunto-kp quizas sea de 15. Esto se puede realizar ya que el
procedimiento va buscando la mejor combinacion de nodos posible, entonces
se iran seleccionando los nodos hasta formar el conjunto-kp, por lo cual es
posible que se complete con nodos no deseados si es que no se activaron en la
lista respectiva. Esto no funciona igual para la lista de nodos requeridos porque
si se activan mas nodos deseados en comparacion al tamano del conjunto-kp,
los nodos requeridos tendran prioridad y entonces seran los primeros en ser
seleccionados. Nuevamente se recalca la importancia de considerar en todo
momento la informacion que subyace en la red y las implicaciones de recursos en
la seleccion de los actores clave.
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7. Consideraciones finales

El propésito de este documento ha sido explicar de forma resumida el uso y
aplicacion del Analisis de Redes Sociales, pasando por temas que van desde el
planteamiento de la pregunta generadora de los datos de red, la colecta de estos
datos y su sistematizacion, hasta la representacion grafica y calculo de indicadores
basicos; todo esto con el uso del software mas popular: UCINET (Borgatti et al.,
2002) y dos softwares asociados a éste, que son i. NetDraw (Borgatti, 2002),
para visualizar redes, y ii. KeyPlayer 2 (Borgatti, 2006; Borgatti & Dreyfus,
2005), para identificar actores clave. Se pretende que el lector (estudiante,
profesionista, investigador, entre otros) tenga un panorama general del potencial
del ARS como herramienta metodoldgica, pero también teorica, en donde el
analisis de los vinculos entre actores represente correctamente la informacion
subyacente en los graficos de red. En este sentido, también se busca contribuir a
reducir el uso del ARS como una simple forma elegante, atractiva y “apantallante”
de representar interacciones entre actores, pero que no logra sustentarse en
informacion empirica ni tedrica, llegando incluso a interpretaciones erréneas
tanto de los indicadores como de los graficos.

Sin embargo, se debe recalcar que el documento es introductorio; asi, queda un
margen de temas y topicos que no se abordaron a detalle y, por tanto, corresponde
al lector documentarse para aplicarlos. Entre los temas promisorios se pueden
sefalar, empezando por el apartado de la colecta y generacion de datos de red,
las diferencias entre los instrumentos para colectar datos de redes “completas”
y “egocéntricas”; un tanto relacionado esta el tema de la delimitacion espacial y
temporal de los datos de red a colectar y de los actores mismos. Asi mismo, al no
especificar y abundar sobre los limites de la red, tampoco se hablé sobre el muestreo
de poblaciones; este topico es determinante, pues la frontera de la red analizada
marcara, en buena medida, la posible interpretacion de los indicadores.

De la misma forma, el lector también podra abundar en el analisis de las diferencias
entre colectar datos de red "modo-uno" (one-mode) y datos de red "modo-dos"
(two-mode), que llevaria a discutir la diferencia entre indicadores y representaciones
graficas, entre otras implicaciones sumamente Utiles. En especifico, el tema de
las redes "modo-dos" es amplio y ha tomado auge por su importancia y posible
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aplicacion en diversas areas y con diferentes objetivos; este tipo de datos son
comunes en estudios sobre colaboracion cientifica, por ejemplo, Rodriguez et al.
(2016) construyeron una red "modo-dos" para ver la participacion de diversos
autores en un conjunto de articulos, y asi analizar la colaboracién académica para la
generacion de conocimiento en la extension rural en Colombia.

Otro tema interesante es el relacionado con desarrollar datos de red sobre
caracteristicas especificas, como son los generadores de posicion y de recursos, que
podrian ser del interés al estudiar capital social, pues hacen referencia al acceso a
“tipos de alters especificos” o de “alters con recursos especiales”, entre otros topicos.

En el apartado de la captura de datos de red, aunque se abordaron los
principales métodos usados en su sistematizacion, existen otros mas. Por ejemplo,
es posible cargar atributos de los actores a través del formato Edgelist2. Aunado
a esto y como una mencion especial, en el software UCINET y con el uso del
Editor DL (ver seccion 3.5. donde se utilizb éste para guardar datos en formato
Edgelist 23), se pueden generar los archivos de red sin necesidad de pasar por
los archivos de texto que se explicaron en este documento. Aunado a esto, en
el Editor DL existen otras opciones de captura de datos de red. Como se sefalo
anteriormente, el tema de las redes "modo-dos" es amplio y con ello la forma de
sistematizar los datos es también un topico especial, en donde formatos como el
mismo Edgelist2 y el Nodelist2 son los indicados.

En cuanto al tema de visualizacion de redes, existe un amplio desarrollo en
cuanto a algoritmos y formas de representacion de la red. De manera general,
en el documento se mencionaron los cinco principios basicos (Davidson &
Harel, 1996) que busca un buen algoritmo, pero el lector podra encontrar en la
literatura especializada una explicacion a mayor profundidad sobre como trabajan
algunos de ellos; esto estara ligado al uso del software elegido por el usuario. En
nuestro caso, hemos hecho énfasis en el uso de NetDraw (Borgatti, 2002), por
estar asociado a UCINET; pero también se recomienda al lector profundizar en
el manejo de otros programas, entre ellos Pajek (Batagelj & Mrvar, 2011), Gephi
(Bastian et al., 2009), NodeXL (Smith et al., 2009) y varios mas.

Uno de los temas que demandaran mucha mas atencion en el futuro y que esta
en constante avance es el desarrollo de indicadores del ARS. Como se mencion6 en
la seccion 5, los indicadores mostrados en este documento son los mas aplicados
en los analisis disponibles en la literatura; se podria decir que son los indicadores
basicos de primer y segundo orden. Sin embargo, existen otros mas en los que
valdria la pena profundizar pues podrian ampliar el horizonte de analisis. S6lo
por mencionar algunos, en primer término esta el tema de la homofilia entre los
actores (Lazarsfeld & Merton, 1954; McPherson, Smith-Lovin, & Cook, 2001) y el
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indicador E-1 como una forma de calcularla (Everett & Borgatti, 2012; Krackhardt
& Stern, 1988); esto es importante porque se puede medir hasta qué grado los
actores tienden a establecer vinculos con aquellos que son similares a ellos o
viceversa. Se ha encontrado evidencia que este tipo de comportamientos puede
impedir el flujo de informacion y conocimiento entre agricultores con diferentes
niveles de innovacion (Aguilar-Gallegos et al., 2015). Otro caso se da en las redes
de pesca, en donde las embarcaciones muestran una ligera tendencia general a la
heterofilia, puesto que el intercambio de informacion entre embarcaciones similares
representa una competencia, es por lo que no se genera ese tipo de vinculo entre
iguales; al contrario, pareciera que las relaciones mas fuertes se dan entre aquellas
embarcaciones que no representan competencia directa por los recursos pesqueros
(Maya Jariego et al., 2017). También que, en cuanto a la colaboracion cientifica,
los investigadores de instituciones publicas tienen mayores niveles de homofilia en
comparacion con investigadores de instituciones privadas, quienes muestran una
tendencia hacia la heterofilia (Rodriguez et al., 2016).

Segundo, se recomienda al lector abundar sobre el estudio de las estructuras
de red centro-periferia, donde se podria probar tanto la presencia de dicha
estructura a nivel de red, asi como encontrar a los nodos que son centro y otros
que forman la periferia (Borgatti & Everett, 2000), que a su vez puede tener
aplicaciones empiricas para la seleccion de actores que faciliten la difusion de
informacion y conocimiento (Bourne et al., 2017; Isaac, Erickson, Quashie-Sam,
& Timmer, 2007).

Tercero, otro tema que ha estado cobrando importancia es la deteccion de
grupos y comunidades a través de algoritmos muy sofisticados (e.g., Blondel,
Guillaume, Lambiotte, & Lefebvre, 2008; Girvan & Newman, 2002) en donde
indicadores como la modularidad toman relevancia para su determinacion y
correcta division. La modularidad, de forma general, sirve para conocer qué
tan buena o mala es la particién de la red en las comunidades encontradas.
La definicion de comunidades es interesante debido a que dentro de éstas es
frecuente que se encuentre una elevada densidad, en comparacion con una baja
densidad entre ellas. Por lo tanto, esto podria ser utilizado para disefiar estrategias
de intervencion basadas en red (Maya Jariego, 2016; Valente, 2012) y, en
especifico, a través de grupos y comunidades. Algunos avances en intervenciones
basadas en red han demostrado, por ejemplo, que es posible incrementar los
niveles de innovacion de productores caprinos (Aguilar-Gallegos et al., 2017);
sin embargo, el disefio de la intervencion se realiz6 con base en la seleccion de
actores, misma que se hizo tomando en cuenta la estructura de toda la red. Por
tanto, seria pertinente generar mas estudios sobre las intervenciones a través de
grupos y comunidades, para hacer comparaciones de ambos métodos.
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Sumado a los temas antes sefialados, y en los que seguramente se tendran
avances importantes en cuanto a su aplicacion en el futuro inmediato, existen
otros mas que convendria explorar. Tal es el caso de lo relacionado al analisis
de modelos estocasticos y de redes dinamicas (analisis longitudinal) (Robins,
Pattison, Kalish, & Lusher, 2007; Robins, Snijders, Wang, Handcock, & Pattison,
2007; Snijders, van de Bunt, & Steglich, 2010), en donde existe todavia una
brecha para la generacion de evidencia empirica y de contribucion tedrica.

Los temas antes sefnalados son considerados como tépicos selectos y en
algunos casos son tan especializados que llevan al desarrollo de otros rubros
alternos. Ademas, al ser topicos especializados, su explicacion podria llevar a
escribir documentos completos, con longitudes mayores al presente. Asi, para
una consulta a mayor detalle o para aquellos lectores que deseen profundizar en
los temas propuestos, algunas de las lecturas recomendadas son hacia autores
clasicos y seminales que fueron citados a lo largo del documento (e.g., Borgatti &
Everett, 1997, 2000; Borgatti et al., 2013; Borgatti & Halgin, 2011a; Costenbader
& Valente, 2003; Marsden, 1990, 2005, 2011; Robins, Pattison, et al., 2007;
Snijders et al., 2010; Valente, 2012; Wasserman & Faust, 1994).

Por Gltimo, se debe recalcar que, tanto para los analisis elementales del ARS
como para la aplicacion de los topicos avanzados, la base fundamental es el
entendimiento a cabalidad de la informacion colectada, que puede ser a través de
diferentes mecanismos y entre ellos las preguntas generadoras de nombres. Con
el entendimiento de la informacion que representa el vinculo y como fue obtenido
éste, el ARS puede ser utilizado con mayor potencial y los indicadores proveeran
mas conocimiento, llegando a conclusiones mas profundas y sustentadas sobre la
red que se esté analizando.
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